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Abstract

KStars is free, open source, cross-platform Astronomy Software. It provides an accurate
graphical simulation of the night sky, from any location on Earth, at any date and time. The dis-
play includes up to 100 million stars, 13,000 deep-sky objects,all 8 planets, the Sun and Moon,
and thousands of comets, asteroids, supernovae, and satellites. For students and teachers,
it supports adjustable simulation speeds in order to view phenomena that happen over long
timescales, the KStars Astrocalculator to predict conjunctions, and many common astronomical
calculations. For the amateur astronomer, it provides an observation planner, a sky calendar
tool, and an FOV editor to calculate field of view of equipment and display them. Find out
interesting objects in the ´́ What’s up Tonight´́ tool, plot altitude vs. time graphs for any ob-
ject, print high-quality sky charts, and gain access to lots of information and resources to help
you explore the universe! HiPS all-sky progressive overlay provide stunning views from nu-
merous surveys spanning the whole electromagnetic spectrum. Included with KStars is Ekos
astrophotography suite, a complete astrophotography solution that can control all INDI devices
including numerous telescopes, CCDs, DSLRs, focusers, filters, and a lot more. Ekos supports
highly accurate tracking using online and offline astrometry solver, autofocus and autoguid-
ing capabilities, and capture of single or multiple images using the powerful built in sequence
manager.
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Chapter 1

Introduction

KStars lets you explore the night sky from the comfort of your computer chair. It provides an
accurate graphical representation of the night sky for any date, from any location on Earth. The
display includes 126,000 stars to 9th magnitude (100 million with addon catalogs), 13,000 deep-
sky objects (Messier, NGC, and IC catalogs), all planets, the Sun and Moon, hundreds of comets
and asteroids, the Milky Way, 88 constellations, and guide lines such as the celestial equator, the
horizon and the ecliptic.

However, KStars is more than a simple night-sky simulator. The display provides a compelling
interface to a number of tools with which you can learn more about astronomy and the night
sky. There is a context-sensitive popup menu attached to each displayed object, which displays
object-specific information and actions. Hundreds of objects provide links in their popup menus
to informative web pages and beautiful images taken by the Hubble Space Telescope and other
observatories.
From an object’s popup menu, you can open its Detailed Information Window, where you can
examine positional data about the object, and query a huge treasury of online databases for
professional-grade astronomical data and literature references about the object. You can even
attach your own Internet links, images and text notes, making KStars a graphical front-end to
your observing logs and your personal astronomical notebook.

Our Astrocalculator tool provides direct access to many of the algorithms the program uses be-
hind the scenes, including coordinate converters and time calculators.

You can plan an observing session using our Altitude vs. Time tool, which will plot curves
representing the Altitude as a function of time for any group of objects. If that is too much detail,
we also provide a What’s Up Tonight? tool that summarizes the objects that you will be able to
see from your location on any given night. You can add your favorite objects to your observing
wish-list using the Observation Planner tool, which allows you to plan your observation sessions
professionally. To see how object appears in the eyepiece under different telescopes and field of
views, use the Simulate Eyepiece View tool to render a simulated view of what you see.

KStars also provides a Solar System Viewer, which shows the current configuration of the major
planets in our solar system. There is also a Jupiter Moons Tool which shows the positions of
Jupiter’s four largest moons as a function of time.

Our primary goal is to make KStars an interactive educational tool for learning about astronomy
and the night sky. To this end, the KStars Handbook includes the AstroInfo Project, a series of
short, hyperlinked articles on astronomical topics that can be explored with KStars. In addition,
KStars includes D-Bus functions that allow you to write complex scripts, making KStars a power-
ful ´́ demo engine´́ for classroom use or general illustration of astronomical topics. Furthermore,
any 3rd party tool or language with support of D-Bus can be used to write powerful scripts using
KStars D-Bus API
Enable HiPS all-sky progressive overlay to fetch high-resolution images and display them di-
rectly in the sky map. You can select from numerous catalogs compiled from different earth and
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space based missions. This features requires a fast internet connection in order to download
the images. The images are cached locally to reduce bandwidth. You can optimize the caching
options to best balance between disk space versus bandwidth.

However, KStars is not just for students. You can control telescopes and cameras with KStars,
using the elegant and powerful INDI protocol. KStars supports several popular telescopes in-
cluding Meade’s LX200 family and Celestron GPS. Several popular CCD cameras, webcams, and
computerized focusers are also supported. Simple slew/track commands are integrated directly
into the main window’s popup menu, and the INDI Control Panel provides full access to all of
your telescope’s functions. INDI’s Client/Server architecture allows for seamless control of any
number of local or remote telescopes using a single KStars session.For advanced users, KStars
provides Ekos, a complete astrophotography suite for Linux. Ekos is based on a modular exten-
sible framework to perform common astrophotography tasks. This includes highly accurate GO-
TOs using astrometry solver, ability to measure and correct polar alignment errors , auto-focus
and auto-guide capabilities, and capture of single or stack of images with filter wheel support.

We are very interested in your feedback; please report bugs or feature requests to the KStars
development mailing list: kstars-devel@kde.org. You can also use the automated bug reporting
tool, accessible from the Help menu.

This documentation is licensed under the terms of the GNU Free Documentation License.
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Chapter 2

A Quick Tour of KStars

This chapter presents a guided tour of KStars, introducing many of its important features.

The above screenshot shows a typical view of the KStars program. You can see the sky display
centered on Betelgeuse, the brightest star in the constellation Orion. Stars are displayed with
realistic colors and relative brightnesses. In three corners of the sky display, there are on-screen
text labels displaying data on the current time (‘LT: 3:08:30 AM EEST Wednesday, July 6, 2016’),
the current Geographic Location (‘Bucharest, Romania’), and the current object in the center of
the display (‘Focused on: Betelgeuse (alpha Orionis)’). Above the sky display, there are two
toolbars. The main toolbar contains shortcuts for menu functions, as well as a time-step widget
which controls how fast the simulation clock runs. The view toolbar contains buttons that toggle
the display of different kinds of objects in the sky. At the bottom of the window, there is a status
bar which displays the name of any object you click on, and the sky coordinates (both Right
Ascension/Declination and Azimuth/Altitude) of the mouse cursor.

2.1 The Setup Wizard

The first time you run KStars, you will be presented with a Setup Wizard, which allows you to
easily set your geographic location and download some extra data files. You can press the OK
button at any time to exit the Setup Wizard.
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The second page of the Setup Wizard allows you to choose the starting geographic location, by
selecting from the list of the 3400+ known locations on the right side of the window. The list
of locations can be filtered to match the text you enter in the City, Province, and Country edit
boxes. If your desired location is not present in the list, you can select a nearby city instead for
now. Later on, you can add your precise location manually using the Set Geographic Location
tool. Once you have selected a starting location, press the Next button.

The last page of the Setup Wizard allows you to download extra data that are not included with
the standard distribution of KStars. Simply press the Download Extra Data button to open the
Get New Stuff tool. When you are all done, press the OK button in the Setup Wizard to start
exploring KStars.

2.2 Have a Look Around

Now that we have the time and location set, let us have a look around. You can pan the display
using the arrow keys. If you hold down the Shift key before panning, the scrolling speed is
increased. The display can also be panned by clicking and dragging with the mouse. Note that
while the display is scrolling, not all objects are displayed. This is done to cut down on the CPU
load of recomputing object positions, which makes the scrolling smoother (you can configure
what gets hidden while scrolling in the Configure KStars window). There are several ways to
change the magnification (or Zoom level) of the display:

1. Use the + and - keys

2. Press the Zoom In/Zoom Out buttons in the toolbar

3. Select Zoom In/Zoom Out from the View menu

4. Select Zoom to Angular Size... from the View menu. This allows you to specify the field-
of-view angle for the display, in degrees.

5. Use the scroll wheel on your mouse

6. Drag the mouse up and down with the middle mouse button pressed.

7. Hold down Ctrl while dragging the mouse. This will allow you to define a rectangle in the
map. When you release the mouse button, the display will zoom to match the rectangle.

Notice that as you zoom in, you can see fainter stars than at lower zoom settings.

Zoom out until you can see a green curve; this represents your local horizon. If you have not
adjusted the default KStars configuration, the display will be solid green below the horizon,
representing the solid ground of the Earth. There is also a white curve, which represents the
celestial equator, and a brown curve, which represents the Ecliptic, the path that the Sun appears
to follow across the sky over the course of a year. The Sun is always found somewhere along the
Ecliptic, and the planets are never far from it.

You can configure KStars to draw or not the celestial equator and Ecliptic curves on the Sky Map
using the Settings → Configure KStars submenu. Select the Guides tab and check/uncheck the
Celestial equator and Ecliptic check boxes. You can also configure which colors KStars uses for
drawing these curves, using the Colors tab.
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2.3 Objects in the Sky

KStars displays thousands of celestial objects: stars, planets, comets, asteroids, clusters, nebulae
and galaxies. You can interact with displayed objects to perform actions on them or obtain more
information about them. Clicking on an object will identify it in the status bar, and simply hov-
ering the mouse cursor on an object will label it temporarily in the map. Double-clicking will
recenter the display on the object and begin tracking it (so that it will remain centered as time
passes). Right clicking an object opens the object’s popup menu, which provides more options.

2.3.1 The Popup Menu

Here is an example of the right click popup menu, for the Uranus:
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The appearance of the popup menu depends somewhat on the kind of object you right-click on,
but the basic structure is listed below. You can get more detailed information about the popup
menu.
The top section contains some lines of information which are not selectable: the object’s names
(´́ Uranus´́ ), object type (´́ Solar system object´́ ), and the constellation which contains the object
(´́ Pisces´́ ). The next three lines show the object’s rise, set, and transit times. If the rise and set
times say ´́ circumpolar´́ , it means that the object is always above the horizon for the present
location.
The middle section contains actions which can be performed on the selected object, such as Cen-
ter & Track, Details, and Attach Label. See the popup menu description for a full list and de-
scription of each action.

The bottom section contains links to images and/or informative webpages about the selected
object. If you know of an additional URL with information or an image of the object, you can add
a custom link to the object’s popup menu. Use the Details item in the popup menu to open the
Object Details dialog. On the Link tab use the Add Link... item.

2.3.2 Finding Objects

You can search for named objects using the Find Object tool, which can be opened by clicking on
the search icon in the toolbar, by selecting Find Object... from the Pointing menu, or by pressing
Ctrl+F. The Find Object window is shown below:
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The window contains a list of all the named objects that KStars is aware of. Many of the objects
only have a numeric catalog name (for example, NGC 3077), but some objects have a common
name as well (for example, Whirlpool Galaxy). You can filter the list by name and by object type.
To filter by name, enter a string in the edit box at the top of the window; the list will then only
contain names which start with that string. To filter by type, select a type from the combo box at
the bottom of the window.
KStars provides another method for resolving the objects that are missing from any of its prede-
fined catalogues, by using an internet connection. Thus, if you want to find an object that KStars
is not aware of, you can easily do this by querying several professional astronomical databases
as: SIMBAD, NED or VizieR. This can be done by entering the object’s name and then press the
or search the internet for ObjectName button. After your object is found, you can use it exactly
as any object that is already loaded into KStars (i.e. adding it to the Observing WishList). If the
object was not found in the online databases, then a warning dialogue will pop-up. Once you
resolve an object by using this method, it is stored in KStars database, so if you close KStars and
open it again, your object will still be there.

You can choose to enable or disable this feature by checking or unchecking the Resolve names
not known to KStars using online services check box from Catalogs tab, inside of Settings
→ Configure KStars window. If this checkbox is checked, when an object name unknown to
KStars is entered in the Find Dialog, KStars will contact online services to learn about the desired
object and then add it directly to KStars database. The objects acquired in this manner are stored
in a fake catalog, called ‘_Internet_Resolved’. Thus, you can enable or disable the display of
these objects by checking or unchecking the ‘_Internet_Resolved’ catalog from the catalogues
list. Note that you can not delete this fake catalogue, as you can do with a custom catalogue. If
this checkbox is unchecked, then the Find Dialog window will be exactly the same, excepting a
minor change: the online searching button will no longer be visible.
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To center the display on an object, highlight the desired object in the list, and press Ok. Note
that if the object is below the horizon, the program will warn you that you may not see anything
except the ground (you can make the ground invisible in the Guides settings page, or by pressing
the Ground button in the View toolbar).

2.3.3 Centering and Tracking

KStars will automatically begin tracking on an object whenever one is centered in the display,
either by using the Find Object window, by double-clicking on it, or by selecting Center & Track
from its right-click popup menu. You can disengage tracking by panning the display, pressing
the Stop Tracking icon in the Main toolbar, or selecting Stop Tracking from the Pointing menu.

NOTE
When tracking on a Solar System body, KStars will automatically attach an ‘orbit trail’, showing the
path of the body across the sky. You will likely need to change the clock’s timestep to a large value
(such as ‘1 day’) to see the trail.

2.3.4 Keyboard Actions

When you click on an object in the map, it becomes the selected object, and its name is identified
in the statusbar. There are a number of quick key commands available which act on the selected
object:

C
Center and Track on the selected object

D
Show the Details window for the selected object
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L
Toggle a visible name label on the selected object

O
Add the selected object to the Observing wish-list

T
Toggle a visible curve on the sky, showing the path of the object across the sky (only appli-
cable to Solar System bodies)

NOTE
By holding down the Shift key, you can perform these actions on the centered object, rather than the
selected object.

2.4 End of the Tour

This concludes the tour of KStars, although we have only scratched the surface of the available
features. KStars includes many useful astronomy tools, it can directly control your telescope,
and it offers a wide variety of configuration and customization options. In addition, this Hand-
book includes the AstroInfo Project, a series of short, interlinked articles explaining some of the
celestial and astrophysical concepts behind KStars.
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Chapter 3

Configuring KStars

3.1 Setting the Geographic Location

Here is a screenshot of the Set Geographic Location window:

There is a list of over 3400 predefined cities available to choose from. You set your location by
highlighting a city from this list. Each city is represented in the world map as a small dot, and
when a city is highlighted in the list, a red crosshairs appears on its location in the map.

It is not practical to scroll through the full list of 3400 locations, looking for a specific city. To
make searches easier, the list can be filtered by entering text in the boxes below the map. For
example, in the screenshot, the text A appears in the City Filter box, while Te has been entered in
the Province Filter box, and USA is in the Country Filter box. Note that all of the cities displayed
in the list have city, province, and country names that begin with the entered filter strings, and
that the message below the filter boxes indicates that 6 cities are matched by the filters. Also
notice that the dots representing these six cities in the map have been colored white, while the
unmatched cities remain gray.
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The list can also be filtered by location in the map. Clicking anywhere in the world map will
show only those cities within two degrees of the clicked location. At this time, you can search by
name, or by location, but not both at once. In other words, when you click on the map, the name
filters are ignored, and vice versa.

The longitude, latitude and time zone information for the currently-selected location are dis-
played in the boxes at the bottom of the window. If you feel that any of these values are inaccu-
rate, you can modify them and press the + (Add City) button to record your custom version of
the location. You can also define a completely new location by pressing the Clear Fields button,
and entering the data for the new location. Note that all fields except the optional State/Province
must be filled before the new location can be added to the list. KStars will automatically load
your custom locations for all future sessions. Please note, at this point, the only way to remove
a custom location is to remove the appropriate line from the file kstars/mycities.dat in your
folder qtpaths --paths GenericDataLocation.

If you add custom locations (or modify existing ones), please send us your mycities.dat file so
that we can add your locations to the master list.

3.2 Setting the Time

When KStars starts up, the time is set to your computer’s system clock, and the KStars clock is
running to keep up with the real time. If you want to stop the clock, select Stop Clock from the
Time menu, or simply click on the Stop Clock icon in the toolbar. You can make the clock run
slower or faster than normal, or even make it run backward, using the time-step spinbox in the
toolbar. This spinbox has two sets of up/down buttons. The first one will step through all 83
available time steps, one by one. The second one will skip to the next higher (or lower) unit of
time, which allows you to make large timestep changes more quickly.

You can set the time and date by selecting Set Time... from the Time menu, or by pressing the
time icon in the toolbar. The Set Time window uses a standard KDE Date Picker widget, coupled
with a spinbox for setting the hours and minutes. If you want to re-synchronize the simulation
clock back to the current CPU time, just select Set Time to Now from the Time menu.

NOTE
KStars can accept very remote dates beyond the usual limits imposed by QDate. Currently, you can
set the date between the years -100000 and +100000. We may extend this range even further in
future releases. However, please be aware that the accuracy of the simulation becomes more and
more degraded as more remote dates are examined. This is especially true for the positions of solar
system bodies.

3.3 The Configure KStars Window

The Configure KStars window allows you to modify a wide range of display options. You can
access the window with the configure toolbar icon, or by selecting Configure KStars... from the
Settings menu. The window is depicted below:
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The Configure KStars window is divided into eleven pages: Catalogs, Solar System, Satellites,
Supernovae, Guides, Colors, FITS, INDI, Ekos, Xplanet and Advanced.

In the Catalogs page, you determine which object catalogs are displayed in the map along with
several properties.

In the Solar System page, you can specify whether the Sun, Moon, planets, comets and asteroids
are displayed.

The Satellites page allows you to set the satellites view options.

The Supernovae page allows you to manage how supernovae are displayed by KStars.

The Guides page lets you toggle whether non-objects are displayed (i.e., constellation lines, con-
stellation names, the Milky Way contour).

The Colors page allows you to set the color scheme, and to define new custom color schemes.

For detailed explanation of the options on the FITS page see the Configure FITS section.

For detailed explanation of the options on the INDI page see the Configure INDI section.

For detailed explanation of Ekos astrophotography suite, see the Ekos section of this manual.

The Xplanet page provides fine-grained control over Solar system planet surface renderer
Xplanet (should be installed separately).

The Advanced page provides fine-grained control over the more subtle behaviors of KStars.
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3.4 Catalogs

In the Catalogs page, you can configure which object catalogs are displayed by KStars, as well
as how much information you would like to be included on the Sky Map. By default, KStars
includes ~300,000 named and unnamed stars up to magnitude 8. For Deep Sky Objects, the
included catalogs are New General Catalog (‘NGC’), Index Catalog (‘IC’), and Messier Catalog.

New General Catalogue of Nebulae and Clusters of Stars (abbreviated as NGC) is a catalogue of
7,840 deep-sky objects.

Index Catalogue of Nebulae and Clusters of Stars (abbreviated as IC) serves as a supplement to
the NGC, and contains an additional 5,386 objects, collectively known as the IC objects.

Messier Catalogue is a catalogue of 110 deep-sky objects, including diffuse nebulae, planetary
nebulae, open clusters, globular clusters and galaxies. Messier objects have names like M1, M2,
up to M110. The maximum apparent visual magnitude of Messier Catalogue is represented by
M91’s value of 10.2.
You can install new catalogues using KStars ‘Add-On Installer’. You can open it by opening the
Data → Download New Data... submenu. You can choose from a list of catalogues, including:

• Steinicke NGC/IC Catalog: is a more complete NGC/IC catalog.

• Abell Planetary Nebulae Catalog: is a catalog of 86 planetary nebulae. The maximum magni-
tude is represented by Abell 47’s value of 19.5.

• Sharpless HII region Catalog: is the Sharpless (Sh2) catalog of HII regions (diffuse nebulae).

• Hickson Compact Groups: is a catalog consisting of 99 compact groups of galaxies.

• Tycho-2 Star Catalog: is a catalog of more than 2.5 million of the brightest stars. It contains
stars with a magnitude value from 8.0 to 12.5.

• USNO NOMAD Catalog: is a catalog of about 100 million stars with magnitude from 12.5 to
16.5. Note that is requires Tycho-2 to be installed.

The following is a summary of catalogs in KStars:
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Name Abbreviation Number of objects Magnitude
Default Catalog Default ~300,000 Up to 8 magnitude

Tycho-2 Tycho2 more than 2.5
million 8.0-12.5

Naval Observatory
Merged Astronomic
Dataset

USNO NOMAD 100 million 12.5-16.5

Table 3.1: Stars Catalogues

Name Abbreviation Number of objects Magnitude
Index Catalogue of
Nebulae and
Clusters of Stars

IC 5,386 Up to 18.3
magnitude

New General
Catalogue of
Nebulae and
Clusters of Stars

NGC 7,840 -

Messier Catalogue - 110 Up to 10.2
magnitude

Steinicke NGC/IC - - -
Abell Planetary
Nebulae Catalog - 86 Up to 19.5

magnitude
Sharpless HII region
Catalog Sh2 - -

Hickson Compact
Groups - 99 -

Table 3.2: Deep-sky objects Catalogues

The Stars section allows you to manage how stars are displayed in KStars. You can choose to see
the stars or not by checking the Star Catalogs checkbox. If you check it, then multiple options
will be enabled. Thus, you can set how many stars are drawn on the map using the Star Density
slider. You can also customize KStars to toggle star name and magnitudes. Star names are drawn
next to bright stars. To display labels of fainter stars, increase the Label density slider.

Below the stars section, the Deep-Sky Objects section controls the display of several non-stellar
object catalogs. You can toggle the display of Deep Sky Objects and control the display of their
names and magnitudes. By default, the list of deep-sky objects includes the Messier, NGC and IC
catalogs. Addons catalogs are available via the Data → Download New Data... submenu where
you can download catalogs provided by KStars team and the community. Furthermore, KStars
supports import of custom catalogs. To import a raw ASCII catalog data file into KStars, press the
Import Catalog and follow the instructions. To import a custom catalog already in KStars catalog
format, press the Load Catalog button. Each line in the custom catalog file should contain the
following space-separated fields:

For stars: type(0 for stars), RA, Dec, mag, SpType, name(optional)

For other types: type(3-8), RA, Dec, mag (optional), flux(optional), name(optional)

The types are:

• 0: star
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• 1: star (in object catalog...probably don’t want to use this)

• 2: planet (don’t use this in custom catalog)

• 3: open cluster

• 4: globular cluster

• 5: gaseous nebula

• 6: planetary nebula

• 7: supernova remnant

• 8: galaxy

• 18: radio source

The SpType is a short string for the spectral type. For example, ‘B5’ or ‘G2’. The coordinates
should be given as floating-point values, in the J2000.0 epoch. The name can be anything you
wish. If the name is more than one word, it must be enclosed in quotation marks.

Once you have constructed a custom data file, open the KStars configuration window to the
Catalogs tab, and press the Import Catalog... button. A popup window appears in which you
can specify a name for the catalog, and the name of the file (including the path):

When you press Ok button, KStars will attempt to read the lines of your data file. It will report
any problems, and if any lines at all were successfully parsed, you are given a choice to accept
the data file (ignoring any unparsed lines), or to cancel the operation to attempt to resolve the
problems first.

You can load a new catalog using the Load Catalog... button. A new window will appear, asking
you to specify the file that contains the catalog.
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Once the data file has been accepted, your custom catalog will be loaded on startup along with
the standard catalogs. In the Catalogs window is a checkbox for each catalog which toggles the
display of catalog objects.

Note that, if you want to load a catalog that is already loaded, a warning dialog will pop-up.
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You can remove custom catalogs by highlighting its checkbox in the Catalogs window, and press-
ing the Remove Catalog... button (this button is active only if a custom catalog is highlighted in
the list of checkboxes). Note that it can not be used for removing KStars default catalogs.

For radio sources catalogs, you must include the flux frequency and units. For example:

# Flux Frequency: 1420 Mhz
# Flux Unit: mJy

The following is a simple catalog file:

# Name: my_catalog
# Prefix: et_radio
# Color: #00ff00
# Epoch: 2000
# Flux Frequency: 1420 Mhz
# Flux Unit: mJy
# ID RA Dc Tp Mj Mn PA Nm Flux
J0001 12:31:23.1 +11:29:34 18 180.60 360.30 45 my_radio_source 70

Using the Catalogs window, you can define faint limits for sky objects for zoomed in and zoomed
out states of the rendering. When the Show objects of unknown magnitude item is enabled,
objects whose magnitudes are unknown, or not available to KStars, are drawn irrespective of the
faint limits set.
The following is a brief tutorial on adding new catalogues to KStars. To import a new catalog,
download a raw catalog data file where the data columns are space delimited. Any lines starting
with # shall be ignored. For this example, we shall use the ‘Lynds Catalog of Dark Nebulae’.

• Download / write the raw catalog data file (the raw file is the file containing catalog’s objects
described by a set of parameters, like: ID Number, Right Ascension, Declination and so on).
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IMPORTANT
In order to successfully load a custom catalog into KStars, you need to use the following syntax:
(otherwise your catalog will be entirely ignored or maybe some objects from your catalog will be
wrongly drawn)

– Every object should be written on a separate row.

– The fields of each line should be separated by white space.

– The catalog header may contain comment lines beginning with the # symbol.

– ID number: integer value.

– Right Ascension: colon-delimited hh:mm:ss.s or floating-point value.

– Declination: colon-delimited dd:mm:ss.s or floating-point value.

– Object type: integer value, one of [ 0,1,2,3,4,5,6,7,8 ].

– Common name: string value (if it contains a space, it *must* be enclosed in quotes!).

– Magnitude: floating-point value.

– Major axis: floating-point value (length of major axis in arcmin).

– Minor axis: floating-point value (length of minor axis in arcmin).

– Position angle: floating-point value (position angle, in degrees).

The following is a subset of the original raw data file:

1 16 26.0 -16 0 .18 +21.82 .054 3 49 8 452
2 18 4.0 -31 30 .13 -05.32 1.240 2 0 4 837
3 18 0.0 -31 0 .15 -04.33 5.600 2 0 6 817
4 16 59.5 -22 8 .18 +11.82 .004 5 27 7 533
5 17 13.2 -24 22 .20 +07.96 .012 4 0 9 595

The raw file contains some extra information, unusable for KStars. It also contains extra
white spaces and values are not meeting KStars expectations (i.e. for Right Ascension: colon-
delimited hh:mm:ss.s or floating-point value). Thus, it need to be modified in order to match
KStars format. For a better understanding on what each column means, you can take a look at
the original source of the catalog. It contains the raw data file and, in addition, it contains an
useful readme, which will help you understand what you should keep and furthermore, what
you need to remove from the raw data file. Minimally, the raw data file should contain the
following fields:

– ID Number
– Object Type
– Right Ascension
– Declination

The raw ‘Dark Nebulae by Lynds’ contains only three usable fields for KStars: Right Ascension,
Declination and Area (square degrees). Therefore, in order to properly import the catalog into
KStars, the ID and Object Type fields need to be added. You can insert these values manually
using your favorite text editor. However, it is recommended to use any spreadsheet application
to import the raw data file and add the necessary columns. This is especially convenient for
large data sets. Since the original raw data contains an area field which is not supported by
KStars, we need to approximate it to a usable value which is the Major Axis. Therefore, we use
the following formula in the spreadsheet to convert area to major axis in arcminutes: Major
Axis = sqrt(Area) * 60
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After importing the raw data file into KStars and selecting the appropriate columns, KStars
shall generate the final catalog file suitable for loading directly into KStars. For example, this
is a small subset of the content (header + first five objects) of the ‘Dark Nebulae by Lynds’
catalog which was created by KStars after importing the raw data file which only contains the
data columns:

# Delimiter:
# Name: LyndsCatalog
# Prefix: Lynds
# Color: #ff7600
# Epoch: 2000
# ID RA Dc Mj Tp
1 16:26:0 -16:0:0.1 13.943 5
2 18:4:0 -31:30:0.1 66.813 5
3 18:0:0 -31:0:0.1 141.986 5
4 16:59:5 -22:8:0.1 3.795 5
5 17:13:2 -24:22:0.2 6.573 5

As seen above, each column was assigned a KStars designated header such as the ID, Right As-
cension, Declination, Major axis and Object Type fields. Note that the Catalog Prefix (‘Lynds’)
and the ID field are used together for identifying objects in the Sky Map (i.e. objects from this
catalog will have names like: Lynds 1, Lynds 2, Lynds 617 up to the last object, Lynds 1791).

• Open the Settings → Configure KStars... menu and choose Catalogs tab.

• In the Deep-Sky objects section, press the Import Catalog... button. If the button is not avail-
able, check the Deep-Sky Catalogs checkbox. This will enable you to configure KStars deep-
sky objects catalogs.

• After you press the Import Catalog... button, Import Catalog window will pop up. At first,
click on Open file dialog button in order to select the raw data file.

• In the dialog window, find your raw file, select it and then press Open button.
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• Now, you need to specify the correct order of the catalog fields within the raw data file. The
fields must be added inside Catalog fields list. Note that you can drag fields in order to build
the right order or you can use additional fields from Available fields fields. For example, if
your raw data file contains a magnitude column, then you need to add Magnitude field to the
Catalog fields list.

• After you set the fields so that they match to your catalog raw file, you can move to the next
step: completing the remaining input fields: Coordinate epoch, Catalog name prefix, Cata-
log name and Save catalog as. You can also choose the Symbol color used for your catalog.
There you can specify how the fields are split within the raw data file: CSV (Comma-separated
values) or Space Delimited.
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• You can preview the output by pressing the Preview Output button. Pay attention to the
header fields to have the same order as your catalog fields (i.e. ID RA Dec Major Axis and
Object Type).

• Press OK button to close the Catalog Preview window. Then press OK button again to create
and save your catalog.

• After you successfully imported your catalog, it will be displayed in the catalogs list. You can
choose to be displayed or not, by pressing on its checkbox.
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3.5 Solar System

In the Solar System page, you can specify whether the Sun, Moon, planets, comets and asteroids
are displayed, and whether the major bodies are drawn as colored circles or actual images. You
can also toggle whether solar system bodies have name labels attached, and control how many of
the comets and asteroids get name labels. There is an option to automatically attach a temporary
‘orbit trail’ whenever a solar system body is tracked, and another to toggle whether the color of
the orbit trail fades into the background sky color.
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3.6 Satellites

The Satellites page allows you to set the satellites view options. Firstly, you can see or hide the
satellites on the skymap using Show satellites checkbox from the top View options section. By
default, satellites are drawn as small light red filled circles with an optional dark red name label
next to them. You can enable or disable these labels by checking or not the Show labels checkbox.
It is located below the Show satellites checkbox, within the View options section.

The colors of the dots representing satellites and their name labels can be easily customized using
the Colors page from the same Configure KStars window. In addition, satellites can be drawn
just like regular stars by checking the Draw satellites like stars checkbox. To display only the
visible satellites from your current geographic location and time, select Show only visible satel-
lites.
KStars can draw artificial satellites from many predefined groups. Thus, you can select to display
a particular group, multiple groups or partially select subgroups. Under each group, a list of
individual satellites is presented. To select all satellites from a group, you need to check the
group checkbox. You can also select only the satellites of interest in each group. The satellites
orbital elements can be updated via the internet by pressing the Update TLEs button. Another
way for updating the satellites orbital elements is to use the Updates → Update satellites orbital
elements in the Data menu. If you know the name of a desired satellite then you can use the
search satellites method that KStars provides. You need to enter the name of satellite in the
Search satellites text box and the list will be reduced only to its best matches.

You can add new satellites to KStars default satellites set by editing the kstars/data/satellite
s.dat file. As each line of this file is a group of satellites, you need to add a new entry for your
desired satellites group. An entry should have the following format: Group Name;local_fil
ename;url. For example: Iridium;iridium.tle;http://celestrak.com/NORAD/ele
ments/iridium.txt.
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3.7 Supernovae

The Supernovae page allows you to decide if the supernovae are displayed or not by checking
the Show supernovae checkbox. By default, supernovae are drawn as small light orange ‘+’
mark. As for satellites, the color of supernovae can be easily customized using the Colors page.

You can configure KStars to check for newly discovered supernovae on startup by checking the
Check for Recent Supernovae on Startup checkbox. This way, KStars will be always up-to-date
with the most recent supernovae. You can enable supernova alerts using the Enable Supernova
alerts checkbox. Thus, KStars will automatically alert you every time it learns of a new supernova
in the sky. You can set the magnitude limit for showing a supernova as well as magnitude limit
for supernova alerts using the spin boxes control. The limiting magnitude is the faintest apparent
magnitude of an skyobject that is visible with the naked-eye or a telescope.

The list of recent supernovae can be updated via the internet by pressing the Update List of
Recent Supernovae button. Another way for updating the supernovae list is to use the Updates
→ Update Recent Supernovae data item in the Data menu.
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3.8 Guides

The Guides page lets you toggle whether non-objects are displayed (i.e., constellation lines, con-
stellation names, the Milky Way contour, the celestial equator, the ecliptic, the horizon line,
and the opaque ground). You can also choose whether you would like to see Latin constel-
lation names, IAU-standard three-letter abbreviations, or constellation names using your local
language.
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3.9 Colors

The Colors page allows you to set the color scheme, and to define custom color schemes. The tab
is split into two panels:

The left panel shows a list of all display items with adjustable colors. Click on any item to bring
up a color selection window to adjust its color. Below the list is the Star Color Mode selection
box. By default, KStars draws stars with a realistic color tint according to the spectral type of the
star. However, you may also choose to draw the stars as solid white, black or red circles. If you
are using the realistic star colors, you can set the saturation level of the star colors with the Star
Color Intensity spinbox.

The right panel lists the defined color schemes. There are four predefined schemes: the Default
Colors scheme, Star Chart, which uses black stars on a white background, Night Vision, which
uses only shades of red in order to protect dark-adapted vision, and Moonless Night, a more
realistic, dark theme. Additionally, you can save the current color settings as a custom scheme
by clicking the Save Current Colors button. It will prompt you for a name for the new scheme,
and then your scheme will appear in the list in all future KStars sessions. To remove a custom
scheme, simply highlight it in the list, and press the Remove Color Scheme button.

3.10 FITS

FITS (Flexible Image Transport System) is a popular open standard for storage, transmission and
processing of digital data. For the details, one is referred to the corresponding Wikipedia article.
This page allows you to configure presentation and processing of FITS data in KStars.

The left panel is for configuring FITS viewer itself.

Check the Use FITS Viewer item if you want automatically display received images in the FITS
Viewer.
The Single Preview Tab item is to display all captured FITS images in a single tab instead of
multiple tabs per image. The Single Window Capture item is to display captured FITS images
from all cameras in a single FITS Viewer window instead of a dedicated window to each camera.
The Single Window Open item is to display opened FITS images in a single FITS Viewer window
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instead of a dedicated window to each file and the Independent Window item is to make FITS
Viewer window independent from KStars.

The right panel lists processing options. The Auto Stretch item is to always apply auto stretch to
images in FITS Viewer, Limited Resources Mode is to enable limited resource mode to turn off
any resource-intensive operations, namely: Auto Debayer (bayered images will not be debay-
ered; only grayscale images are shown), Auto WCS (World Coordinate System data will not be
processed; WCS maps sky coordinates to image coordinates; equatorial grid lines, object identifi-
cation, and telescope slew within an image are disabled), and 3D Cube (RGB images will not be
processed; only grayscale images are shown). You can switch off some of these resource-greedy
operations separately as well.

3.11 INDI

For detailed explanation of the options on the INDI page see the Configure INDI section.
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3.12 Ekos

Ekos is an astrophotography suite, a complete astrophotography solution that can control all
INDI devices including numerous telescopes, CCDs, DSLRs, focusers, filters, and a lot more.
Ekos supports highly accurate tracking using online and offline astrometry solver, autofocus and
autoguiding capabilities, and capture of single or multiple images using the powerful built in
sequence manager. For detailed explanation of Ekos, see the Ekos section of this manual.
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3.13 Advanced

The Advanced page provides fine-grained control over the more subtle behaviors of KStars.

The Correct for atmospheric refraction checkbox controls whether the positions of objects are
corrected for the effects of the atmosphere. Because the atmosphere is a spherical shell, light from
outer space is ‘bent’ as it passes through the atmosphere to our telescopes or eyes on the Earth’s
surface. The effect is largest for objects near the horizon, and actually changes the predicted rise
or set times of objects by a few minutes. In fact, when you ‘see’ a sunset, the Sun’s actual position
is already well below the horizon; atmospheric refraction makes it seem as if the Sun is still in the
sky. Note that atmospheric refraction is never applied if you are using Equatorial coordinates.

The Use animated slewing checkbox controls how the display changes when a new focus posi-
tion is selected in the map. By default, you will see the sky drift or ‘slew’ to the new position;
if you uncheck this option, then the display will instead ‘snap’ immediately to the new focus
position.

If the Attach label to centered object checkbox is selected, then a name label will automatically
be attached to an object when it is being tracked by the program. The label will be removed when
the object is no longer being tracked. Note that you can also manually attach a persistent name
label to any object with its popup menu.

There are three situations when KStars must redraw the sky display very rapidly: when a new
focus position is selected (and Use animated slewing is checked), when the sky is dragged with
the mouse, and when the time step is large. In these situations, the positions of all objects must
be recomputed as rapidly as possible, which can put a large load on the CPU. If the CPU cannot
keep up with the demand, then the display will seem sluggish or jerky. To mitigate this, KStars
will hide certain objects during these rapid-redraw situations, as long as the Hide objects while
moving checkbox is selected. The timestep threshold above which objects will be hidden is de-
termined by the Also hide if time step larger than: timestep-spinbox. You can specify the objects
that should be hidden in the Configure Hidden Objects group box.

3.14 Customizing the Display

There are several ways to modify the display to your liking.
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• Select a different color scheme in the Settings → Color Schemes menu. There are four prede-
fined color schemes, and you can define your own in the Configure KStars window.

• Toggle whether the Toolbars are drawn in the Settings → Toolbars Shown menu. Like most
KDE toolbars, they can also be dragged around and anchored on any window edge, or even
detached from the window completely if they are unlocked.

• Toggle whether the Info Boxes are drawn in the Settings → Info Boxes menu. In addition, you
can manipulate the three Info Boxes with the mouse. Each box has additional lines of data that
are hidden by default. You can toggle whether these additional lines are visible by double-
clicking a box to ‘shade’ it. Also, you can reposition a box by dragging it with the mouse.
When a box hits a window edge, it will ‘stick’ to the edge when the window is resized.

• Choose an ‘FOV Symbol’ using the Settings → FOV Symbols menu. FOV is an acronym for
‘field-of-view’. An FOV symbol is drawn at the center of the window to indicate where the
display is pointing. Different symbols have different angular sizes; you can use a symbol to
show what the view through a particular telescope would look like. For example, if you choose
the ‘7x35 Binoculars’ FOV symbol, then a circle is drawn on the display that is 9.2 degrees in
diameter; this is the field-of-view for 7x35 binoculars.
You can define your own FOV symbols (or modify the existing symbols) using the Edit FOV
Symbols... menu item, which launches the FOV Editor:

The list of defined FOV symbols is displayed on the left. On the right are buttons for adding a
new symbol, editing the highlighted symbol’s properties, and removing the highlighted sym-
bol from the list. Note that you can even modify or remove the four predefined symbols (if you
remove all symbols, the four defaults will be restored the next time you start KStars). Below
these three buttons is a graphical preview display showing the highlighted symbol from the
list. When the New... or Edit... button is pressed, the New FOV Indicator window is opened:
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This window lets you modify the four properties that define a FOV symbol: name, size, shape,
and color. The angular size for the symbol can either be entered directly in the Field of View
edit box, or you can use the Eyepiece/Camera Tabs to calculate the field-of-view angle, given
parameters of your telescope/eyepiece or telescope/camera setup. The five available shapes
are: Square, Circle, Crosshairs, Bullseye and Semitransparent circle. Once you have specified
all four parameters, press Ok, and the symbol will appear in the list of defined symbols. It will
also be available from the Settings → FOV Symbols menu.

3.15 HiPS Progressive Overlay

KStars provides support for HiPS: Hierarchical Progressive Surveys. HiPS provides multi-
resolution progressive surveys to be overlayed directly in client applications. It provides an
immersive experience as you can explore the night sky dynamically. With over 200+ surveys
across the whole electromagnetic spectrum from radio, infrared, visual, to even gamma rays, the
user can pan and zoom progressively deeper into the data visually.

It can be enabled from the HiPS All Sky Overlay submenu in the View menu.

Under the submenu, a list of enabled surveys are listed. Click on the survey of interest to activate
it. You can only activate one-overlay at a time. After activating the survey, KStars shall begin
downloading the data in the background and progressively overlay the images unto the sky map
as they become ready. Zooming in usually requires another patch of images that should trigger
another download cycle.
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The above screenshot shows the DSS Color visual overlay in KStars.

HiPS Settings submenu includes the following pages:

• Display: Enable or disable Linear Interpolation and HiPS Grid. The interpolation is enabled
by default and should make the overlay appear smoother.

• Cache: Set the Disk and Memory cache size in MB. Increase cache size if you have abundant
resources and want to reduce bandwidth required to download the images.

• Sources: Browse a list of HiPS sources and enable/disable them accordingly. When you se-
lect each source, a summary and a preview are downloaded that include information on the
mission in additional to technical data on the survey.
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Chapter 4

Command Reference

4.1 Menu Commands

4.1.1 File Menu

File → Open FITS... (Ctrl+O)

Open a FITS image in the FITS Viewer tool

File → Save Sky Image... (Ctrl+I)

Create image on disk from current display

File → Run Script... (Ctrl+R)

Run the specified KStars script

File → Printing Wizard

Starts a wizard to configure capturing sky objects images using telescope and printing the
results as a good looking printout for further use or catalogization.

File → Print... (Ctrl+P)
Send the current sky map to the printer (or to a PostScript/PDF file)

File → Quit (Ctrl+Q)
Quit KStars

4.1.2 Time Menu

Time → Set Time to Now (Ctrl+E)
Sync time to system clock

Time → Set Time... (Ctrl+S)
Set time and date

Time → Advance one step backward in time (<)

Advance one step backward in time in the KStars simulation of the sky chart. The duration
of the time step can be configured after pressing the little > button on the KStars toolbar.
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Time → Stop Clock

Toggle whether time passes

Time → Advance one step forward in time (>)

Advance one step forward in time in the KStars simulation of the sky chart. The duration
of the time step can be configured after pressing the little > button on the KStars toolbar.

4.1.3 Pointing Menu

Pointing → Zenith (Z)

Center the display at the Zenith point (straight up)

Pointing → North (N)

Center the display above the North point on the horizon

Pointing → East (E)

Center the display above the East point on the horizon

Pointing → South (S)

Center the display above the South point on the horizon

Pointing → West (W)

Center the display above the West point on the horizon

Pointing → Set Coordinates Manually... (Ctrl+M)

Center the display on specific sky coordinates

Pointing → Find Object (Ctrl+F)

Locate an object by name using the Find Object Window

Pointing → Stop Tracking (Ctrl+T)

Toggle tracking on/off. While tracking, the display will remain centered on the current
position or object.

4.1.4 View Menu

View → Zoom in (Ctrl++)
Zooms view in

View → Zoom out (Ctrl+-)
Zooms view out

View → Default Zoom (Ctrl+Z)
Restore the default Zoom setting

View → Zoom to Angular Size... (Ctrl+Shift+Z)

Zoom to specified field-of-view angle

View → Full Screen Mode (Ctrl+Shift+F)
Toggle full-screen mode
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View → Switch to star globe view / Switch to horizontal view (Space)

Toggle between the Horizontal and Equatorial Coordinate Systems

View → Projection → Lambert Azimuthal Equal-area (F5)

Switch sky chart view to the Lambert azimuthal equal-area projection.

View → Projection → Azimuthal Equidistant (F6)

Switch sky chart view to the azimuthal equidistant projection.

View → Projection → Orthographic (F7)

Switch sky chart view to the orthographic projection.

View → Projection → Equirectangular (F8)

Switch sky chart view to the equirectangular projection.

View → Projection → Stereographic (F9)

Switch sky chart view to the stereographic projection.

View → Projection → Gnomonic (F10)

Switch sky chart view to the gnomonic projection.

View → HiPS All Sky Overlay

Select and configure HiPS sky overlays

4.1.5 Tools Menu

Tools → Calculator (Ctrl+Shift+C)
Opens the AstroCalculator Tool, which provides full access to many of the mathematical
functions used by KStars.

Tools → Devices → Telescope Wizard...

Opens the Telescope Wizard, which provides a step-by-step guide to help you connect to
your telescope and control it with KStars.

Tools → Devices → Device Manager... (Ctrl+D)

Opens up the device manager, which allows you to start/shutdown device drivers and
connect to remote INDI servers.

Tools → Devices → INDI Control Panel...
Opens up INDI Control Panel, which allows you to control all the features supported by a
device.

Tools → Sky Calendar

Opens the Sky Calendar Tool, which allows you to plan observations of Solar System plan-
ets by giving graphical data on sets and rises of these objects.

Tools → Altitude vs. Time (Ctrl+A)
Opens the Altitude vs. Time Tool, which can plot curves representing the altitude of any
object as a function of time. This is useful for planning observing sessions.

Tools → What’s Up Tonight (Ctrl+U)

Opens the What’s Up Tonight Tool, which presents a summary of the objects which are
observable from your location on a given date.
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Tools → What’s Interesting... (Ctrl+W)

Opens the What’s Interesting Tool, which allows you to be informed about the most inter-
esting observations that can be made from your current location using the given equipment.

Tools → Script Builder (Ctrl+B)

Opens the Script Builder Tool, which provides a GUI interface for building KStars D-Bus
scripts.

Tools → Solar System (Ctrl+Y)

Opens the Solar System Viewer, which displays an overhead view of the solar system on
the current simulation date.

Tools → Ekos (Ctrl+K)
Opens Ekos, a complete and powerful tool for astrophotography. With Ekos, you can align
and guide your telescope, focus your CCD, and capture images using an easy intuitive
interface.

Tools → Jupiter’s Moons (Ctrl+J)

Opens the Jupiter Moons Tool, which displays the positions of Jupiter’s four brightest
moons as a function of time.

Tools → Flags

Opens the Flag manager Tool, which can be used to assign color labels and icons to the
given positions on the sky chart.

4.1.6 Data Menu

Data → Download New Data... (Ctrl+N)
Open the Get Hot New Stuff dialog to download additional data for KStars.

Data → Updates

This submenu can be used to update various object data, namely asteroids, comets and
satellites orbital elements as well as recent supernovae data from the Internet. The data
will be downloaded for the current user account only. If you use KStars from different
account you should download them for every account separately.
KStars tries to download recent supernovae list automatically by default. You can switch
the download off using Supernovae page of KStars Settings window.

4.1.7 Observation Menu

Observation → Observation Planner (Ctrl+L)
Open the Observation Planner tool.

Observation → Execute the session Plan (Ctrl+2)
Opens session plan wizard or execute the planned session.
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4.1.8 Settings Menu

Settings → Info Boxes → Show Info Boxes

Toggle display of all three Info Boxes:

• Time Box
• Focus Box
• Location Box

Settings → Info Boxes → Show Time Box

Toggle display of the Time Info Box. By default, the Time Info Box is located in the top left
side of the screen. You can change the position of Time Info Box by holding the left-click
mouse button and dragging it to the new position.

Settings → Info Boxes → Show Focus Box

Toggle display of the Focus Info Box. By default, the Focus Info Box is located in the top
right side of the screen. You can change the position of Focus Info Box by holding the
left-click mouse button and dragging it to the new position.

Settings → Info Boxes → Show Location Box

Toggle display of the Location Info Box. By default, the Location Info Box is located in the
bottom left side of the screen. You can change the position of Location Info Box by holding
the left-click mouse button and dragging it to the new position.

Settings → Toolbars Shown → Main Toolbar

Toggle display of the Main Toolbar. By default, the Main Toolbar provides useful shortcuts
for controlling the sky map view (i.e. Zoom in and Zoom out) and for controlling KStars
clock as well. You can Start / Stop the clock, advance one step backward / forward in time
and also you can easily set the time step used by KStars’ clock. The time step is the rate
at which time flows in the simulation. For setting the time step, you can use the spin box
used for establishing the time step units and the spin box used for increasing / decreasing
the time step value. Using the Main Toolbar you can quickly open the Find Object, Set
Time or Set Geographic Location window. Main Toolbar can be configured using Settings
→ Configure Toolbars.

Settings → Toolbars Shown → View Toolbar

Toggle display of the View Toolbar. View Toolbar controls which sky objects are drawn on
KStars Sky Map (stars, deep sky objects, Solar system objects, supernovae or satellites) as
well as what constellation information is included (constellation lines, constellation names,
constellation art or constellation boundaries). It also provides icon shortcuts for: showing
milky way (drawn with dark grey color), showing equatorial/horizontal coordinate grid
and for showing the green opaque ground. Note that when the horizon is switched off,
refraction effects are temporarily disabled. View Toolbar can be configured using Settings
→ Configure Toolbars.

Settings → Toolbars Shown → INDI Toolbar

Toggle display of the INDI Toolbar. By default, INDI Toolbar contains three shortcut icons:

• Toggle Ekos
• Toggle INDI Control Panel
• Toggle FITS Viewer

INDI Toolbar can be configured using Settings → Configure Toolbars.

Settings → Statusbar → Show Statusbar

Toggle display of the Statusbar. It is located in the bottom of KStars window.
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Settings → Statusbar → Show Az/Alt Field

Toggle display of the mouse cursor’s horizontal coordinates in the statusbar.

Settings → Statusbar → Show RA/Dec Field

Toggle display of the mouse cursor’s equatorial coordinates in the statusbar.

Settings → Statusbar → Show J2000.0 RA/Dec Field

Toggle display of the mouse cursor’s equatorial J2000 coordinates in the statusbar.

Settings → Color Schemes

This submenu contains all of the defined color schemes: Classic, Star Chart, Night Vision
and Moonless Night. It can also include your custom color schemes. Select any item to set
that color scheme.

Settings → FOV Symbols

This submenu lists the available field-of-view (FOV) Symbols. The FOV Symbol is drawn
at the center of the display. You may choose one or more from the list of predefined sym-
bols (7x35 Binoculars, Telrad, One Degree, HST WFPC2 or 30m at 1.3cm) by checking their
specific checkbox, or you may use no symbol by unchecking all the items from the symbols
list. You can also define your own symbols (or modify existing symbols) using the Edit
FOV Symbols... option.

Settings → Artificial Horizon

If you select this submenu, then Artificial Horizon Manager will be opened. Artificial Hori-
zon Manager is used to define on the skymap one or more regions that are blocked from
view from your current location (i.e. tall trees or building). The window is split in two
sections: in the left side is the Regions section while in the right side is the Points section.
You can add a new region by pressing the + (Add Region) button or you can remove a
region by selecting it in the regions list and then pressing the - (Remove Region) button.
In order to draw a region you need to define a list of points that encompasses the blocked
area. You can add a new point by pressing the + (Add Point) button from the right Points
section. You can also remove a highlighted point from the list of points or you can clear
all the points. There are two ways to add a new point to a selected region: manually by
entering the point’s coordinates or by selecting the point from the skymap after clicking
Select Points button. Note that each point is described by a set of horizontal coordinates:
Az (Azimuth) and Alt (Altitude). If you want to modify a point’s coordinates, just double
click on its Az/Alt text box value and enter the new value. First and Last points must be
on the horizon. Polygons must be closed to be considered valid regions. Artificial Horizon
Manager provides a easy way to rename your regions. By default, regions are named as:
‘Region ’ plus an index (i.e. ‘Region 1’ or ‘Region 2’). For renaming a region, just double
click on its name and then you will be invited to complete a new region name. You can also
control which regions are enabled or disabled for marking on the map by a simple click
on the checkbox in front of each region. After you defined your desired regions you can
apply them by pressing the Apply button. If you want to use these regions again, in further
astronomy sessions, you can save them such that next time when you will open KStars they
will be automatically marked on the skymap.

Settings → Configure Observation Logging → List your Equipment (Ctrl+0)

Allows you to define your equipment characteristics for observation logs. The Configure
Equipment window is divided into four tabs: Telescope, Eyepiece, Lens and Filter. You
can add a new equipment by completing its characteristics and pressing Add New... button.
You can also save or remove an equipment from the list.

Settings → Configure Observation Logging → Manage Observer (Ctrl+1)

Selecting this will open Manage Observers window that enables you to register a number of
observers which are using KStars on this computer. You can add a new entry to observers
list by completing the mandatory fields: Name and Surname and then pressing the + (Add
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observer) button. Note that Contact field is optional, KStars allowing you to add a new
observer even though Contact text box is empty. You can also remove an observer from the
list using - (Remove observer) button.

Settings → Geographic (Ctrl+G)

Select a new geographic location.

Settings → Configure KStars

Modify configuration options.

Settings → Configure Shortcuts

Open the Configure Shortcuts window which allows you to modify KStars shortcuts. You
can use KStars default shortcuts scheme or define your own shortcuts scheme. In order to
add a new custom shortcut to an action, you need to click on action’s name and then press
the Custom checkbox. Then click on the button next to Custom checkbox and enter the
shortcut you would like to use in KStars. You can also remove a shortcut by pressing the
Delete button after you select an action from the list. KStars helps you to find an action by
providing its search method; just enter the name of the action and the list will be reduced
to its best matches. For example, I will give you a brief example on how to use KStars
Configure Shortcuts feature:

• Firstly, open the Configure Shortcuts window from the Settings menu.
• Then select the action you would like to add a shortcut (i.e. Artificial Horizon). You can

use the search method provided by KStars. Just type ‘art’ in the search text box and the
list will be reduced to only four actions. The Artificial Horizon is the first action in the
list.

• Now that you find your desired action, you can add a new shortcut by clicking on its
name. After you click on the action name, press the Custom checkbox. There is a button
next to Custom checkbox used for adding new shortcuts. By default, if an action has no
custom shortcut, the ‘None’ tag will be assigned to this button. Press this button and
then add your custom shortcut. For example, for Artificial Horizon, you can use Ctrl+H
shortcut. Hold the Ctrl key and press H. Your shortcut be automatically saved, thus you
can use it next time when you open KStars.

Settings → Configure KStars...

Modify configuration options.

Settings → Startup Wizard

By selecting the Startup Wizard... submenu, the ‘Setup Wizard’ window will pop up. It
is the same window that you saw when you ran KStars for the very first time. KStars
Setup Wizard will help you set up some basic options, such as your location on Earth.
The first page of Setup Wizard is a welcome page and if you press Next button, you will
get the ‘Choose Your Home Location’ page. Here you can select your exact home location
or a city near your home location if your accurate location is not present in KStars cities
database. Browsing the entire list is not so efficient and thus, KStars provides you a easy-
to-use method for selecting your desired city in a short time. You may filter the list of cities
by the name of your city, province and country. By giving more details about your location,
the list’s size will reduced only to its best matches. When you highlight a city in the cities
list, the Longitude and Latitude boxes will be updated, containing the accurate information
of your selected location. When you hit the Next button, you will get the last page of KStars
Setup Wizard: ‘Download Extra Data Files’ page. Here you may download optional data
files via the Internet, in order to enhance KStars, such as Messier object images, or a more
complete NGC/IC catalog. Press the Download Extra Data button to proceed. After you
pressed the Download Extra Data button, the ‘Get Hot New Stuff’ window will appear. It is
KStars Add-On Installer, which will help you to manage what extra information you added
to KStars. Firstly, you can choose how the add-ons list is displayed, by pressing the Details
view mode or Icons view mode button. You may also order the list by various criteria like:
newest, rating, most downloads or installed. This can be easily done by selecting an option
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using the radio button. You can also make searches using the Search: text box. Regarding
the list of add-ons, you may perform several actions by selecting an add-on from the list:
you can install or uninstall an add-on using the Install / Uninstall button, you can open
the Details window using the Details button or you can rate an add-on by giving a number
of gold stars, up to five stars. If you want to send an email to the author of an add-on, you
are able to do that by clicking on his e-mail address. Then, your default e-mail application
will guide you through the sending process. After you managed your KStars add-ons, then
you can close the window by pressing the Close button. You can also use the Download
Extra Data Files tool later, by selecting Data → Download New Data....

Additionally KStars has the common KDE Settings and Help menu items, for more information
read the sections about the Settings Menu and Help Menu of the KDE Fundamentals.

4.1.9 Help Menu

KStars has the common KDE Help menu item, for more information read the section about the
Help Menu of the KDE Fundamentals.

4.1.10 Popup Menu

The right click popup menu is context-sensitive, meaning its content varies depending on what
kind of object you click on. We list all possible popup menu items here, with the relevant object
type [in brackets].

[All]
Identification and type: The top one to three lines are devoted to the name(s) of the object,
and its type. For stars, the Spectral Type is also shown here.

[All]
Rise, Transit, and Set times for the object on the current simulation date are shown on the
next three lines.

[All]
Center & Track: Center the display on this location, and engage tracking. Equivalent to
double-clicking.

[All]
Add flag...: Open KStars ‘Flag manager’ window. Here you can manage your flags and
use some of KStars features. When ‘Flag manager’ window is open for a selected object,
Right ascension and Declination text boxes will be automatically filled with the coordinate
values of the selected object on the Sky Map. Besides these two text boxes, you can set
the Epoch, add a Label, set the Label color or even add an Icon. To add custom icons,
just add images in ‘qtpaths --paths GenericDataLocation‘/kstars/ . File names must
begin with the ‘flag’ keyword. For example, the file ‘flagSmall_red_cross.gif’ will be shown
as Small red cross in the combo box. After you set up the information of the new flag, you
can add it to the flags list using the Add button. You may also change flags details (i.e.
RA/Dec, label or icon) and then save the new ones by pressing the Save changes button.
Using the Flag manager, you can easily center an object in Map or in Telescope, by pressing
Center in Map or Center in Telescope button. In order to delete a value from the list, just
select it in the list and then press Delete button. Your flags are saved after you close current
session and thus you will be able to see them everytime you will use KStars again.
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[All]
Angular Distance To...: Enter ´́ angular distance mode´́ . In this mode, a dotted line is
drawn from the first target object to the current mouse position. When you click with the
right mouse button on a second object, this will display the angular distance between the
two objects near the second object. You can press the Esc key to exit angular distance mode
without measuring an angle.

[All]
Starhop from here to: will enable you to find a path between two points in the sky. Star
hopping is a technique that uses bright stars as a guide for finding fainter objects. So if
you have a bright star, you can use it as a reference to find a fainter object. Starting from
your reference star, KStars will find a route to the destination, traversing a sequence of
stars/patterns of stars. The object for which you called Starhop from here to tool will
be your starting point. When your starting point is established, a dotted line will appear,
allowing you to decide which will be your end point. You have to move the mouse cursor
to your destination object position and right click on it. Then, a dialog box will pop up,
requiring you to set the FOV used for star hopping. For selecting a FOV, you need to make
a choice from the FOV combo box list of values. The values you can choose include default
FOV values (7x35 Binoculars, Telrad, One Degree, HST WFPC2 and 30m at 1.3cm) plus
your customized FOVs. After you selected the FOV, KStars will find a route for you. Thus,
the dialog box will contain a list of object used in the starhop. If KStars did not manage to
find a route, then an error dialog box will be displayed, giving you a helping hand. When
the Star-Hopper algorithm ends, the dialog box will contain a list of objects used in starhop
route. For every object from the list, you can perform a set of actions: you can ask for details
using the Details button, center selected object in the map using Center on map button or
you can go to next star by pressing the Next button. Note that when go to next star, it will
be automatically centered on the map. Also, Star-Hopper tool provides directions to star
hop for every object of the list.

[All]
Details: Open the Object Details window for this object.

[All]
Attach Label: Attach a permanent name label to the object. If the object already has a label
attached, this item will read Remove Label.

[All]
Add to Observing WishList: Add the selected object to Observation Planner’s Wish List.
You can see the Wish List, by selecting Observation → Observation Planner. If the object
is already in the Observing WishList, then this item will become Remove Label.

[Solar system objects]

Add Trail: Add a trail to current Solar system object. A star trail is the continuous path
created by the star in the night sky due to the rotation of the Earth. If the object already has
a trail, this item will become Remove Trail.

[All]
Simulate eyepiece view: Eyepiece View feature renders the view through the eyepiece of
various telescope types. Firstly, an input dialog is shown, which asks you to select one of
the visible FOVs to use as a FOV for the eyepiece view. The user also has the option of
trying to determine it from the image (accurate if image has metadata, otherwise it will be
random). After you set the FOV, the ´́ Eyepiece Field View´́ window will pop up. You can
easily rotate the view using the ´́ Rotation´́ slider. You can also flip and invert the view
to help match the view through a telescope/camera. ´́ Eyepiece view´́ tool can help you
locate many objects with ease, instead of trying to work with relative positions and relative
orientations. This is an important advantage, especially when you are star hopping. Note
that for getting best results, time must be synced with current time in KStars, and KStars
must be in horizontal coordinates mode.
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[Solar system objects]

Image Resources: gives a list of image links for current Solar system object. The images are
displayed in KStars Image Viewer tool. Image Viewer tool allows you to invert the colors
and save the image in your computer.

[Solar system objects]

Information Resources: gives a list of documentation links for current Solar system object.
The links are opened in your default browser.

[All objects without Solar system objects]

Show SDSS Image: download a SDSS (Sloan Digital Sky Survey) image of the object from
the Internet, and display it in the Image Viewer tool.

[All objects without Solar system objects]

Show DSS Image: download a DSS (Digitized Sky Survey) image of the object from the
Internet, and display it in the Image Viewer tool.

4.2 Keyboard Commands

4.2.1 Navigation Keys

Arrow Keys

Use the arrow keys to pan the display. Holding down the Shift key doubles the scrolling
speed.

+ / -
Zoom In/Out

Ctrl+Z
Restore the default Zoom setting

Ctrl+Shift+Z
Zoom to specified field-of-view angle

0–9
Center Display on a major Solar System body:

• 0: Sun
• 1: Mercury
• 2: Venus
• 3: Moon
• 4: Mars
• 5: Jupiter
• 6: Saturn
• 7: Uranus
• 8: Neptune
• 9: Pluto

Z
Center the display at the Zenith Point (straight up)

N
Center the display above the North point on the horizon
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E
Center the display above the East point on the horizon

S
Center the display above the South point on the horizon

W
Center the display above the West point on the horizon

Ctrl+T
Toggle tracking mode

<
Advance the simulation clock backwards by one time step

>
Advance the simulation clock forwards by one time step

4.2.2 Menu Shortcuts

Ctrl+N
Download extra data

Ctrl+O
Open a FITS image in the FITS Editor

Ctrl+I
Export sky image to a file

Ctrl+L
Run a KStars Observation Planner.

Ctrl+R
Run a KStars D-Bus script

Ctrl+P
Print the current sky map

Ctrl+Q
Quit KStars

Ctrl+E
Sync the simulation clock with the current system time

Ctrl+S
Set the simulation clock to a specified Time and Date

Ctrl+Shift+F
Toggle full-screen mode

Ctrl+0
Define equipment (telescope, eyepiece, lens and filter) characteristics for observation logs.

Ctrl+1
Add a new observer item for your observation logs

Space

Toggle between the Horizontal and Equatorial Coordinate Systems
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F1
Open the KStars Handbook

F5
Switch sky chart view to the Lambert azimuthal equal-area projection.

F6
Switch sky chart view to the azimuthal equidistant projection.

F7
Switch sky chart view to the orthographic projection.

F8
Switch sky chart view to the equirectangular projection.

F9
Switch sky chart view to the stereographic projection.

F10
Switch sky chart view to the gnomonic projection.

4.2.3 Actions for the Selected Object

Each of the following keystrokes performs an action on the selected object. The selected object is
the last object which was clicked on (identified in the status bar). Alternatively, if you hold down
the Shift key, then the action is performed on the centered object instead.

C
Center and Track on the selected object

D
Open the Details window for the selected object

L
Toggle a name label for the selected object

O
Add the selected object to the observing list

P
Open the selected object’s popup menu

T
Toggle a trail on the selected object (solar system bodies only)

4.2.4 Tools Shortcuts

Ctrl+F
Open the Find Object window, for specifying a sky object on which to center

Ctrl+M
Open the Set Coordinates Manually tool, for specifying RA/Dec or Az/Alt coordinates on
which to center
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[
Start an Angular Distance measurement at the current mouse cursor position. The angular
distance between start and end points is displayed at the endpoint.

Ctrl+G
Open the Set Geographic Location window

Ctrl+C
Open the AstroCalculator

Ctrl+A
Open the Altitude vs. Time tool

Ctrl+U
Open the What’s Up Tonight? tool

Ctrl+W
Open the ‘What’s Interesting’ tool

Ctrl+B
Open the Script Builder tool

Ctrl+Y
Open the Solar System Viewer

Ctrl+J

Open the Jupiter Moons tool

4.3 Mouse Commands

Moving the mouse

The sky coordinates (Az/Alt, RA/Dec and J2000.0 RA/Dec) of the mouse cursor are up-
dated in the status bar. The status bar is located in the right bottom corner of the screen.
The status bar can be customized by selecting Settings → Statusbar submenu. Here you
may choose what coordinates systems KStars will display in the status bar. Furthermore,
you can hide the status bar by unchecking the Show Statusbar checkbox.

´́ Hovering´́ the mouse

A temporary name label is attached to the object nearest to the mouse cursor.

Left-clicking

The object nearest the mouse click is identified in the status bar.

Double-clicking

Center and track on the location or object nearest the mouse click. Double-clicking on an
Info Box will ‘shade’ it to show/hide extra information.

Right-clicking

Open the popup menu for the location or object nearest the mouse cursor.

Scrolling the mouse wheel

Zoom the display in or out. If you do not have a mouse wheel, you can hold the middle
mouse button and drag vertically.
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Click-and-dragging

Dragging the sky map
Pan the display, following the drag motion.

Ctrl+dragging the sky map
Define a rectangle in the map. When the mouse button is released, the display is
zoomed in to match the field-of-view to the bounds of the rectangle.

Dragging an Info Box
The Info Box is repositioned in the map. Info Boxes will ‘stick’ to window edges, so
that they remain on the edge when the window is resized.
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Chapter 5

KStars Tools

KStars comes with a number of tools that allow you to explore some more advanced aspects of
astronomy and the night sky.

• Object Details

• Astrocalculator

• Altitude vs. Time Plotter

• What’s Up Tonight?

• Simulate Eyepiece View

• Script Builder

• Solar System Viewer

• Ekos

• Jupiter Moons Tool

• Observation Planner

• FITS Viewer
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5.1 Object Details Window

The Object Details Window presents advanced data available about a specific object in the sky.
To access this tool, right-click on any object, and select the Details... item from the popup menu.

The window is divided into a number of Tabs. In the General Tab, we present basic data about
the current object. This includes names and catalog designations, object type, and magnitude
(brightness). On the Position tab are the object’s Equatorial and Horizontal coordinates, as well
as its rise, set and transit times.

In the Links tab, you can manage the internet links associated with this object. The Image and
Information links associated with the object are listed. These are the links that appear in the
popup menu when the object is right-clicked. You can add custom links to the object with the
Add Link... button. This will open a window in which you fill in the URL and link text for the
new link (you can also test the URL in the web browser from this window). Every time you add
a custom URL to a certain object, you are able to choose the resource type using the Resource
Type radio button. It has two predefined values: ‘Image’ or ‘Information’. Keep in mind that the
custom link can easily point to a file on your local disk, so you can use this feature to index your
personal astronomical images or observing logs.

You can also modify or remove any link using the Edit Link... and Remove Link... buttons.

The Advanced Tab (not available for all objects) allows you to query professional astronomical
databases on the internet for information regarding the current object. To use these databases,
double click on the desired database in the list to see the results of your query in a web browser
window. The query is made using the primary name of the object you clicked on to open the
Details Dialog. The following databases are available for querying:

• High Energy Astrophysical Archive (HEASARC). Here you can retrieve data about the current
object from a number of ‘High-energy’ observatories, which covers the Ultraviolet, X-ray and
Gamma Ray portions of the electromagnetic spectrum.

• Multimission Archive at Space Telescope (MAST). The Space Telescope Science Institute pro-
vides access to the entire collection of images and spectra taken with the Hubble Space Tele-
scope, as well as several other space-based observatories.
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• NASA Astrophysical Data System (ADS). This incredible bibliographic database encompass
the entire body of literature published in international peer-review Journals about astronomy
and astrophysics. The database is divided into four general subject areas (Astronomy and
Astrophysics, Astrophysics Preprints, Instrumentation, and Physics and Geophysics). Each of
these has three sub-nodes that query the database in different ways. ‘Keyword search’ will
return articles which listed the object’s name as a keyword. ‘Title word search’ will return
articles which included the object name in their Title, and the ‘Title & Keyword search’ uses
both options together.

• NASA/IPAC Extragalactic Database (NED). NED provides encapsulated data and biblio-
graphic links about extragalactic objects. You should only use NED if your target is extra-
galactic; i.e. if it is itself a galaxy.

• Set of Identifications, Measurements, and Bibliography for Astronomical Data (SIMBAD). SIM-
BAD is similar to NED, except it provides data about all kinds of objects, not just galaxies.

• SkyView provides images from All-Sky surveys that have been performed in dozens of differ-
ent parts of the spectrum, from Gamma Rays to the Radio. The KStars interface will retrieve
an image from any of these surveys, centered on the selected object.

Finally, in the Log Tab, you can type in some text that will remain associated with this object’s
Details window. You could use this to attach personal observing notes, for example. Your notes
will be saved, such that you can easily read or use them next time when you will use KStars.

5.2 The Astrocalculator

The KStars Astrocalculator provides several modules that give you direct access to algorithms
used by the program. The modules are organized by subject:

COORDINATE CONVERTERS

• Angular Distance

• Apparent Coordinates

• Ecliptic Coordinates

• Equatorial/Galactic Coordinates

• Horizontal Coordinates

• Geodetic Coordinates

SOLAR SYSTEM

• Planets Coordinates

TIME CALCULATORS

• Almanac

• Equinoxes and Solstices

• Julian Day

• Sidereal Time
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5.2.1 Angular Distance module

The Angular Distance tool is used to measure the angle between any two points on the sky. You
simply specify the Equatorial coordinates of the desired pair of points, and then obtain the angle
between the two points.

There is also a Batch mode for this module. In batch mode, you specify an input filename which
contains a number of parameters (up to four) on each line: the initial right ascension (RA), initial
declination (Dec), final right ascension and final declination. By default, each line should contain
four numbers signifying the RA and Dec values for pairs of points. Alternatively, you can specify
a single value for any of these four coordinates in the calculator panel (the corresponding values
in the input file should be skipped if they are specified in the calculator).

Once you have specified the input filename and an output filename, simply press the Run button
to generate the output file.
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5.2.2 Apparent Coordinates module

The Apparent Coordinates module converts the catalog coordinates of a point in the sky to its
apparent coordinates for any date. The coordinates of objects in the sky are not fixed, because of
precession, nutation and aberration. This module takes these effects into account.

To use the module, first enter the desired target date and time in the Target Time & Date section.
Then, enter the catalog coordinates in the Catalog Coordinates section. Alternatively you can set
the catalog coordinates by selecting an object using the Find Object dialog. You can also specify
the catalog’s epoch here (usually 2000.0 for modern object catalogs). Then the object’s coordinates
for the target date will be displayed in the Apparent Coordinates section.
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5.2.3 Ecliptic Coordinates module

This module converts between Equatorial coordinates and Ecliptic coordinates. First, select Date
& time. Then, fill in the coordinate values in either the Ecliptic Coordinates or Equatorial Coor-
dinates section. Alternatively set the equatorial coordinates by selecting an object using the Find
Object dialog. Then the complementary coordinates will be filled in.

5.2.4 Equatorial/Galactic Coordinates module
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This module converts from Equatorial coordinates to Galactic coordinates, and vice versa. Fill
in the coordinate values in either the Galactic coordinates or Equatorial coordinates section.
Alternatively set the equatorial coordinates by selecting an object using the Find Object dialog.
Then the complementary coordinates will be filled in.

The module contains a batch mode for converting several coordinate pairs at once. You must
construct an input file in which each line contains two values: the input coordinate pairs (either
Equatorial or Galactic). Then specify which coordinates you are using as input, and identify the
input and output filenames. Finally, press the Run button to generate the output file, which will
contain the converted coordinates (Equatorial or Galactic; the complement of what you chose as
the input values).

5.2.5 Horizontal Coordinates module

This module converts from Equatorial coordinates to Horizontal coordinates. First, select the
date, time, and geographic coordinates for the calculation. Then, fill in the equatorial coordi-
nates to be converted or use the Find Object dialog in the Equatorial Coordinates section. The
corresponding Horizontal coordinates will be presented in the Horizontal Coordinates section.
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5.2.6 Geodetic Coordinates module

The normal geographic coordinate system assumes that the Earth is a perfect sphere. This is
nearly true, so for most purposes geographic coordinates are fine. If very high precision is re-
quired, then we must take the true shape of the Earth into account. The Earth is an ellipsoid;
the distance around the equator is about 0.3% longer than a Great Circle that passes through the
poles. The Geodetic Coordinate system takes this ellipsoidal shape into account, and expresses the
position on the Earth’s surface in Cartesian coordinates (X, Y and Z) or in Geographic coordinates
(Longitude, Latitude and Elevation).

To use the module, first select which coordinates you will use as input in the Select Input Coor-
dinates section: ‘Cartesian’ or ‘Geographic’. Then select an ellipsoid model and fill in the input
coordinates in either the Cartesian Coordinates section or the Geographic Coordinates section.
When you press the Convert button, the corresponding coordinates will be filled in.

The module contains a batch mode for converting several coordinate values at once. You must
construct an input file in which each line contains up to three numbers: the input coordinate
values (either Cartesian or Geographic). Then specify which coordinates you are using as input,
and identify the input and output filenames. Finally, press the Run button to generate the output
file, which will contain the converted coordinates (Cartesian or Geographic; the complement of
what you chose as the input values).
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5.2.7 Planet Coordinates module

The Planet Coordinates module computes positional data for any major solar system body, for
any time and date and any geographic location. Simply select the Solar system body from the
drop-down list, and specify the desired date, time, and geographic coordinates (these values are
preset to the current KStars settings). Then the Equatorial, Horizontal, and Ecliptic coordinates
of the body are computed and displayed.

There is a batch mode for this module. You must construct an input file in which each line speci-
fies values for the input parameters (solar system body, date, time, longitude, and latitude). You
may choose to specify a constant value for some of the parameters in the calculator window
(these parameters should be skipped in the input file). You may also specify which of the out-
put parameters (Equatorial, Horizontal, Heliocentric ecliptic and Geocentric ecliptic coordinates)
should be calculated. Finally, specify the input and output filenames, and press the Run button
to generate the output file with the computed values.
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5.2.8 Day Duration module

This module computes the length of day as well as sunrise, sun-transit (noon), and sunset times
for any calendar date, for any location on Earth. First select the desired geographic coordinates
and date, then the data is computed and displayed.

5.2.9 Equinoxes and Solstices module

The Equinoxes and Solstices module calculates the date and time of an equinox or solstice for a
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given year. You specify the year and the date and time of the events (Vernal Equinox, Summer
Solstice, Autumnal Equinox, or Winter Solstice) are displayed.

There is a batch mode for this module. To use it, simply generate an input file whose lines each
contain a year for which the Equinox and Solstice data will be computed. Then specify the input
and output filenames, and press the Compute button to generate the output file. Each line in
the output file contains the input year and the date of each event. You can also read the output
directly in KStars by pressing the View output button.

5.2.10 Julian Day module

This module converts between the calendar Date and time, the Julian Day, and the Modified Julian
Day. The Modified Julian Day is simply equal to the Julian Day - 2,400,000.5.

To use the module, enter one of the three dates and the corresponding values for the other two
date systems will be displayed. You can also set the Date and time to now, by pressing the Now
button.
There is a batch mode for this module. To use it, simply generate an input file whose lines each
contain a number of values for the input parameter: ‘Date and time’, ‘Julian day’ or ‘Modified
Julian day’. Then specify the input and output filenames, and press the Compute button to
generate the output file. The output file will contains values for the other two complementary
parameters. For example, if your input file contains a set of ‘Date and time’ values, then each line
of the output file will contain values for ‘Julian day’ and ‘Modified Julian day’. You can read the
output directly in KStars by pressing the View output button.

TIP
Exercise:
What calendar date does MJD = 0.0 correspond to?
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5.2.11 Sidereal Time module

This module converts between Universal Time and Local Sidereal Time. First, select a geographic
location and a date for the calculation. Then the corresponding value for the other Time will be
displayed.

There is a batch mode for this module. To use it, simply generate an input file whose lines each
contain values for the input parameter: ‘sidereal time’ or ‘standard time’. You can choose to set
the Date and Location in the current window, or you can tell KStars to read the Date and Location
values from the input file. Then specify the input and output filenames, and press the Compute
button to generate the output file. The output file will contains values for the complementary
parameter. For example, if your input file contains a set of ‘standard time’ values, then each line
of the output file will contain values for ‘sidereal time’. You can read the output directly in KStars
by pressing the View output button.
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5.3 Altitude vs. Time Tool

This tool plots the altitude of any objects as a function of time, for any date and location on Earth.
The top section is a graphical plot of altitude angle on the vertical axis, and time on the horizontal
axis. The time is shown both as standard local time along the bottom, and sidereal time along the
top. The bottom half of the graph is shaded green to indicate that points in this region are below
the horizon.
There are a few ways to add curves to the plot. The simplest way to add the curve of an existing
object is to simply type its name in the Name input field, and press Enter, or the Plot button. If
the text you enter is found in the object database, the object’s curve is added to the graph. You
can also press the Find Object button to open the Find Object Window to select an object from
the list of known objects. If you want to add a point that does not exist in the object database,
simply enter a name for the point, and then fill in the coordinates in the RA and Dec input fields.
Then press the Plot button to add the curve for your custom object to the plot (note that you have
to pick a name that does not already exist in the object database for this to work).

When you add an object to the plot, its altitude vs. time curve is plotted with a thick white line,
and its name is added to the listbox at the lower right. Any objects that were already present
are plotted with a thinner red curve. You can choose which object is plotted with the thick white
curve by highlighting its name in the listbox.

These curves show the objects’ Altitude (angle above the horizon) as a function of time. When a
curve passes from the lower half to the upper half, the object has risen; when it falls back to the
lower half, it has set. For example, in the screenshot, the minor planet Quaoar is setting at around
15:00 local time, and is rising at about 04:00 local time.

The plot can be easily zoomed and panned using the mouse. The zooming level can be adjusted
using the mouse scroll wheel. When the plot is zoomed out, the zooming level will be automati-
cally limited to a default minimum value, such as the axes’ ranges are able to cover the entire plot
(i.e. on vertical axis, the maximum altitude value should touch the top edge of the plot frame).
The same principle is applied when the plot is panned using the mouse movement. For panning
the plot, all you need to do is to click on the point of the plot you want to pan and then drag the
mouse on your desired direction: left, right, up or down.

Another useful feature that Altvstime tool provides is its ability to compute and mark the
Rise/Set/Transit times. This can be accomplished by a simple press of one of the Rise, Set or
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Transit buttons. When one of these buttons is pressed, a filled colored circle will be marked on
the curve. The color used for Rise, Set and Transit dots are: red for Rise, blue for Set and green
for Transit time. For a more intuitive way of using these buttons, they are marked with the color
of their specific dots. This way, the user can easily understand the plot and make the association
between a certain color and its significance.

Altvstime tool provides an easy way to find out the altitude of a sky-object at a certain moment
of time using the Compute button. After you select the object from the Objects list and set the
moment of time, the altitude can be computed by pressing the Compute button. But this is not
the only way you can find out the altitude. Another method is to hover with mouse above one
curve and thus, a tooltip containing the Local Time, Local Sidereal Time and Altitude will come
up. This way, you can read the information in real time.

The Altitude of an object depends on both where you are on Earth, and on the Date. By default,
the Tool adopts the Location and Date from the current KStars settings. You can change these
parameters in the Date & Location Tab. To change the Location, you can press the Choose City...
button to open the Set Geographic Location Window, or enter Longitude and Latitude values
manually in the input fields, and press the Update button. To change the Date, use the spin
and combo boxes, then press Update. Note that any curves you had already plotted will be
automatically updated when you change the Date and/or Location.

TIP
Exercise:
Plot the Sun’s Altitude curve. Make sure the geographic location is not near the equator. Change the
Date to some time in June, and then again to sometime in January. You can see easily why we have
seasons; in the winter, the Sun is above the horizon for less time (the days are shorter), and its altitude
is never very high.
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5.4 Simulate Eyepiece View

On the left hand side is the sky map shot from KStars. On the right hand side is the POSS (DSS)
image of the same region. The orientation in the above example has been adjusted to match the

view through a Dobsonian telescope at the location and time of the simulation in KStars.

This tool simulates how an object looks through your eyepiece. In addition to rendering the
eyepiece field, KStars can also fetch and overlay the DSS imagery. Additionally, if you are using
a Dobsonian telescope, you can rotate the field of view to match the eyepiece view.

To use this feature, first define your eyepieces’ fields of view using the FOV Symbol editor.

Then there are two ways to invoke the feature:

• In Sky Map, right click on the desired object and click Simulate eyepiece view in the popup
menu.

• In observation planner, right click an object and click Simulate eyepiece view in the popup
menu.

When the tool is first invoked, it will prompt a dialog to select the desired FOV to render the
view. To compare the rendered view against a real sky image, click the Fetch DSS image button
to download a DSS image. You can manually adjust the view to match your eyepiece using
the rotation slider, the invert view and flip view check boxes. Alternatively, you can use a pre-
calculated amount of rotation by using one of the Presets that is tailored for different optical
systems.
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Arp84 eyepiece view with ticks enabled indicating how the chart must be oriented to match the
eyepiece view through a Dobsonian at a given time (the generated data is for location

McDonald Observatory Texas, and the date is 14th Dec 2016).

To export the view to a file, click Export button. Export enables adding ticks for printed charts as
shown above and save the image.

5.5 What’s Up Tonight? Tool
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The ‘What’s Up Tonight?’ (WUT) tool displays a list of objects that will be visible at night from
any location, on any date. By default, the Date and Location are taken from the current settings in
the main window, but you can change either value using the Change Date and Change Location
buttons at the top of the WUT window.

The WUT tool also displays a short almanac of data for the selected date: the rise and set times
for the Sun and moon, the duration of the night, and the Moon’s illumination fraction.

Below the almanac is where the object information is displayed. The objects are organized into
type categories. Select an object type in the box labeled Select a Category, and all objects of
that type which are above the horizon on the selected night will be displayed in the box labeled
Matching Objects. For example, in the screenshot, the Planets category has been selected, and
three planets which are up on the selected night are displayed (Mars, Jupiter and Saturn). When
an object in the list is selected, its rise, set and transit times are displayed in the lower-right panel
(i.e. Mars rises at 17:13, transits at 21:46 and sets at 02:16). In addition, you can press the Object
Details... button to open the Object Details window for that object.

By default, the WUT will display objects which are above the horizon between sunset and mid-
night (i.e. ‘in the evening’). You can choose to show objects which are up between midnight and
dawn (‘in the morning’), or between dusk and dawn (‘any time tonight’) using the combobox
near the top of the window. You can also choose to see only those objects that are brighter than a
magnitude by setting a minimum magnitude using the Show objects brighter than magnitude
spinbox. You may center the selected object in the Sky Map or add it to Wish List by pressing the
Center Object or Add to List button.

5.6 The Script Builder Tool

KDE applications can be controlled externally from another program, from a console prompt, or
from a shell script using the Inter-process communication protocol (D-Bus). KStars takes advan-
tage of this feature to allow rather complex behaviors to be scripted and played back at any time.
This can be used, for example, to create a classroom demo to illustrate an astronomical concept.

The problem with D-Bus scripts is, writing them is a bit like programming, and can seem a daunt-
ing task to those who do not have programming experience. The Script Builder Tool provides a
GUI point-and-click interface for constructing KStars D-Bus scripts, making it very easy to create
complex scripts.

5.6.1 Introduction to the Script Builder

Before explaining how to use the Script Builder, I provide a very brief introduction to all of the
GUI components; for more infomation, use the ´́ What’s This?´́ function.
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The Script Builder is shown in the above screenshot. The box on the left is the Current Script box;
it shows the list of commands that comprise the current working script. The box on the right
is the Function Browser; it displays the list of all available script functions. Below the Function
Browser, there is a small panel which will display short documentation about the script function
highlighted in the Function Browser. The panel below the Current Script box is the Function
Arguments panel; when a function is highlighted in the Current Script box, this panel will contain
items for specifying values for any arguments that the highlighted function requires.

Along the top of the window, there is a row of buttons which operate on the script as a whole.
From left to right, they are: New Script, Open Script, Save Script, Save Script As..., and Test
Script. The function of these buttons should be obvious, except perhaps the last button. Pressing
Test Script will attempt to run the current script in the main KStars window. You should move
the Script Builder window out of the way before pressing this, so you can see the results.

In the center of the window, there is a column of buttons which operate on individual script
functions. From top to bottom, they are: Add Function, Remove Function, Copy Function,
Move Up, and Move Down. Add Function adds the currently-highlighted function in the Func-
tion Browser to the Current Script box (you can also add a function by double-clicking on it). The
rest of the buttons operate on the function highlighted in the Current Script box, either removing
it, duplicating it, or changing its position in the current script.

5.6.2 Using the Script Builder

In order to illustrate using the Script Builder, we present a small tutorial example where we make
a script that tracks the Moon while the clock runs at an accelerated rate.

If we are going to track the Moon, we will need to point the display at it first. The lookToward
function is used to do this. Highlight this function in the Function Browser, and note the docu-
mentation displayed in the panel below the Browser. Press the Add Function button to add this
function to the Current Script box. The Function Arguments panel will now contain a combobox
labeled ‘Dir’, short for direction. This is the direction in which the display should be pointed. The
combobox contains only the cardinal compass points, not the Moon or any other objects. You can
either enter ‘Moon’ in the box manually, or press the Object button to use the Find Object win-
dow to select the Moon from the list of named objects. Note that, as usual, centering on an object
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automatically engages object-tracking mode, so there is no need to add the setTracking function
after lookToward.
Now that we have taken care of pointing at the Moon, we next want to make time pass at an
accelerated rate. Use the setClockScale function for this. Add it to the script by double-clicking
on it in the Function Browser. The Function Arguments panel contains a timestep spinbox for
setting the desired time step for the simulation clock. Change the timestep to 3 hours.

OK, we have pointed at the Moon and accelerated the clock. Now we just want the script to
wait for several seconds while the display tracks on the Moon. Add the waitFor function to the
script, and use the Function Arguments panel to specify that it should wait for 20 seconds before
continuing.

To finish up, let us reset the clock’s timestep to the normal value of 1 second. Add another
instance of setClockScale, and set its value to 1 sec.

Actually, we are not quite done yet. We should probably make sure that the display is using Equa-
torial coordinates before the script tracks the Moon with an accelerated time step. Otherwise, if
the display is using Horizontal coordinates, it will rotate very quickly through large angles as
the Moon rises and sets. This can be very confusing, and is avoided by setting the View Option
UseAltAz to ‘false’. To change any View Option, use the changeViewOption function. Add this
function to the script, and examine the Function Arguments panel. There is a combobox which
contains the list of all options which can be adjusted by changeViewOption. Since we know we
want the UseAltAz option, we could simply select it from the combobox. However, the list is
quite long, and there is no explanation of what each item is for. It therefore may be easier to press
the Browse Tree button, which will open a window containing a tree view of the available op-
tions, organized by topic. In addition, each item has a short explanation of what the option does,
and the data type of the option’s value. We find UseAltAz under the Skymap Options category.
Just highlight this item and press OK, and it will be selected in the combobox of the Function
Arguments panel. Finally, make its value ‘false’ or ‘0’.

One more step: changing UseAltAz at the end of the script does us no good; we need this to be
changed before anything else happens. So, make sure this function is highlighted in the Current
Script box, and press the Move Up button until it is the first function.

Now that we have finished the script, we should save it to disk. Press the Save Script button.
This will first open a window in which you can provide a name for the script, and fill in your
name as the author. Enter ‘Tracking the Moon’ for a name, and your name as the author, and
press OK. Next, you will see the standard KDE Save File dialog. Specify a filename for the script
and press OK to save the script. Note that if your filename does not end with ‘.kstars’, this suffix
will be automatically attached. If you are curious, you can examine the script file with any text
editor.
Now that we have a completed script, we can run it in a couple of ways. From a console prompt,
you can simply execute the script as long as an instance of KStars is currently running. Alter-
natively, you can execute the script from within KStars using the Run Script... item in the File
menu.
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5.7 Solar System Viewer

This tool displays a model of our solar system as seen from above. The Sun is drawn as a yellow
dot in the center of the plot, and the orbits of the planets are drawn as ellipses with the correct
shapes and orientations. The current position of each planet along its orbit is drawn as a colored
dot, along with a name label. The display can be zoomed in and out with the + and - keys, and the
display can be recentered with the arrow keys, or by double-clicking anywhere in the window
with the mouse. You can also center on a planet with the 0–9 keys (0 is the Sun; 9 is Pluto). If you
center on a planet, it will be tracked as time passes in the tool.

The Solar System Viewer has its own clock, independent of the clock in the main KStars window.
There is a timestep control widget here, similar to the one in the main window’s toolbar. How-
ever, this control defaults to a timestep of 1 day (so that the motions of the planets can be seen),
and it starts out with the clock paused when the tool is opened. You may set the date to now by
pressing the Today button.

NOTE
The current model used for Pluto’s orbit is only good for dates within about 100 years of the present
date. If you let the Solar System clock advance beyond this range, you will see Pluto behave very
strangely! We are aware of this issue, and will try to improve Pluto’s orbit model soon.

5.8 Ekos

Ekos is an advanced cross-platform (Windows®, OSX, Linux®) observatory control and automa-
tion tool with a particular focus on Astrophotography. It is based on a modular extensible frame-
work to perform common astrophotography tasks. This includes highly accurate GOTOs using
astrometry solver, ability to measure and correct polar alignment errors, auto-focus & auto-guide
capabilities, and capture of single or stack of images with filter wheel support. Ekos is shipped
with KStars.

Ekos introductory video

Features:
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• Control your telescope, CCD (& DSLRs), filter wheel, focuser, guider, adaptive optics unit, and
any INDI-compatible auxiliary device from Ekos.

• Built-in native Auto Guiding with support for automatic dithering between exposures and
support for Adaptive Optics devices in addition to traditional guiders.

• Extremely accurate GOTOs using astrometry.net solver (both Online and Offline solvers sup-
ported).

• Load & Slew: Load a FITS image, slew to solved coordinates, and center the mount on the
exact image coordinates in order to get the same desired frame.

• Measure & Correct Polar Alignment errors using astromety.net solver.

• Easy to use Polar Alignment Assistant tool. A very quick and reliable tool to polar align your
German Equatorial Mount!

• Capture and record video streams in SER format.

• Completely automated scheduler to control all your observatory equipment, select the best
targets for imaging given current conditions and constraints, monitor weather conditions, and
capture your data while you are away!

• Smart Dark Library: All your dark frames with different binning/temperature/frame settings
are saved for future use. Ekos re-uses dark frames intelligently without taking unnecessary
captures. You can configure how long you want to reuse all the dark frames.

• Define multiple driver profiles for local and remote setups. Switch among them easily.

• Auto and manual focus modes using Half-Flux-Radius (HFR) method.

• Automated unattended meridian flip. Ekos performs post meridian flip alignment, calibration,
focusing, and guiding to resume the capture session.

• Automatic focus between exposures when a user-configurable HFR limit is exceeded.

• Powerful sequence queue for batch capture of images with optional prefixes, timestamps, filter
wheel selection, and much more!

• Export and import sequence queue sets as Ekos Sequence Queue (.esq) files.

• Center the telescope anywhere in a captured FITS image or any FITS with World Coordinate
System (WCS) header.

• Automatic flat field capture, just set the desired ADU and let Ekos does the rest!

• Automatic abort and resumption of exposure tasks if guiding errors exceed a user-configurable
value.

• Support for dome slaving.

• Complete integration with KStars Observation Planner and SkyMap.

• Fully scriptable via DBus.

• Integrate with all INDI native devices.
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5.8.1 Ekos Setup

Ekos is a part of KStars. KStars/Ekos is already included with your StellarMate gadget. It is also
available for Linux, Mac OS, and Windows if you want to install on your primary machine. After
you run KStars on your PC or on StellarMate (Either directly via HDMI or via VNC), Ekos can
be accessed from the Tools menu or via the Ekos on the main toolbar, or by a keyboard shortcut
(Ctrl-K). In addition to the Ekos window, KStars provides a more detailed INDI Control Panel
where you can directly set and control the device parameters.

When running Ekos, it is not necessary to start INDI Server via StellarMate Web Manager as Ekos
manages that transparently.
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5.8.2 User Interface

Ekos Astrophotography Tool is organized into several Modules. A module is a set of functions and
tasks for a particular step in astrophotography and/or data acquisition. Currently, the following
modules are included with Ekos:

• Setup & Summary Module

• Scheduler Module

• Capture Module

• Focus Module

• Alignment Module

• Guide Module

• Mount Module

Each module has its own tab and icon in the graphical user interface as illustrated in the screen-
shot below:

Summary & Setup Module

As its name suggests, this is where you will create and manage your equipment profile,
and connect to your devices. It also provides a summary view where the capture progress
along with the focus & guide operations is displayed in a compact format to convey the
most important information relevant to the user.

Scheduler Module
After mastering Ekos, users are encouraged to learn how to use the Scheduler module since
it facilitates the complete observation process greatly. It enables you to select multiple tar-
gets, specify which conditions and requirements to be met, and what frames are required
for capture. Afterwards the scheduler intelligently calculates the best observation time for
each object and then proceed to control the complete observatory from startup to shutdown.
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Capture Module

This is the primary module for camera & filter wheel control. Create imaging sequences,
capture previews, and watch video streams. It supports rotator control and can automati-
cally capture flat frames in a number of scenarios.

Focus Module
Measure the sharpness of your images in the focus module by calculating Half-Flux-Radius.
The lower the HFR, the sharper the image becomes. You can run the focus module with or
without a focuser. With an electronic focuser, you can run an autofocus operation where
Ekos iterates and calculates the optical focus position.

Guide Module
To achieve long exposure astrophotography, guiding is necessary to ensure the image is
locked and stabilized for the complete duration of the exposure duration. Deviations from
the frame with time can lead to blurry images and star trails. In the guide module, it can
automatically select a suitable guide star and then lock the mount to always keep that star
in its position. If the guide module detects any deviation from this locked position, it sends
correction pulses to the mount to bring it back to the original position.

Mount Module
Mount control can be either done via the Sky Map interactively or via the Mount Control
Panel in the mount module. Configure telescope properties (focal length & aperture) for
both your primary imaging telescope and guide scope. However, it is recommended to
select the telescopes in the equipment profile and not change the values directly in the
mount module.

5.8.3 Profile Wizard

The Profile Wizard is a handy tool to setup your equipment for the first time. It should popup
automatically the first time you run KStars. Follow the guided instructions to setup your first
equipment profile.

Greeting Page
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The first greeting screen contains some links to learn more about Ekos & INDI. Click Next
to continue.

Equipment Location Page

Next, you will be presented with the equipment location page. Your selection depends on
where your equipment is connected to:

• Equipment is attached to your PC: Select this option if Ekos is running on your Stellar-
Mate (via HDMI or VNC), PC (Windows®/Linux®) or Mac® OS.

• Equipment is attached to a remote computer: Select this option if Ekos is running on
your PC (Windows®/Linux®) or Mac® OS, and your equipment is connected to a remote
computer.

• Equipment is attached to StellarMate: Select this option if Ekos is running on your PC
(Windows®/Linux®) or Mac® OS, and your equipment is connected to StellarMate.

Click next to continue.

Remote Connection Page

In case selected the 2nd option in the last step, you shall be presented with the Remote
Connect Page, here you will enter the hostname or IP address of the StellarMate unit. You
can get the hostname from the StellarMate mobile App. Alternatively, you can construct
the hostname from StellarMate HotSpot SSID. You should see the SSID when you search
for WiFi networks nearby. For example, suppose the SSID is stellarmate. The hostname
should be stellarmate.local. That is, if you remove the underscore, and append .local, then
you will get the unit hostname. You can always use the StellarMate App to change the unit
default hostname to the name of your choice.

81



The KStars Handbook

For the INDI Manager question, always select Yes since StellarMate Web Manager is run-
ning by default on the unit. Click Next to continue.

Profile Creation Page

Now you get to name your equipment profile. Afterwards select which guider application
to use. The Internal Guider is the only officially supported selection in StellarMate. You
may opt to select PHD2/LinGuider but the details are out of the scope of this documenta-
tion. If additional services are desired, check the ones you want to run.

In the example above, we select Remote Astrometry, WatchDog, and SkySafari drivers. The de-
tailed explanations for each is provided in the tooltip when you over them. Once done, click
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Create Profile button. You should now be presented with the Profile Editor.

5.8.4 Profile Editor

Profiles
You can define profiles for your equipment and their connection mode using the Profile
Editor. Ekos comes pre-installed with the Simulators profile which can be used to start
simulator devices for demonstration purposes:

• Connection Mode: Ekos can be started either locally or remotely. Local mode is when
Ekos is running in the same machine as INDI server, i.e. all the devices are connected
directly to the machine. If you run INDI server on a remote machine (for example, on a
Raspberry PI), you need to set the INDI server host and port.

• Auto Connect: Check this option to enable automatic connection to all your devices after
INDI server is started. If unchecked, INDI devices are created but not automatically
connected. This is useful when you want to make changes to the driver (e.g. change
baud rate or IP address or any other settings) before you connect to it.

• Site Info: Optionally, you can check the Site Info checkbox and Ekos will load the cur-
rent city and timezone whenever is Ekos is started with this profile. This can be useful
when connecting to the remote geographic site so that Ekos is in sync location and time
wise.

• Guiding: Select which Guide application you want to use for guiding. By default, the
Ekos internal Guide Module is utilized. External guiders include PHD2 and LinGuider.

• INDI Web Manager: StellarMate Web Manager is a web-based tool to start and stop
INDI drivers. You should always check this option when connecting remotely to a Stel-
larMate unit.

• Device Selection: Select your devices from each category. Please note that if you have
a CCD with a guide head, you can leave the guider drop-down menu blank as Ekos
will auto-detect the guide head from the CCD camera. Similarly, if your CCD includes
embedded filter wheel support, then you do not need to specify the filter wheel device in
the filter drop-down menu.
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Start & Stop INDI

Start and Stop INDI services. Once INDI server is established, INDI Control Panel will
be displayed. Here you can change some driver options such as which port the device is
connected to etc.

Connect & Disconnect Devices
Connect to INDI server. Based on the devices connected, Ekos modules (CCD, Focus,
Guide...etc) will be established and available to use.
Once you are ready, click Start INDI to establish INDI server and connection to your equip-
ment. Ekos shall create the various module icons (Mount, Capture, Focus, etc.) as the
connection is established with the device.

5.8.5 Logs

Logging is a very important tool in order to diagnose any issues with either INDI drivers or Ekos.
Before submitting any support request, the log must be attached in order to help diagnose the
exact issue. Depending on the exact problem, you may need to enable logging for the feature
or drivers that exhibit issues. Enabling logging for everything is not recommended as it will
produce too much data that would be useful to diagnose the issue and could result in missing
the root cause all other. So only enable the necessary logs.

The following short video explains how to use the Logging feature to submit logs.

Logging feature

5.8.6 Capture

The CCD Module is your primary image and video acquisition module in Ekos. It enables you
to capture single (Preview), multiple images (Sequence Queue), or record SER videos along with
a selection of filter wheel and rotator, if available.
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5.8.6.1 CCD & Filter Wheel Group

Select the desired CCD/DSLR and Filter Wheel (if available) for capture. Set CCD temperature
and filter settings.

• CCD: Select the active CCD camera. If your camera has a guide head, you can select it from
here as well.

• FW: Select the active Filter Wheel device. If your camera has a built-in filter wheel, the device
would be the same as the camera.

• Cooler: Toggle Cooler On/Off. Set the desired temperature, if your camera is equipped with
a cooler. Check the option to force temperature setting before any capture. Capture process is
only started after the measured temperature is within requested temperature tolerance. The
default tolerance is 0.1 degrees Celsius but can be adjusted in Capture options under Ekos
configuration.

5.8.6.2 Capture Settings

Set all capture parameters as detailed below. Once set, you can capture a preview by click on
Preview or add a job to the sequence queue.

• Exposure: Specify exposure duration in seconds.

• Filter: Specify the desired filter.

• Count: Number of images to capture

• Delay: Delay in seconds between image captures.

• Type: Specify the type of desired CCD frame. Options are Light, Dark, Bias, and Flat frames.

• ISO: For DSLR cameras, specify the ISO value.

• Format: Specify capture save format. For all CCDs, only FITS option is available. For DSLR
cameras, you can an additional option to save in Native format (e.g. RAW or JPEG).
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• Custom Properties: Set extended properties available in the camera to the job settings.

• Calibration: For Dark &s; Flat frames, you can set additional options explained in the Calibra-
tion Frames section below.

• Frame: Specify the left (X), top (Y), width (W), and height (H) of the desired CCD frame. If
you changed the frame dimensions, you can reset it to default values by clicking on the reset
button.

• Binning: Specify horizontal (X) and vertical (Y) binning.

5.8.6.2.1 Custom Properties

Many cameras offer additional properties that cannot be directly set in the capture settings using
the common control. The capture controls described above represent the most common settings
shared among different cameras, but each camera is unique and may offer its own extended
properties. While you can use INDI Control Panel to set any property in the driver; it is important
to be able to set such property for each job in the sequence. When you click Custom Properties,
a dialog is shown divided into Available Properties and Job Properties. When you move an
Available Properties to the Job Property list, its current value can be recorded once you click
Apply. When you add a job to the Sequence Queue, the properties values selected in the Job
Properties list shall be recorded and saved.

The following video explains this concept is more detail with a live example:

Custom Properties feature

5.8.6.3 File Settings

Settings for specifying where captured images are saved to, and how to generate unique file
names in addition to upload mode settings.

• Prefix: Specify the prefix to append to the generated filename. You may also append the frame
type, filter, expose duration, and ISO 8601 timestamp. For example, if you specify Prefix as
M45 and checked the Type and Filter checkboxes, and assuming your filter was set to Red and
your frame type is Light, the generated file names will be as follows:

– M45_Light_Red_001.fits
– M45_Light_Red_002.fits

If TS was checked, a timestamp will be appended to the filename, e.g.

– M45_Light_Red_001_2016-11-09T23-47-46.fits
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– M45_Light_Red_002_2016-11-09T23-48-34.fits

• Script: Specify an optional script to be executed after each capture is complete. The full path of
the script must be specified and it must executable. To denote success, the script must return
zero as this would allow the sequence to continue. If a non-zero value is returned by the script,
the sequence is aborted.

• Directory: Local directory to save the sequence images to.

• Upload: Select how captured images are uploaded:

1. Client: Captured images are only uploaded to Ekos and saved to the local directory spec-
ified above.

2. Local: Captured images are only saved locally on the remote computer.
3. Both: Captured images are saved on the remote device and uploaded to Ekos.

When selecting Local or Both, you must specify the remote directory where the remote images
are saved to. By default, all captured images are uploaded to Ekos.

• Remote: When selecting either Local or Both modes above, you must specify the remote di-
rectory where remote images are saved to.

5.8.6.4 Limit Settings

Limit settings are applicable to all the images in the sequence queue. When a limit is exceeded,
Ekos shall command the appropriate action to remedy the situation as explained below.

• Guiding Deviation: If checked, it enforces a limit of maximum allowable guiding deviation for
the exposure, if autoguiding is used. If the guiding deviation exceeds this limit in arcseconds,
it aborts the exposure sequence. It will automatically resume the exposure sequence again
once the guiding deviation goes below this limit.

• Autofocus if HFR exceeds a value: If autofocus is enabled in the focus module and at least
one autofocus operation was completed successfully, you can set the maximum acceptable
HFR value. If this option is enabled then between consecutive exposures, the HFR value is
recalculated, and if found to exceed the maximum acceptable HFR value, then an autofocus
operation is automatically triggered. If the autofocus operation is completed successfully, the
sequence queue resumes, otherwise, the job is aborted.

• Meridian Flip: If supported by the mount, set the hour angle limit (in hours) before a meridian
flip is commanded. For example, if you set the meridian flip duration to 0.1 hours. Ekos shall
wait until the mount passes the meridian by 0.1 hours (6 minutes), then it commands the
mount to perform a meridian flip. After the meridian flip is complete, Ekos re-aligns using
astrometry.net (if the alignment was used) and resumes guiding (if it was started before) and
then resumes the capture process automatically.
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5.8.6.5 Sequence Queue

Sequence Queue is the primary hub of the Ekos Capture Module. This is where you can plan and
execute jobs using the sequence queue built-in powerful editor. To add a job, simply select all the
parameters from the capture and file settings as indicated above. Once you selected your desired

parameters, click on the add button in the sequence queue to add it to the queue.

You can add as many jobs as desired. While it is not strictly necessary, it is preferable to add
the dark and flat jobs after the light frames. Once you are done adding jobs, simply click Start

Sequence to begin executing the jobs. A job state changes from Idle to In Progress and
finally to Complete once it is done. The Sequence Queue automatically starts the next job. If a

job is aborted, it may be resumed again. To pause a sequence, click the pause button and
the sequence will be stopped after the current capture is complete. To reset the status of all the

jobs, simply click the reset button . Please beware that all image progress counts are reset
as well. To preview an image in KStars FITS Viewer, click the Preview button.

Sequence queues can be saved as an XML file with extension .esq (Ekos Sequence Queue). To

load a sequence queue, click the open document button . Please note that it will replace
any current sequence queues in Ekos.

IMPORTANT
Job Progress: Ekos is designed to execute and resume the sequence over multiple nights if required.
Therefore, if Remember Job Progress option is enabled in Ekos Options, Ekos shall scan the file
system to count how many images are already completed and will resume the sequence from where
it was left off. If this default behavior is not desired, simply turn off Remember Job Progress under
options.

To edit a job, double click it. You will notice the add button now changed to check mark
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button . Make your changes on the left-hand side of the CCD module and once done,
click on the check mark button. To cancel a job edit, click anywhere on the empty space within
the sequence queue table.

If your camera supports live video feed, then you can click the Live Video button to start stream-
ing. The video stream window enables recording and subframing of the video stream. For more
information, check the video below:

Recording feature

5.8.6.6 Filter Settings

Click the filter icon next to the filter wheel selection box to open the filter settings dialog.
If you are using filters that are not parafocal with each other and require a specific amount of
focus offsets in order to get them into proper then set all the relative focus offsets in the dialog.

Configure settings for each filter individually:

1. Filter: Filter Name

2. Exposure: Set exposure time used when performing focus under this filter. By default, it is
set to 1 second.

3. Offset: Set relative offsets. Ekos will command a focus offset change if there is a difference
between the current and target filter offsets. For example, given the values in the example
image to the right, if the current filter is set to Red and next filter is Green, then Ekos shall
command the focuser to Focus In by +300 ticks. Relative positive focus offsets denote Focus
Out while negative values denote Focus In.

4. Auto Focus: Check this option to initial AutoFocus process whenever the filter is changed
to this filter.

5. Lock Filter: Set which filter should be set and locked when performing autofocus for this
filter.
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Let’s take an example. Suppose the capture sequence is running and the current filter is Green,
so the relative already offset is set to +300. The next image in the sequence uses Hydrogen Alpha
(H_Alpha) so before Ekos captures the next frame, the following actions take place:

• Since Luminosity is specified as the locked filter and auto-focus is checked, the filter is changed
to Luminosity

• A focus offset is -300 is applied since the prior filter Green was moved +300 previously.

• Auto Focus process is initiated.

• Once Auto Focus is complete, the filter is changed to H_Alpha.

• A focus offset of -1200 is applied.

• Capture sequence is resumed.

5.8.6.7 FITS Viewer

Captured images are displayed in KStars FITS Viewer tool, and also in the summary screen. Set
options related to how the images are displayed in the viewer.

• Auto Dark: You can capture an image and auto dark subtract it by checking this option. Note
that this option is only applicable when using Preview, you cannot use it in batch mode se-
quence queue.

• Effects: Image enhancement filter to be applied to the image after capture.

5.8.6.8 Rotator Settings

Field Rotators are supported in INDI & Ekos. The rotator angle is the raw angle reported by the
rotator and is not necessary the Position Angle. A Position Angle of zero indicates that the frame
top (indicated by small arrow) is pointing directly at the pole. The position angle is expressed as
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E of N (East of North), so 90 degrees PA indicates the frame top points 90 degrees away (counter-
clockwise) from the pole. Check examples for various PAs.

To calibrate the Position Angle (PA), capture and solve an image in the Ekos Align module. An
offset and a multiplier are applied to the raw angle to produce the position angle. The Ekos Rotator
dialog permits direct control of the raw angle and also the PA. The offset and multiplier can be
changed manually to synchronize the rotator’s raw angle with the actual PA. Check Sync FOV
to PA to rotate the current Field of View (FOV) indicator on the Sky Map with the PA value as
you change it in the dialog.

Rotator settings

Each capture job may be assigned different rotator angles, but be aware that this would cause
guiding to abort as it would lose track of the guide star when rotating. Therefore, for most
sequences, the rotator angle is kept the same for all capture jobs.

5.8.6.9 Calibration Frames

For Flat Field frames, you can set calibration options in order to automate the process. The
calibration options are designed to facilitate automatic unattended flat field frame capture. It can
also be used for dark and bias frames if desired. If your camera is equipped with a mechanical
shutter, then it is not necessary to set calibration settings unless you want to close the dust cover
to ensure no light at all passes through the optical tube. For flat fields, you must specify the flat
field light source, and then specify the duration of the flat field frame. The duration can be either
manual or based on ADU calculations.

1. Flat Field Source
• Manual: The flat light source is manual.
• Dust Cover with Built-In Flat Light: If using a dust cover with builtin light source (e.g.

FlipFlat). For dark and bias frames, close the dust cap before proceeding. For flat frames,
close the dust cap and turn on the light source.

• Dust Cover with External Flat Light: If using a dust cover with an external flat light
source. For dark and bias frames, close the dust cap before proceeding. For flat frames,
open the dust cap and turn on the light source. The external flat light source location is
presumed to be the parking location.
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• Wall: Light source is a panel on the observatory wall. Specify the Azimuth and Altitude
coordinates of the panel and the mount shall slew there before capturing the flat field
frames. If the light panel is controllable from INDI, Ekos shall turn it on/off as required.

• Dawn/Dusk: Currently unsupported.

2. Flat Field Duration

• Manual: Duration is as specified in the Sequence Queue.
• ADU: Duration is variable until specified ADU is met.

Before the calibration capture process is started, you can request Ekos to park the mount and/or
dome. Depending on your flat source selection above, Ekos will use the appropriate flat light
source before starting flat frames capture. If ADU is specified, Ekos begins by capturing a couple
of preview images to establish the curve required to achieve the desired ADU count. Once an ap-
propriate value is calculated, another capture is taken and ADU is recounted until a satisfactory
value is achieved.

5.8.6.10 Video Tutorials

Capture

Filter Wheels

5.8.7 Focus

5.8.7.1 Theory Of Operation

In order to focus an image, Ekos needs to establish a numerical method for gauging how good
your focus is. It’s easy when you look at an image and can see it as unfocused, as the human is
very good at detecting that, but how can Ekos possibly know that?

There are multiple methods. One is to calculate the Full Width at Half Maximum (FHWM) of
a star profile within an image, and then adjust the focus until an optimal (narrower) FWHM is
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reached. The problem with FWHM is that it assumes the initial focus position to be close to
the critical focus. Additionally, FWHM does not perform very well under low-intensity fluxes.
An Alternative method is Half-Flux-Radius (HFR), which is a measure of the width in pixels
counting from the center of the stars until the accumulated intensity is half of the total flux of the
star. HFR proved to be much more stable in conditions where you might have unfavorable sky
conditions, when the brightness profile of the stars is low, and when the starting position of the
focus is far from the optimal focus.

After Ekos processes an image, it selects the brightest star and starts measuring its HFR. It can
automatically select the star, or you can select the star manually. It is usually recommended to
select stars that are not too bright as they might get saturated during the focusing process. A
magnitude 3 or 4 star is often sufficient.

Ekos then begins the focusing process by commanding the focuser to focus inwards or outwards,
and re-measures the HFR. This establishes a V-shaped curve in which the sweet spot of optimal
focus is at the center of the V-curve, and the slope of which depends on the properties of the
telescope and camera in use. In Ekos, a full V-curve is never constructed as the focusing process
works iteratively, so under most circumstances, a half V-curve shape as illustrated in the Focus
Module image is measured.

Because the HFR varies linearly with focus distance, it is possible to calculate the optimal focus
point. In practice, Ekos operates iteratively by moving in discrete steps, decided initially by the
user-configurable step size and later by the slope of the V-curve, to get closer to the optimal focus
position where it then changes gears and performs smaller, finer moves to reach the optimal
focus. In the default Iterative algorithm, the focus process stops when the measured HFR is
within the configurable tolerance of the minimum recorded HFR in the process. In other words,
whenever the process starts searching for a solution within a narrowly limited range, it checks
if the current HFR is within % difference compared to the minimum HFR recorded, and if this
condition is met then the autofocus process is considered successful. The default value is set to
1% and is sufficient for most situations. The Step options specify the number of initial ticks the
focuser has to move. If the image is severely out of focus, we set the step size high (i.e. > 250).
On the other hand, if the focus is close to optimal focus, we set the step size to a more reasonable
range (< 50). It takes trial and error to find the best starting tick, but Ekos only uses that for the
first focus motion, as all subsequent motions depend on the V-Curve slope calculations.

When using the Polynomial algorithm, the process starts in the Iterative mode, but once we
cross to the other side of the V-curve (i.e. once HFR values start increasing again after decreasing
for a while), the Ekos performs polynomial fitting to find a solution that predicts the minimum
possible HFR position. If a valid solution is found, the autofocus process is considered successful.

While Ekos Focus Module supports relative focusers, it is highly recommended to use absolute
focusers.
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5.8.7.2 Focuser Group

Any INDI-compatible focuser is supported. It is recommended to use absolute focusers since
their absolute position is known on power up. In INDI, the focuser zero position is when the
drawtube is fully retracted. When focusing outwards, the focuser position increases, while it
decreases when focusing inwards. The following focuser types are supported:

• Absolute: Absolute Position Focusers such as RoboFocus, MoonLite, etc.

• Relative: Relative Position Focusers.

• Simple Focusers: DC/PWM focusers with no position feedback.

For absolute focusers, you can set the ticks count. To view a continuous feed of the camera, click
the Framing button. An image shall be captured repeatedly according to the CCD settings in
the CCD and Filter Wheel group. You can focus in and out by pressing the respective buttons,
and each shall move by the step size indicated in the focus settings. For absolute and relative
focusers, the step size is in units of ticks and for simple DC focusers, the step size is in milliseconds

To begin the autofocus process, simply click the Auto Focus button.
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5.8.7.3 CCD & Filter Wheel Group

You must specify the CCD and Filter Wheel (if any) to be used during the focusing process. You
can lock a specific filter within the filter wheel to be utilized whenever the autofocus process is
invoked. Usually, the user should select the Clear/Luminescence filter for this purpose so that
Ekos always uses the same filter to perform the autofocus process. This locked filter is also used
in the Alignment Module whenever it performs any astrometry capture.

You may also select an Effect filter to enhance the image for preview purposes. It is highly advis-
able to turn off any effects during the focusing process as it may interfere with HFR calculations.
For DSLRs cameras, you can change the ISO settings. You may reset the focusing subframe to
full frame capture if you click the Reset button.

5.8.7.4 Settings

You may need to adjust focus settings in order to achieve a successful and reliable autofocus
process. The settings are retained between sessions.

• Auto Star Select: Automatically select the best focus star from the image.
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• Subframe: Subframe around the focus star during the autofocus procedure. Enabling sub-
framing can significantly speed up the focus process.

• Dark Frame: Check this option to capture a dark frame if necessary and perform dark-frame
subtraction. This option can be useful in noisy images.

• Suspend Guiding: Suspend Guiding while autofocus in progress. If the focus process can
disrupt the guide star (e.g. when using Integrated Guide Port IGP whereas the guider is phys-
ically attached to the primary CCD), then it is recommended to enable this option. When using
Off-Axis guider, then this option is not necessary.

• Box size: Sets the box size used to enclose the focus star. Increase if you have very large stars.

• Max Travel: Maximum travel in ticks before the autofocus process aborts.

• Step: Initial step size in ticks to cause a noticeable change in HFR value. For timer-based
focuser, it is the initial time in milliseconds to move the focuser inward or outward.

• Tolerance: The tolerance percentage values decides when the autofocus process stops in the
Iterative algorithm. During the autofocus process, HFR values are recorded, and once the
focuser is close to an optimal position, it starts measuring HFRs against the minimum recorded
HFR in the sessions and stops whenever a measured HFR value is within % difference of
the minimum recorded HFR. Decrease value to narrow optimal focus point solution radius.
Increase to expand solution radius.

WARNING
Setting the value too low might result in a repetitive loop and would most likely result in a failed
autofocus process.

• Threshold: Threshold percentage value is used for star detection using the Threshold detection
algorithm. Increase to restrict the centroid to bright cores. Decrease to enclose fuzzy stars.

• Algorithm: Select the autofocus process algorithm:

– Iterative: Moves focuser by discreet steps initially decided by the step size. Once a curve
slope is calculated, further step sizes are calculated to reach an optimal solution. The algo-
rithm stops when the measured HFR is within percentage tolerance of the minimum HFR
recorded in the procedure.

– Polynomial: Starts with the iterative method. Upon crossing to the other side of the V-
Curve, polynomial fitting coefficients along with possible minimum solution are calculated.
This algorithm can be faster than a purely iterative approach given a good data set.

• Frames: Number of average frames to capture. During each capture, an HFR is recorded. If
the instantaneous HFR value is unreliable, you can average a number of frames to increase the
signal to noise ratio.

• Detection: Select star detection algorithm. Each algorithm has its strengths and weaknesses.
It is recommended to keep the default value unless it fails to properly detect stars.
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5.8.7.5 V-Curve

The V-shaped curve displays absolute position versus Half-Flux-Radius (HFR) values. The center
of the V-curve is the optimal focus position. Once Ekos crosses from one side of the V-curve to
the other, it backtracks and tries to find the optimal focus position. The final focus position is
decided by which algorithm is selected.

When framing, the horizontal axis denotes the frame number. This is to aid you in the framing
process as you can see how HFR changes between frames.

5.8.7.6 Relative Profile
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The relative profile is a graph that displays the relative HFR values plotted against each other.
Lower HFR values correspond to narrower shapes and vice-versa. The solid red curve is the pro-
file of the current HFR value, while the dotted green curve is for the previous HFR value. Finally,
the magenta curve denotes the first measured HFR and is displayed when the autofocus process
concludes. This enables you to judge how well the autofocus process improved the relative focus
quality.

5.8.8 Guide

5.8.8.1 Introduction

Ekos Guide Module enables autoguiding capability using either the powerful built-in guider, or
at your option, external guiding via PHD2 or lin_guider. Using the internal guiding, guider CCD
frames are captured and sent to Ekos for analysis. Depending on the deviations of the guide star
from its lock position, guiding pulses corrections are sent to your mount Via any device that sup-
ports ST4 ports. Alternatively, you may send the corrections to your mount directly, if supported
by the mount driver. Most of the GUI options in the Guide Module are well documented so just
hover your mouse over an item and a tooltip will popup with helpful information.

To perform guiding, you need to select a Guider CCD in Ekos Profile Setup. The telescope aper-
ture and focal length must be set in the telescope driver. If the Guider CCD is attached to a
separate Guide Scope, you must also set the Guide Scope’s Focal Length and Aperture. You
can set these values under the Options tab of the telescope driver or from the Mount module.
Autoguiding is a two-step process: Calibration & Guiding.

Guiding introduction

During the two processes, you must set the following:

• Guider: Select the Guider CCD.

• Via: Selects which device receives the autoguiding correction pulses from Ekos. Usually,
guider CCDs have an ST4 port. If you are using the guider’s ST4 to autoguide your tele-
scope, set the guider driver in the Via combo box. The guider CCD will receive the correction
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pulses from Ekos and will relay them to the mount via the ST4 port. Alternatively, some tele-
scopes support pulse commands and you can select the telescope to be a receiver of the Ekos
correction pulses.

• Exposure: CCD Exposure in seconds.

• Binning: CCD Binning.

• Box: Size of the box enclosing the guide star. Select a suitable size that is neither too large or
too small for the selected star.

• Effects: Specify filter to be applied to the image to enhance it.

5.8.8.2 Dark Frames

Dark frames are immensely helpful in reducing noises in your guide frames. It is highly recom-
mended to take dark frames before you begin and calibration or guiding procedure. To take a
dark frame, check the Dark checkbox and then click Capture. For the first time this is performed,
Ekos will ask you about your camera shutter. If your camera does not have a shutter, then Ekos
will warn you anytime you take a dark frame to cover your camera/telescope before proceeding
with the capture. On the other hand, if the camera already includes a shutter, then Ekos will di-
rectly proceed with taking the dark frame. All dark frames are automatically saved to Ekos Dark
Frame Library. By default, the Dark Library keeps reusing dark frames for 30 days after which it
will capture new dark frames. This value is configurable and can be adjusted in Ekos settings in
the KStars settings dialog.

It is recommended to take dark frames covering several binning and exposure values so that they
may be reused transparently by Ekos whenever needed.
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5.8.8.3 Calibration

In the calibration phase, you need to capture an image, select a guide star, and click Guide to
begin the calibration process. If calibration was already completed successfully before, then the
autoguiding process shall begin immediately, otherwise, it would start the calibration process.
If Auto Star is checked, then you are only required to click capture and Ekos will automatically
select the best-fit guide star in the image and continues the calibration process automatically. If
Auto Calibration is disabled, Ekos will try to automatically highlight the best guide star in the
field. You need to confirm or change the selection before you can start the calibration process.
The calibration options are:

• Pulse: The duration of pulses in milliseconds to be sent to the mount. This value should be
large enough to cause a noticeable movement in the guide star. If you increase the value and
you do not notice any movement of the guide star, then this suggests possible mount issues
such as jamming or connection issues via the ST4 cable.

• Two axis: Check if you want the calibration process calibration in both RA & DEC. If
unchecked, the calibration is only performed in RA.

• Auto Star: If checked, Ekos will attempt to select the best guide star in the frame and begins
the calibration process automatically.

The reticle position is the guide star position selected by you (or by the auto selection) in the
captured guider image. You should select a star that is not close to the edge. If the image is not
clear, you may select different Effects to enhance it.

Ekos begins the calibration process by sending pulses to move the mount in RA and DEC. If the
calibration process fails due to short drift, try increasing the pulse duration. To clear calibration,
click the trash bin icon next to Guide button.

WARNING
Calibration can fail for a variety of reasons. To improve the chances of success, try the tips below.
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• Better Polar Alignment: This is critical to the success of any astrophotography session. Per-
form a quick polar alignment with a polar scope (if available) or by using Ekos Polar Alignment
procedure in the Align module.

• Set binning to 2x2: Binning improves SNR and is often very important to the success of the
calibration and guiding procedures.

• Prefer to use ST4 cable between guide-camera and mount over using mount pulse commands.

• Select different filter (e.g. High contrast) and see if that makes a difference to bring down the
noise.

• Smaller Square Size.

• Take dark frames to reduce noise.

• Play with DEC Proportional Gain or disable DEC control completely and see the difference.

• Leave algorithm to the default value (Smart)

5.8.8.4 Guiding

Once the calibration process is completed successfully, the guiding shall begin automatically
hereafter. The guiding performance is displayed in the Drift Graphics region where Green re-
flects deviations in RA and Blue deviations in DEC. The colors of the RA/DE lines can be
changed in KStars color scheme in KStars settings dialog. The vertical axis denotes the devia-
tion in arcsecs from the guide star central position and the horizontal axis denotes time. You can
hover over the line to get the exact deviation at this particular point in time. Furthermore, you
can also zoom and drag/pan the graph to inspect a specific region of the graph.

Ekos can utilize multiple algorithms to determine the center of mass of the guide star. By default,
the smart algorithm is suited best for most situation. The fast algorithm is based on HFR calcula-
tions. You can try switching guiding algorithms if Ekos cannot keep of the guide star within the
guiding square properly.

The info region displays information on the telescope & FOV, in addition to the deviations from
the guide star along with the correction pulses sent to the mount. The RMS value for each axis is
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displayed along with the total RMS value in arcsecs. The internal guider employs PID controller
to correct the mount tracking. Currently, the only the proportional and integral gains are utilized
within the algorithm, so adjusting it should affect the length of the generated pulses sent to the
mount in milliseconds.
To enable automatic dithering between frames, make sure to check the Dither checkbox. By de-
fault, Ekos should dither (i.e. move) the guiding box by up to 3 pixels after each frame captured
in Ekos Capture Module. The motion duration and direction are randomized. Since the guiding
performance can oscillate immediately after dithering, you can set the appropriate Settle dura-
tion to wait after dither is complete before resuming the capture process. In rare cases where
the dithering process can get stuck in an endless loop, set the appropriate Timeout to abort the
process. But even if dithering fails, you can select whether this failure should terminate the auto-
guiding process or not. Toggle Dither Failure Aborts Autoguide to select the desired behavior.

Non-guide dithering is also supported. This is useful when no guide camera is available or when
performing short exposures. In this case, the mount can be commanded to dither in a random
direction for up to the pulse specified in the Non-Guide Dither Pulse option.

Ekos supports multiple guiding methods: Internal, PHD2, and LinGuider. You need to select the
desired guider in your Ekos equipment profile:

• Internal Guider: Use Ekos internal guider. This is the default and recommended option.

• PHD2: Use PHD2 as the external guider. If selected, specify the host and port of the PHD2.
Leave to default values if Ekos and PHD2 are running on the same machine.

• LinGuider: Use LinGuider as the external guider. If selected, specify the host and port of the
LinGuider. Leave to default values if Ekos and LinGuider are running on the same machine.

5.8.8.5 Guiding Direction Control

You can fine-tune the guiding performance in the Control Section. The autoguide process works
like a PID controller when sending correction commands to the mount. You can alter the Propor-
tional and Integral gains to improve the guiding performance if necessary. By default, guiding
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corrective pulses are sent to both mount axis in all directions: positive and negative. You can
fine-tune control by selecting which axis shall receive corrective guiding pulses and within each
axis, you can indicate which direction (Positive) + or Negative (-) receives the guiding pulses.
For example, for the Declination axis, the + direction is North and - is South.

5.8.8.6 Guiding Rate

Each mount has a particular guiding rate in (x15´́ /sec) and usually ranges from 0.1x, to 1.0x
with 0.5x being a common value used by many mounts. The default guiding rate is 0.5x sidereal,
which is equivalent to a proportional gain of 133.33. Therefore, set the guiding rate value to
whatever value used by your mount, and Ekos shall display the recommended proportional gain
value that you may set in the proportional gain field under the Control Parameters. Setting this
value does not change your mount guiding rate! You must change your mount guiding rate either
via the INDI driver, if supported, or via the hand controller.

5.8.8.7 Drift Graphics

The drift graphics is a very useful tool to monitor the guiding performance. It is a 2D plot of
guiding deviations and corrections. By default, only the guiding deviations in RA and DE are
displayed. The horizontal axis is the time in seconds since the autoguiding process was started
while the vertical axis plots the guiding drift/deviation in arcsecs for each axis. Guiding correc-
tions (pulses) can also be plotted in the same graph and you can enable them by checking the
Corr checkbox below each Axis. The corrections are plotted as shaded areas in the background
with the same color as that of the axis.
You can pan and zoom the plot, and when hovering the mouse over the graph, a tooltip is dis-
played containing information about this specific point in time. It contains the guiding drift and
any corrections made, in addition to the local time, this event was recorded. A vertical slider to
the right of the image can be used to adjust the height of the secondary Y-axis for pulses correc-
tions.
The Trace horizontal slider at the bottom can be used to scroll through the guide history. Alter-
natively, you can click the Max checkbox to lock the graph onto the latest point so that the drift
graphics autoscrolls. The buttons to the right of the slider are used for autoscaling the graphs,
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exporting the guide data to a CSV file, clearing all the guide data, and for scaling the target in the
Drift Plot. Furthermore, the guide graph includes a label to indicate when a dither occurred so
the user knows guiding was not bad at those points.
The colors of each axis can be customized in KStars Settings color scheme.

5.8.8.8 Drift Plot

A bulls-eye scatter plot can be used to gauge the accuracy of the overall guiding performance.
It is composed of three concentric rings of varying radii with the central green ring having a

default radius of 2 arcsecs. The last RMS value is plotted as with its color reflecting
which concentric ring it falls within. You can change the radius of the innermost green circle by
adjusting the drift plot accuracy.

5.8.8.9 PHD2 Support

You can opt to select external PHD2 application to perform guiding instead of the built-in guider.

If PHD2 is selected, the Connect and Disconnect buttons are enabled to allow you to establish
a connection with the PHD2 server. You can control PHD2 exposure and DEC guide settings.
When clicking Guide, PHD2 should perform all the required actions to start the guiding process.
PHD2 must be started and configured before Ekos.
After launching PHD2, select your INDI equipment and set their options. From Ekos, connect
to PHD2 by clicking Connect button. On startup, Ekos will attempt to automatically connect to
PHD2. Once the connection is established, you may begin the guiding immediately by click on
the Guide button. PHD2 shall perform calibration if necessary. If dithering is selected, PHD2
shall be commanded to dither given the offset pixels indicated and once guiding is settled and
stable, the capture process in Ekos shall resume.

NOTE
Ekos saves a CSV guide log data that can be useful for analysis of the mount’s performance under
~/.local/share/kstars/guide_log.txt. This log is only available when using the built-in guider.
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5.8.9 Align

5.8.9.1 Introduction

Ekos Alignment Module enables highly accurate GOTOs to within sub-arcseconds accuracy and
can measure and correct polar alignment errors. This is possible thanks to the astrometry.net
solver. Ekos begins by capturing an image of a star field, feeding that image to astrometry.net
solver, and getting the central coordinates (RA, DEC) of the image. The solver essentially per-
forms a pattern recognition against a catalog of millions of stars. Once the coordinates are deter-
mined, the true pointing of the telescope is known.

Often, there is a discrepancy between where the telescope thinks it is looking at and where it is
truly pointing. The magnitude of this discrepancy can range from a few arcminutes to a couple
of degrees. Ekos can then correct the discrepancy by either syncing to the new coordinates, or by
slewing the mount to the desired target originally requested.

Furthermore, Ekos provides two tools to measure and correct polar alignment errors:

• Polar Alignment Assistant Tool: A very easy tool to measure and correct polar errors. It
takes three images near the celestial pole (Close to Polaris for Northern Hemisphere) and then
calculates the offset between the mount axis and polar axis.

• Legacy Polar Alignment Tool: If Polaris is not visible, this tool can be used to measure and
correct polar alignment errors. It captures a couple of images near the meridian and east/west
of the meridian. This will enable the user to adjust the mount until the misalignment is mini-
mized.

At a minimum, you need a CCD/Webcam and a telescope that supports Slew & Sync commands.
Most popular commercial telescope nowadays support such commands.

For the Ekos Alignment Module to work, you have an option of either utilizing the online astrom-
etry.net solver, offline, or remote solver

• Online Solver: The online solver requires no configuration, and depending on your Internet
bandwidth, it might take a while to upload and solve the image.
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• Offline Solver: The offline solver can be faster and requires no Internet connection. In order to
use the offline solver, you must install astrometry.net in addition to the necessary index files.

• Remote Solver: The remote solver is an offline solver the resides on a different machine (for
example, you can use Astrometry solver on StellarMate). Captured images are solved on the
remote machine.

5.8.9.2 Get astrometry.net

If you are planning to use Offline astrometry then you need to download astrometry.net applica-
tion.

NOTE
Astrometry.net is already shipped with StellarMate so there is no need to install it. Index files from
16 arcminutes and above (4206 to 4019) are included with StellarMate. For any additional index files,
you need to install them as necessary. To use Astrometry in StellarMate from a remote Ekos on
Linux®/Windows®/Mac® OS, make sure to select Remote option in Ekos Alignment Module. Further-
more, make sure that the Astrometry driver is selected in your equipment profile.

Windows®

To use astrometry.net under Windows, you need to download and install the ANSVR Local
Astrometry.net solver. The ANSVR mimics the astrometry.net online server on your local
computer; thus the internet not required for any astrometry queries.
After installing the ANSVR server and downloading the appropriate index files for your
setup, make sure ANSVR server is up and running and then go to Ekos Alignment options
where you can simply change the API URL to use the ANSVR server as illustrated below:
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In Ekos Align module, you must set the solver type to Online so that it uses the local
ANSVR server for all astrometry queries. Then you can use the align module as you would
normally do.
Remember as indicated above that StellarMate already includes astrometry.net. Therefore,
if you would like to use StellarMate remotely to solve your images, simply change solver
type to Remote and ensure that your equipment profile includes Astrometry driver which
can be selected under the Auxiliary dropdown. This is applicable to all operating systems
and not just Windows.

Mac® OS
Astrometry.net is already included with KStars for MacOS, so no need to install it.

Linux®

Astrometry.net is already included with KStars bleeding version. But if astrometry is not
installed, then you can install it by running the following command under Ubuntu:
sudo apt-get install astrometry.net

5.8.9.3 Download Index Files

For offline (and remote) solvers, index files are necessary for the solver to work. The complete
collection of index files is huge (over 30 GB), but you only need to download what is necessary
for your equipment setup. Index files are sorted by the Field-Of-View (FOV) range they cover.
There are two methods to fetch the necessary index files: The new download support in Align
module, and the old manual way.
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5.8.9.3.1 Automatic Download

Automatic download is only available for Ekos users on Linux® & Mac® OS. For Windows®;
users, please download ANSVR solver.

To access the download page, click the Options button in the Align module and then select
Astrometry Index Files tab. The page displays the current FOV of your current setup and below
it a list of available and installed index files. Three icons are used to designate the importance of
index files given your current setup as follows:

• Required

• Recommended

• Optional

You must download all the required files, and if you have plenty of hard drive space left, you
can also download the recommended indexes. If an index file is installed, the checkmark shall be
checked, otherwise check it to download the relevant index file. Please only download one file
at a time, especially for larger files. You might be prompted to enter the administrator password
(default in StellarMate is smate) to install the files. Once you installed all the required files, you
can begin using the offline astrometry.net solver immediately.

5.8.9.3.2 Manual Download

You need to download and install the necessary index files suitable for your telescope+CCD field
of view (FOV). You need to install index files covering 100% to 10% of your FOV. For example, if
your FOV is 60 arcminutes, you need to install index files covering skymarks from 6 arcminutes
(10%) to 60 arcminutes (100%). There are many online tools to calculate FOVs, such as Starizona
Field of View Calculator.
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Index Filename FOV (arcminutes) Debian Package
index-4219.fits 1400 - 2000

astrometry-data-4208-4219

index-4218.fits 1000 - 1400
index-4217.fits 680 - 1000
index-4216.fits 480 - 680
index-4215.fits 340 - 480
index-4214.fits 240 - 340
index-4213.fits 170 - 240
index-4212.fits 120 - 170
index-4211.fits 85 - 120
index-4210.fits 60 - 85
index-4209.fits 42 - 60
index-4208.fits 30 - 42
index-4207-*.fits 22 - 30 astrometry-data-4207
index-4206-*.fits 16 - 22 astrometry-data-4206
index-4205-*.fits 11 - 16 astrometry-data-4205
index-4204-*.fits 8 - 11 astrometry-data-4204
index-4203-*.fits 5.6 - 8.0 astrometry-data-4203
index-4202-*.fits 4.0 - 5.6 astrometry-data-4202

index-4201-*.fits 2.8 - 4.0

astrometry-data-4201-1astr-
ometry-data-4201-2astrome-
try-data-4201-3astrometry--
data-4201-4

index-4200-*.fits 2.0 - 2.8

astrometry-data-4200-1astr-
ometry-data-4200-2astrome-
try-data-4200-3astrometry--
data-4200-4

Table 5.1: Index Files

The Debian packages are suitable for any Debian-based distribution (Ubuntu, Mint...etc). If you
downloaded the Debian Packages above for your FOV range, you can install them from your
favorite package manager, or via the following command:

sudo dpkg -i astrometry-data-*.deb

On the other hand, if you downloaded the FITS index files directly, copy them to /usr/share/as
trometry directory.

NOTE
It is recommended to use a download manager as such DownThemAll! for Firefox to download the
Debian packages as browsers’ built-in download manager may have problems with download large
packages.

5.8.9.4 How to Use?

Ekos Align Module offers multiple functions to aid you in achieving accurate GOTOs. Start
with your mount in home position with the telescope tube looking directly at the celestial pole.
For users in Northern Hemisphere, point the telescope as close as possible to Polaris. It is not
necessary to perform 2 or 3 star alignments, but it can be useful for some mount types. Make
sure your camera is focused and stars are resolved.
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• Capture & Solve: Capture an image and determine what region in the sky the telescope is
exactly looking at. The astrometry results include the equatorial coordinates (RA & DEC) of
the center of the captured image in addition to pixel scale and field rotation. Depending on
the Solver Action settings, the results can be used to Sync the mount or Sync and then Slew
to the target location. For example, suppose you slewed the mount to Vega then used Capture
& Solve. If the actual telescope location is different from Vega, it will be first synced to the
solved coordinate and then Ekos shall command the mount to slew to Vega. After slew is
complete, the Alignment module will repeat Capture & Solve process again until the error
between reported and actual position falls below the accuracy thresholds (30 arcseconds by
default).

• Load & Slew: Load a FITS or JPEG file, solve it, and then slew to it.

• Polar Alignment Assistant: A simple tool to aid in polar alignment of German Equatorial
Mounts.

• Legacy Polar Alignment Tool: Measure polar alignment error when a view of the celestial
pole (e.g. Polaris for Northern Hemisphere) is not available.

WARNING
Never solve an image at or near the celestial pole (unless Ekos Polar Alignment Assistant Tool is
used). Slew at least 20 degrees away from the celestial pole before solving the first image. Solving
very close to the poles will make your mount pointing worse so avoid it.

5.8.9.5 Alignment Settings

Before you begin the alignment process, select the desired CCD & Telescope. You can explore
astrometry.net options that are passed to the astrometry.net solver each time an image is captured:

• CCD: Select CCD to capture from

• Exposure: Exposure duration in seconds

• Accuracy: Acceptable difference between reported telescope coordinate and actually solved
coordinate.

• Bin X: Set horizontal binning of the CCD

• Bin Y: Set vertical binning of the CCD

• Scope: Set the active telescope in case you have different Primary and Guide scopes. FOV is
re-calculated when selecting a different telescope.

• Options: Options that are passed to the astrometry.net solver. Click the edit button to
explore the options in detail.
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• Solver: Select solver type (Online, Offline, Remote). The remote solver is only available when
connecting to a remote device.

By default, the solver will search all over the sky to determine the coordinates of the captured
image. This can take a lot of time; therefore, in order to speed up the solver, you can restrict it to
only search within a specified area in the sky designated by the RA, DEC, and Radius options
above.

5.8.9.6 Astrometry.net Options

Options for offline and online solvers.

Most of the options are sufficient by default. If you have astrometry.net installed in a non-
standard location, you can change the paths as necessary.

• WCS: World-Coordinate-System is a system for embedding equatorial coordinate information
within the image. Therefore, when you view the image, you can hover it and view the coordi-
nate for each pixel. You can also click anywhere in the image and command to the telescope to
slew there. It is highly recommended to keep this option on.

• Verbose: If the solver repeatedly fails to solve, check this option to enable verbose output of the
solver to help you identify any problems.

• Overlay: Overlay captured images unto the sky map of KStars.

• Upload JPG: When using online astrometry.net, upload all images are JPEGs to save band-
width as FITS images can be large.

5.8.9.7 Solver Options

Ekos selects and updates the optimal options by default to accelerate the performance of the
solver. You may opt to change the options that are passed to the solver in case the default options
are not sufficient.
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5.8.9.8 Capture & Solve

Using Ekos Alignment Module, aligning your mount using the controller’s 1, 2, or 3 star align-
ment is not strictly necessary, though for some mounts it is recommended to perform a rough 1
or 2 star alignment before using Ekos alignment module. If you are using EQMod, you can start
using Ekos alignment module right away. A typical workflow for GOTO alignment involves the
following steps:

1. Set your mount to its home position (usually the NCP for equatorial mounts)

2. Select Slew to Target in the Solver Action.

3. Slew to a nearby bright star.

4. After slew is complete, click Capture & Solve.

If the solver is successful, Ekos will sync and then slew to the star. The results are displayed in the
Solution Results tab along with a bullseye diagram that shows the offset the reported telescope
coordinates (i.e. where the telescope thinks it is looking at) vs. its actual position in the sky as
determined by the solver.

Each time the solver is executed and returns successful results, Ekos can run on the following
actions:

• Sync: Syncs the telescope coordinates to the solution coordinates.

• Slew to Target: Syncs the telescope coordinates to the solution coordinates and then slew to
the target.

• Nothing: Just solve the image and display the solution coordinates.
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5.8.9.9 Polar Alignment

5.8.9.9.1 Polar Alignment Assistant

When setting up a German Equatorial Mount (GEM) for imaging, a critical aspect of capturing
long-exposure images is to ensure proper polar alignment. A GEM mount has two axis: Right
Ascension (RA) axis and Declination (DE) axis. Ideally, the RA axis should be aligned with the
celestial sphere polar axis. A mount’s job is to track the star’s motion around the sky, from the
moment they rise at the eastern horizon, all the way up across the median, and westward until
they set.

Polar Alignment Assistant

In long exposure imaging, a camera is attached to the telescope where the image sensor captures
incoming photons from a particular area in the sky. The incident photons have to strike the same
photo-site over and over again if we are to gather a clear and crisp image. Of course, actual
photons do not behave in this way: optics, atmosphere, seeing quality all scatter and refract
photons in one way or another. Furthermore, photons do not arrive uniformly but follow a
Poisson distribution. For point-like sources like stars, a point spread function describes how
photons are spatially distributed across the pixels. Nevertheless, the overall idea we want to keep
the source photons hitting the same pixels. Otherwise, we might end up with an image plagued
with various trail artifacts.

Since mounts are not perfect, they cannot perfectly keep track of object as it transits across the
sky. This can stem from many factors, one of which is the misalignment of the mount’s Right
Ascension axis with respect to the celestial pole axis. Polar alignment removes one of the biggest
sources of tracking errors in the mount, but other sources of error still play a factor. If properly
aligned, some mounts can track an object for a few minutes with the only deviation of 1-2 arcsec
RMS.
However, unless you have a top of the line mount, then you’d probably want to use an autogu-
ider to keep the same star locked in the same position over time. Despite all of this, if the axis
of the mount is not properly aligned with the celestial pole, then even a mechanically-perfect
mount would lose tracking with time. Tracking errors are proportional to the magnitude of the
misalignment. It is therefore very important for long exposure imaging to get the mount polar
aligned to reduce any residual errors as it spans across the sky.
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Before starting the process, point the mount as close as possible to the celestial pole. If you are
living in the Northern Hemisphere, point it as close as possible to Polaris.

The tool works by capturing and solving three images. After capturing each, the mount rotates
by a fixed amount and another image is captured and solved.

After the first capture, you can rotate the mount by a specific amount (default 30 degrees) either
West or East. After selecting the magnitude and direction, click Next to continue and the mount
will be rotated. Once the rotation is complete you shall be asked to take another capture, unless
you have checked Auto Mode. In Automated mode, the rest of the process will continue with
the same settings and direction until a total of three images are captured.

Since the mount’s true RA/DE are resolved by astrometry, we can construct a unique circle from
the three centers found in the astrometry solutions. The circle’s center is where the mount rotates
about (RA Axis) and ideally, this point should coincide with the celestial pole. However, if there
is a misalignment, then Ekos draws a correction vector. This correction vector can be placed any-
where in the image. Next, refresh the camera feed and make corrections to the mount’s Altitude
and Azimuth knobs until the star is located in the designated cross-hair. To make it easy to make

corrections, expand the view by clicking on the Fullscreen button
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If you are away from StellarMate or PC, you can use your Tablet to monitor the camera feed
while making corrections. Use the StellarMate’s web-based VNC viewer or use any VNC Client
on your tablet to access StellarMate. If Ekos is running on your PC, you can use applications like
TeamViewer to achieve the same results. The following is a video demonstrating how to utilize
the Polar Alignment Assistant tool.

Polar Alignment

5.8.9.9.2 Legacy Polar Alignment Workflow

Using the Polar Alignment mode, Ekos can measure and correct for polar alignment errors. To
measure Azimuth error, point your mount to a star close to the meridian. If you live in the north-
ern hemisphere, you will point the mount toward the southern meridian. Click on Measure Az
Error to begin the process. Ekos will try to measure the drift between two images and calculates
the error accordingly. You can ask Ekos to correct Azimuth error by clicking on the Correct Az
Error button. Ekos will slew to a new location and asks you to adjust the mount’s azimuth knobs
until the star is in the center of the Field of View. You can use the Focus Module’s Framing feature
to take a look at the image as you make your adjustments.

Similarly, to measure Altitude error, click on the Measure Alt Error button. You need to point
your mount either east or west and set the Altitude Direction combo box accordingly. Ekos will
take two images and calculates the error. You can ask Ekos to correct Altitude error by clicking
on the Correct Alt Error button. As with Azimuth correction, Ekos will slew to a new location
and asks you to adjust the mount’s altitude knobs until the star is in the center of the FOV.

After making a correction, it is recommended to measure the Azimuth and Altitude errors again
and gauge the difference. You may need to perform the correction more than once to obtain
optimal results.

Before starting the Polar Alignment tool, you must complete the GOTO Workflow above for at
least one point in the sky. Once your mount is aligned, proceed with the following (assuming
you live in the northern hemisphere):

1. Slew to a bright star (4th magnitude or below) near the southern meridian (Azimuth 180).
Make sure Slew to Target is selected. Capture and solve. The star should be exactly cen-
tered in your CCD field of view.
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2. Switch mode to Polar Alignment. Click Measure Az Error. It will ask you to slew to a star
at the southern meridian which we already done click Continue. Ekos will now perform
the error calculation.

3. If all goes well, the error is displayed in the output boxes. To correct for the error, click
Correct Az Error. Ekos will now slew to a different point in the sky, and you will be required
to ONLY adjust the mount’s azimuth knobs to center the star in the field of view. The most
convenient way of monitoring the star field is by going to the Focus module and clicking
Start Framing. If the azimuth error is great, the star might not be visible in the CCD field
of view, and therefore you have to make blind adjustments (or simply look through the
finderscope) until the star enters the CCD FOV.

4. Begin your azimuth adjustments until the bright star you slewed to initially is as close to
center as you can get it.

5. Stop Framing in the Focus module.

6. Repeat the Measure Az Error to ensure we indeed corrected the error. You might have to
run it more than once to ensure the results are valid.

7. Switch mode to GOTO.

8. Now slew to a bright star either on the eastern or western horizon, preferably above 20
degrees of altitude. It has to be as close as possible to the eastern (90 azimuth) or western
(270) cardinal points.

9. After slew is complete, capture and solve. The star should be dead center in the CCD FOV
now.

10. Switch mode to Polar Alignment.

11. Click Measure Alt Error. It will ask you to slew to a star at either the eastern (Azimuth 90)
or western (Azimuth 270) which we already done click Continue. Ekos will now perform
the error calculation.

12. To correct for the error, click Correct Alt Error. Ekos will now slew to a different point in
the sky, and you will be required to ONLY adjust the mount’s altitude knobs to center the
star in the field of view. Start framing as done before in the focus module to help you with
the centering.

13. After centering is complete, stop framing.

14. Repeat the Measure Alt Error to ensure we indeed corrected the error. You might have to
run it more than once to ensure the results are valid.

15. Polar alignment is now complete!

WARNING
The mount may slew to a dangerous position and you might risk hitting the tripod and/or other equip-
ment. Carefully monitor the mount’s motion. Use at your own risk.

116



The KStars Handbook

5.8.10 Scheduler

5.8.10.1 Introduction

Ekos Scheduler is an indispensable arsenal in building your robotic observatory. A Robotic ob-
servatory is an observatory composed of several subsystems that are orchestrated together to
achieve a set of scientific objectives without human intervention. It is the only Ekos module that
does not require Ekos to be started as it is utilized to start and stop Ekos. It is designed to be
straightforward and intuitive. However, the scheduler should only be used after you mastered
Ekos and knows all the quirks of your equipment. Since the complete process is automated, in-
cluding focus, guiding, and meridian flip. All equipment should be thoroughly used with Ekos
and all their parameters and settings adjusted to achieve the best result.

With Ekos, the user can utilize the powerful sequence queue to image batches of images for a
particular target. In simple setups, the user is expected to focus the CCD, align the mount, frame
the target, and start guiding before initiating the capture process. For more complex observatory
environments, there are usually predefined custom procedures to be executed to prepare the
observatory for imaging, and another set of procedures on shutdown. The user may plan to
image one or more targets during the night and expects data to be ready by morning. In KStars,
tools such as the Observation Planner and What’s up Tonight help the user in selecting candidates
for imaging. After selecting the desired candidates, the user can add them to the Ekos Scheduler
list for evaluation. The user may also add the targets directly in Ekos scheduler or select a FITS
file of a previous image.

5.8.10.2 Settings

Ekos Scheduler provides a simple interface to aid the user in setting the conditions and con-
straints required for an observation job. Each observation job is composed of the following:

• Target name and coordinates: Select target from the Find Dialog or Add it from Observation
Planner. You can also enter a custom name.
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• Optional FITS file: If a FITS file is specified, the astrometry solver shall solve the file and use
the central RA/DEC as the target coordinates.

• Sequence File: The sequence file is constructed in the Ekos Capture Module. It contains the
number of images to capture, filters, temperature settings, prefixes, download directory, etc.

• Priority: Set job priority in the range of 1 to 20 where 1 designates the highest priority and 20
the lowest priority. Priority is applied in calculating the weight used to select the next target
to image.

• Profile: Select which equipment profile to utilize when starting Ekos. If Ekos & INDI are
already started and online, this selection is ignored.

• Steps: The user selects which Ekos modules should be utilized in the observation job execution
workflow.

• Startup Conditions: Conditions that must be met before the observation job is started. Cur-
rently, the user may select to start as soon as possible Now, or when the target is near or past
culmination, or at a specific time.

• Constraints: Constraints are conditions that must be met at all times during the observation
job execution process. These include minimum target altitude, minimum moon separation,
twilight observation, and weather monitoring.

• Completion Conditions: Conditions that trigger completion of the observation job. The de-
fault selection is to simply mark the observation job as complete once the sequence process is
complete. Additional conditions enable the user to repeat the sequence process indefinitely or
up until a specific time.

You must select the Target and Sequence before you can add a job to the Scheduler. When the
scheduler starts, it evaluates all jobs in accord to the conditions and constraints specified and
attempts to select the best job to execute. Selection of the job depends on a simple heuristic
algorithm that scores each job given the conditions and constraints, each of which is weighted
accordingly. If two targets have identical conditions and constraints, usually the higher priority
target followed by higher altitude target is selected for execution. If no candidates are available
at the current time, the scheduler goes into sleep mode and wakes up when the next job is ready
for execution.

The description above only tackles the Data Acquisition stage of the observatory workflow. The
overall procedure typically utilized in an observatory can be summarized in three primary stages:

1. Startup
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2. Data Acquisition (including preprocessing and storage)

3. Shutdown

5.8.10.3 Startup Procedure

Startup procedure is unique to each observatory but may include:

• Turning on power to equipment

• Running safety/sanity checks

• Checking weather conditions

• Turning off light

• Fan/Light control

• Unparking dome

• Unparking mount

• etc.

Ekos Scheduler only initiates the startup procedure once the startup time for the first observation
job is close (default lead time is 5 minutes before startup time). Once the startup procedure is
completed successfully, the scheduler picks the observation job target and starts the sequence
process. If a startup script is specified, it shall be executed first.

5.8.10.4 Data Acquisition

Depending the on the user selection, the typical workflow proceeds as follows:

• Slew mount to target. If a FITS file was specified, it first solves the files and slew to the file
coordinates.

• Auto-focus target. The autofocus process automatically selects the best star in the frame and
runs the autofocus algorithm against it.

• Perform plate solving, sync mount, and slew to target coordinates.

• Perform post-alignment focusing since the frame might have moved during the plate solving
process.

• Perform calibration and start auto-guiding: The calibration process automatically selects the
best guide star, performs calibration, and starts the autoguide process.

• Load the sequence file in the Capture module and start the imaging process.

5.8.10.5 Shutdown

Once the observation job is completed successfully, the scheduler selects the next target. If the
next target scheduled time is not due yet, the mount is parked until the target is ready. Further-
more, if the next scheduled target is not due for a user-configurable time limit, the scheduler
performs a preemptive shutdown to preserve resources and performs the startup procedure again
when the target is due.

If an unrecoverable error occurs, the observatory initiates shutdown procedure. If there is a
shutdown script, it will be executed last.

The following video demonstrates an earlier version of the scheduler, but the basic principles still
apply today:

Ekos Scheduler

119



The KStars Handbook

5.8.10.6 Weather Monitoring

Another critical feature of any remotely operated robotic observatory is weather monitoring. For
weather updates, Ekos relies on the selected INDI weather driver to continuously monitor the
weather conditions. For simplicity sake, the weather conditions can be summed in three states:

1. Ok: Weather conditions are clear and optimal for imaging.

2. Warning: Weather conditions are not clear, seeing is subpar, or partially obstructed and
not suitable for imaging. Any further imaging process is suspended until the weather im-
proves. Warning weather status does not pose any danger to the observatory equipment so
the observatory is kept operational. The exact behavior to take under Warning status can
be configured.

3. Alert: Weather conditions are detrimental to the observatory safety and shutdown must be
initiated as soon as possible.

5.8.10.7 Startup & Shutdown Scripts

Due to the uniqueness of each observatory, Ekos enables the user to select startup and shutdown
scripts. The scripts take care of any necessary procedures that must take place on startup and
shutdown stages. On startup, Ekos executes the startup scripts and only proceeds to the remain-
der of the startup procedure (unpark dome/unpark mount) if the script completes successfully.
Conversely, the shutdown procedure begins with parking the mount & dome before executing
the shutdown script as the final procedure.

Startup and shutdown scripts can be written any language that can be executed on the local
machine. It must return 0 to report success, any other exist value is considered an error indicator.
The script’s standard output is also directed to Ekos logger window. The following is an sample
demo startup script in Python:

#!/usr/bin/env python
# -*- coding: utf -8 -*-

import os
import time
import sys

print "Turning on observatory equipment..."
sys.stdout.flush()

time.sleep(5)

print "Checking safety switches..."
sys.stdout.flush()

time.sleep(5)

print "All systems are GO"
sys.stdout.flush()

exit(0)

The startup and shutdown scripts must be executable in order for Ekos to invoke them (e.g. use c
hmod +x startup_script.py to mark the script as executable). Ekos Scheduler enables truly
simple robotic operation without the need of any human intervention in any step of the process.
Without human presence, it becomes increasingly critical to gracefully recover from failures in
any stage of the observation run. Using Plasma notifications, the user can configure audible
alarms and email notifications for the various events in the scheduler.
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5.8.10.8 Mosaic Wizard

Hubble-like super wide field images of galaxies and nebulae are truly awe-inspiring, and while
it takes great skills to obtain such images and process them; many notable names in the field of
astrophotography employ gear that is not vastly different from yours or mine. I emphasize vastly
because some do indeed have impressive equipment and dedicated observatories worth tens of
the thousands of dollars. Nevertheless, many amateurs can obtain stellar wide-field images by
combining smaller images into a single grand mosaic.

We are often limited by our camera+telescope Field of View (FOV). By increasing FOV by means
of a focal reducer or a shorter tube, we gain a larger sky coverage at the expense of spatial reso-
lution. At the same time, many attractive wide-field targets span multiple FOVs across the sky.
Without any changes to your astrophotography gear, it is possible to create a super mosaic image
stitched together from several smaller images. There are two major steps to accomplish a super
mosaic image:

1. Capture multiple images spanning the target with some overlap between images. The over-
lap is necessary to enable the processing software from aligning and joining the sub-images.

2. Process the images and stitch them into a super mosaic image.

The 2nd step is handled by image processing applications such as PixInsight, among others, and
will not be the topic of discussion here. The first step can be accomplished in Ekos Scheduler
where it creates a mosaic suitable for your equipment and in accordance with the desired field
of view. Not only Ekos creates the mosaic panels for your target, but it also constructs the corre-
sponding observatory jobs required to capture all the images. This greatly facilitates the logistics
of capturing many images with different filters and calibration frames across a wide area of the
sky.

Before starting the Mosaic Job Creator in Ekos Scheduler, you need to select a target and a se-
quence file. The Sequence File contains all the information necessary to capture an image includ-
ing exposure time, filters, temperature setting, etc. Start the Mosaic Job Creator by clicking on
the icon next to the Find button in Ekos Module.
On first use, you need to enter your equipment settings including your telescope focal length in
addition to camera’s width, height, and pixel dimensions. Finally, you need to enter the rotation
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of the camera with respect to north or the position angle. If you don’t know this value, start Ekos
and slew to your desired target then use the Align module to solve the image and obtain the
position angle.

Next, enter the desired number of horizontal and vertical panels (e.g. 2x2, 3x3, etc.) and then
click Update. The target FOV shall be calculated given the number of panels and your camera’s
FOV and the mosaic overlap shall be displayed. By default, the percentage of the overlap among
images is 5%, but you can change this value to your desired value. You can also move the com-
plete mosaic structure around to fine tune the position of the mosaic panels. When satisfied, click
Create Jobs and Ekos shall create an observation job and a corresponding customized sequence
file for each panel. All the jobs shall be saved to an Ekos Scheduler List (.esl) file that you
can load on any suitable observing night and it will pick off where you left. Before starting the
Mosaic Job Creator, check that all the observation job conditions, constraints, and startup/shut-
down procedures are as per your requirements since these settings shall be copied to all the jobs
generated by the Mosaic tool.

With Ekos Scheduler, multi-night imaging is greatly facilitated and creating super mosaics has
never been so easy.

5.8.11 FITS Viewer

The Flexible Image Transport System (FITS) is the standard format for representing images and
data in Astronomy.

The KStars FITS Viewer tool is integrated with Ekos for seamless display of captured FITS images.
It can be used as a standalone tool or embedded within Ekos modules. To open a FITS file, select
Open FITS... from the File menu, or press Ctrl-O.

In addition to image display, the viewer can process World-Coordinate-System (WCS) header if
present within the FITS file and provides useful information regarding the objects found within
the image, equatorial grid overlay, popup menu, and the ability to slew the mount (if connected)
to any point within the image.

Several filters can be applied to enhance the image include auto stretch and high contrast. De-
pending on the image size, these operations can take a few seconds to complete. The bottom
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status bar displays the current pixel value and current X & Y coordinates of the mouse pointer
within the image. Furthermore, it includes the current zoom level and the image resolution.

When loading a bayered image, the viewer can automatically debayer the image if Auto Debayer
is checked in the FITS Settings. The debayering operation fetches the bayer pattern (e.g. RGGB)
from the FITS header. If none exists, you can alter the debayering algorithm and pattern from the
File menu or by using the Ctrl-D shortcut.

Since operations such as auto debayering and auto WCS are computationally expensive and
stress the processor on low-powered embedded devices, you can toggle their behavior in KStars
Settings FITS page.

Hovering over any option shall display a detailed tooltip that explains its function.

5.8.11.1 Features

• Support for 8, 16, 32, IEEE-32, and IEEE-64 bits formats.

• Support Color FITS images (3D Cubes) and Bayered FITS images.

• Histogram with linear, logarithmic, and square-root scales.

• Brightness/Contrast controls.

• Pan and Zoom.

• Auto levels.

• Statistics.

• Rectangular and Equatorial Grids (if WCS info is present).

• Detection and highlight of stars.

• FITS header query.

• Undo/Redo.
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Histogram

Displays multi-channel FITS histogram. The user can rescale the image by optionally defin-
ing an upper and lower limit for the cutoff region. The rescaling operation (linear, logarith-
mic, or square-root) may then be applied to the region enclosed by the upper and lower
limits.

FITS Header
Displays a read-only table listing FITS header keywords and values.

Statistics
Provides simple statistics for minimum and maximum pixel values and their respective
locations. FITS depth, dimension, mean, and standard deviation.
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5.8.11.2 Embedded FITS Viewer

In Ekos Focus, Guide, and Align modules, captured images are displayed in the embedded FITS
Viewer. The embedded viewer includes a floating bar that can be used to perform several func-
tions:

• Zoom Out

• Zoom In

• Default Zoom

• Zoom To Fit

• Toggle Cross Hairs

• Toggle Pixel Gridlines

• Toggle Detected Stars: Highlight detected stars with red circles.

• Star Profile: View detailed 3D star profile.

The floating bar is automatically hidden once the mouse leaves the embedded viewer area. You
can use the mouse to pan and zoom just like the standalone FITS Viewer tool. The green tracking
box can be used to select a specific star or region within the image, for example, to select a guide
star.
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5.8.11.3 3D Star Profile & Data Visualization Tool

The 3D data visualization tool can plot 3D graphs of the selected region of the image. This is
particularly useful for astrophotographers who want to visualize the profile of a star they are
considering focusing or guiding on. For scientists, it enables them to examine a cross-section of
the data to understand the relative brightness of different objects in the image. Additionally, it
empowers imagers who want to visually see what is going on in their data collection in a new
way.

To use the new feature, the user needs to select the View Star Profile icon in one of the Ekos
Module Views, or in the FITS Viewer. Then, the region selected in the green tracking box will
show up in the 3D graph as shown above. The user will then have one of the following toolbars
at the bottom.

At the far left, the sample size combo box will let the user select the size of the image crop shown
in the graph. This option is only available in the Summary Screen, the Align Module, and the
FITS Viewer. The second combo box lets the user control whether they are selecting an individual
item, or a row, or a column of pixels. The slice button will be enabled if the user selects Row or
Column. It will put the graph in slice mode so that the user can see a cross-section view of the
image. Third, is a checkbox that will open up two sliders that will let the user drag the slider to
change the selection. This is extremely useful in the slide mode to change the selected point and
to move the cross section around the graph. It is also useful in the normal view when in Explore
Mode so that the user can zoom around the image examining the pixels.
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Then the user has the Zoom To combo box, which the user can use to zoom the graph to different
preset locations. Next is the combo box that lets the user select the color scheme of the graph.
Then are the HFR and the Peak checkboxes, which will both turn on the HFR and Peak labels
on each found star in the image, but will also display one of them at the bottom of the screen.
And finally comes the Scaling checkbox, which enables the Scaling Side Panel. There are three
sliders in that panel, one to control the minimum value displayed on the graph or ‘black point’,
one to control the maximum value displayed in the graph or the ‘white point’, and a third that is
disabled by default that lets the user control the cutoff value for data displayed on the graph.

This third slider is very useful to get really big peaks out of the way so you can study the finer
details in the image. There is a checkbox at the top to enable/disable the cutoff slider. And
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finally at the bottom of the sliders is the “Auto scale” button. This will auto scale the sliders as
you sample different areas in the image. It will not only optimize the display of the data but will
also affect the minimum and maximum points of the slider. If you disable auto scale, then as
you sample different parts of the image, they will be displayed at the same scale. A particularly
useful way to use this is to select an area of your image using auto scale, tweak the min, max,
and cutoff sliders to your liking, and then turn off the auto scale feature to explore other areas of
the graph.

5.8.12 Ekos Tutorials

5.8.12.1 Viewer

StellarMate is shipped with a VNC Server. This enables you to access the whole StellarMate
desktop remotely. To connect to VNC, you can either use a Desktop/Mobile VNC Client, or
simply via any browser.

The VNC address is: http:// stellarmate_hostname:6080/vnc.html

Where stellarmate_hostname is the actual hostname (or IP address) of your unit and 6080 is
the port. If you do not know the unit hostname, you can find the hostname in your StellarMate
App.

You can use Real VNC which is available on all platforms to access stellarmate.

Once you access StellarMate, you can use it like any full-fledged computer. The default username
is stellarmate and the default password is smate.
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5.9 Jupiter Moons Tool

This tool displays the positions of Jupiter’s four largest moons (Io, Europa, Ganymede, and Cal-
listo) relative to Jupiter, as a function of time. Time is plotted vertically; the units are days and
‘time=0.0’ corresponds to the current simulation time. The horizontal axis displays the angu-
lar offset from Jupiter’s position, in arcminutes. The offset is measured along the direction of
Jupiter’s equator. Each moon’s position as a function of time traces a sinusoidal path in the plot,
as the moon orbits around Jupiter. Each track is assigned a different color to distinguish it from
the others; the name labels at the top of the window indicate the color used by each moon (i.e.
red for Io, yellow for Europa, green for Callisto and blue for Ganymede).

The plot can be manipulated with the keyboard. The time axis can be expanded or compressed
using the + and - keys. The time displayed at the center of the window can be changed with the
[ and ] keys.

5.10 Observation Planner

Since KDE SC 4.4, Prakash Mohan’s GSoC work has been released in KStars. KStars now has
an awesome observation planner to plan your observation sessions. The execute session option
allows you to log information about objects as you observe them. Alternately, you may also write
a short log in the session planner itself. We wish you a lot of fun planning your observations with
KStars!
You can even add some pictures to the objects. The image list is a Google image search list. To
add image to an object just press Find Image button on the right and then find an image that you
like. If you do not have an Internet connection you can open an image from your hard drive.
Note that images that will be used are going to be cropped to 600x600 pixels.

The first way of doing this is by pressing Ctrl+2 or Ctrl+L to open the Observation List, then
press the Add Object button.
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The Download all Images button does a search for the SDSS images and displays the DSS image
if the requested RA/Dec is out of the SDSS footprint.

This is an SDSS image of a galaxy
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This is an DSS image of the same galaxy

The Delete all Images button does the opposite. It deletes all downloaded images.

The image for the galaxy is now deleted

You can add more objects by pressing the Find Object button. It will open the Find Object tool
which provides two accurate methods for sorting out the items, depending on what criteria you
want to use. You can filter the list by objects type: Any, Stars, Solar System, Clusters (Globular
and Open), Nebulae (Gaseous and Planetary), Galaxies, Comets, Asteroids, Constellations, Su-
pernovae or Satellites. You can also filter the objects list by name. Enter the name of desired
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object in the Filter by name text box.

Inside Observation Planner window you can see the ‘Altitude vs Time’ widget (AltvsTime),
which shows you how the altitude of a selected object varies over time.

Below the AltvsTime widget, there is a text box in that you can add observing notes for current
sky object.

Note that the Wish List is not the Session Plan. In the Wish List you can add objects that you wish
to observe at some point. From there you can add them to the Session Plan.

You can see the pop-up window that comes after right-clicking on an object.

Add objects to Session Plan window

Here is the second way of adding objects in your Observation Plan, using the Observing List
Wizard. You just need to press the fourth button on the top-left corner of the Observation Planner
window.
Despite looking differently this way is basically the same as the first one. Although that it could
be a bit more detailed. Here you can see the same categories of objects.
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You can choose where these objects to be on the sky. There are four options available for you:
All over the sky (which is the default option), by constellation and in a region (rectangular or
circular).
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You can choose the date for the observation and the place you are going to observe from.

You can choose the treshold of magnitude for the objects to be shown. In astronomy, absolute
magnitude (also known as absolute visual magnitude when measured in the standard V photo-
metric band) measures a celestial object’s intrinsic brightness.
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You can save your observation plan. And it will save it with a .obslist extension.

You can also access the WUT (What’s up tonight), which could be of a great assistance to you. It
can give you ideas what to observe on a date, time and place that you specify using the configu-
ration buttons int the top-right corner of the What’s up tonight window.
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This is how the Execution Session Window look. It can be opened by pressing Ctrl+2. In it you
can also see some information about the selected object and you are able to add observing notes.

First Execute Session window
By pressing the Next Page button you will access the second page of Session Plan. Here you are
able to see information not about your object, but about your equipment.
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Second Execute Session window
Pressing the Next Target button will cause the Execute Session to open the first window about
the next object.

5.11 FITS Viewer Tool

The Flexible Image Transport System (FITS) is the standard format for representing images and
data in Astronomy.

The KStars FITS Viewer tool is integrated with the INDI framework for seamless display and
manipulation of captured FITS images. To open a FITS file, select Open FITS... from the File
menu, or press Ctrl+O.

FITS Viewer features:

• Support for 8, 16, 32, IEEE -32, and IEEE -64 bits formats.

• Support Color FITS images (3D Cubes) and Bayered FITS images.

• Histogram with linear, logarithmic, and square-root scales.

• Brightness/Contrast controls.

• Pan and Zoom.

• Auto levels.

• Statistics.

• Detection and highlight of stars.

• FITS header query.

• Undo/Redo.

137



The KStars Handbook

The above diagram illustrates the FITS Viewer work area and window. The tool provides basic
functions for image display. FITS data depth is preserved throughout all processing, open, and
save functions. While the tool adhere to the FITS standard, it does not support all possible FITS
features:

• Support for only one image per file.

• Support for only 2D and 3D data. 1D data are discarded.

The following is a brief description of the tool’s functional units:

• Histogram: Displays one-channel FITS histogram. The user can rescale the image by option-
ally defining an upper and lower limit for the cutoff region. The rescaling operation (linear,
logarithmic, or square-root) may then be applied to the region enclosed by the upper and lower
limits.

• Statistics: Provides simple statistics for minimum and maximum pixel values and their respec-
tive locations. FITS depth, dimension, mean, and standard deviation.

• FITS header: Displays FITS header information.
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Chapter 6

Command-Line mode for Image
Generation

You can use KStars to generate an image of the sky without actually launching the GUI portion
of the program. To use this feature, start KStars from a command prompt using arguments to
specify the filename for the image, as well as the desired image dimensions:

kstars --dump [--filename kstars.png] [--height 640] [--width 480] [--script myscript.kstars]
[--date ´´4 July 1976 12:30:00´´]

If no filename is specified, it generates a file named kstars.png. It will attempt to generate an
image that matches the extension of your filename. The following extensions are recognized:
‘png’, ‘jpg’, ‘jpeg’, ‘gif’, ‘pnm’, and ‘bmp’. If the filename extension is not recognized, it defaults
to the PNG image type.

Likewise, if the image width and height are not specified, they default to 640 and 480, respec-
tively.

By default, KStars will read in the options values stored in your $KDEHOME/share/config/ksta
rsrc file to determine where the image will be centered, and how it is rendered. This means
you need to run KStars in normal GUI mode, and exit the program when it is set up with the
desired options for the generated images. This is not very flexible, so we also provide the ability
to execute a KStars D-Bus script to set the scene before generating the image. The filename you
specify as the script argument should be a valid KStars D-Bus script, such as one created with the
Script Builder Tool. The script can be used to set where the image is pointing, set the geographic
location, set the time and date, change the Zoom level, and adjust other view options. Some of
the D-Bus functions make no sense in non-GUI mode (such as waitForKey()); if these functions
are encountered while parsing the script, they are simply ignored.

By default, KStars will use the system CPU time and date for generating the image. Alternatively,
you may specify a time and date with the ‘--date’ argument. You can also use this argument for
specifying the startup date in normal GUI mode.
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Chapter 7

Astronomical Device Control with
INDI

KStars provides an interface to configure and control astronomical instruments via the INDI pro-
tocol.
The INDI protocol supports a variety of astronomical instruments such as CCD cameras and
focusers. For an up to date list of supported devices, please visit INDI supported devices page.

7.1 INDI Setup

KStars can control local and remote devices seamlessly via the INDI server/client architecture.
INDI devices may be run in three different modes:

1. Local: The local mode is the most common and is used to control local device (i.e. a device
attached to your machine).

2. Server: The server mode establishes an INDI server for a particular device and waits for
connections from remote clients. You cannot operate server devices, you can only start and
shut them down.

3. Client: The client mode is used to connect to remote INDI servers running INDI devices.
You can control remote devices seamlessly like local devices.

You can run local device, establish INDI servers, and connect to remote clients from the Device
Manager in the Tools → Devices submenu.

Here is a screenshot of the Device Manager window:
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You can run devices by browsing the device tree, selecting a specific device, and then clicking
on the Run Service button. You can select the operation mode, either local or server as defined
above. The port number is randomly generated between the range from 7624 to 10,000. To specify
a port, click on the port column next to the desired driver. KStars allows multiple drivers to run
under one INDI server, and hence one port. Select multiple drivers then press Run Service
button.
To control remote devices, refer to the remote device control section.

7.2 Telescope Setup

Most telescopes are equipped with RS232 interface for remote control. Connect the RS232 jack
in your telescope to your computer’s Serial/USB port. Traditionally, the RS232 connects to the
serial port of your computer, but since many new laptops abandoned the serial port in favor of
USB/FireWire ports, you might need to obtain a Serial to USB adaptor to use with new laptops.

After connecting your telescope to the Serial/USB port, turn your telescope on. It is highly rec-
ommended that you download and install the latest firmware for your telescope controller.

The telescope needs to be aligned before it can be used properly. Align your telescope (one or
two stars alignment) as illustrated in your telescope manual.

KStars needs to verify time and location settings before connecting to the telescope. This insures
proper tracking and synchronization between the telescope and KStars. The following steps will
enable you to connect to a device that is connected to your computer. To connect and control
remote devices, please refer to remote device control section.

You can use the Telescope Setup Wizard and it will verify all the required information in the
process. It can automatically scan ports for attached telescopes. You can run the wizard by
selecting Telescope Wizard from the Devices menu.

Alternatively, you can connect to a local telescope by performing the following steps:

1. Set your geographical location. Open the Set Geographic Location window by selecting
Geographic... from the Settings menu, or by pressing the Globe icon in the toolbar, or by
pressing Ctrl+G.
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2. Set your local time and date. You can change to any time or date by selecting Set Time...
from the Time menu, or by pressing the time icon in the toolbar. The Set Time window
uses a standard KDE Date Picker widget. If you ever need to reset the clock back to the
current time, just select Set Time to Now from the Time menu.

3. Click on the Tools → Devices submenu and select the Device Manager.

4. Under the Device column, select your telescope model.

5. Click on the Run Service button.

6. Click Close to leave the Device Manager Dialog.

FREQUENT SETTINGS
You do not need to set the geographic location and time every time you connect to a telescope. Only
adjust the settings as needed.

You are now ready to use the device features, KStars conveniently provides two interchangeable
GUI interfaces for controlling telescopes:

CONTROLLING YOUR TELESCOPE

1. Sky map Control: For each device you run in the Device Manager, a corresponding entry
will show up in popup menu that allows you to control the properties of the device. You
can issue commands like Slew, Sync, and Track directly from the sky map.
Here is a screenshot of the popup menu with an active LX200 Classic device:

2. INDI Control Panel: The panel offers the user with all the features supported by a device.
The panel is divided into three main sections:

• Device tabs: Each additional active device occupies a tab in the INDI panel. Multiple
devices can run simultaneously without affecting the operation of other devices.
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• Property views on the Main Control and Options tabs: Properties are the key element
in INDI architecture. Each device defines a set of properties to communicate with the
client. The current position of the telescope is an example of a property. Semantically
similar properties are usually contained in logical blocks or groupings.

• Log viewer: Devices report their status and acknowledge commands by sending INDI
messages. Each device has its own log view. A device usually sends messages to its
device driver only, but a device is permitted to send a generic message when appropriate.

You are not restricted on using one interface over another as they can be both used simultane-
ously. Actions from the Sky map are automatically reflected in the INDI Control Panel and vice
versa.
To connect to your telescope, you can either select Connect from your device popup menu or
alternatively, you can press Connect under your device tab in the INDI Control Panel.

IMPORTANT
By default, KStars will try to connect to the /dev/ttyS0 port. To change the connection port, select
INDI Control Panel from the Tools → Devices submenu and change the port under your device tab.

KStars automatically updates the telescope’s longitude, latitude, and time based on current set-
tings in KStars. You can enable/disable these using the INDI tab from Settings → Configure
KStars... submenu. Using the INDI tab you can configure KStars to display or not INDI status
messages in the status bar. By default INDI server port numbers have values between the range
from 7624 to 9000, but you can easily change the range using the From and To text boxes from
the Server Port section.
If KStars communicates successfully with the telescope, it will retrieve the current RA and DEC
from the telescope and will display a crosshair on the sky map indicating the telescope posi-
tion. You can hide the crosshair that marks telescope position using INDI tab from Settings
→ Configure KStars... submenu.
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SYNCHRONIZING YOUR TELESCOPE
If you aligned your telescope and the last alignment star was, for example, Vega, then the crosshair
should be centered around Vega. If the crosshair was off target, then you can right-click Vega from
the sky map and select Sync from your telescope menu. This action will instruct the telescope to
synchronize its internal coordinates to match those of Vega, and the telescope’s crosshair should now
be centered around Vega.

This is it: your telescope is ready to explore the heavens!

WARNING
Never use the telescope to look at the sun. Looking at the sun might cause irreversible damage to your
eyes and your equipment.

7.3 CCD and Video-Capture Setup

You can run CCD and Video Capture devices from the Device Manager in the Tools → Devices
submenu. Like all INDI devices, some of the device controls will be accessible from the skymap.
The device can be controlled fully from the INDI Control Panel.

The standard format for image capture is FITS. Once an image is captured and downloaded, it
will be automatically displayed in the KStars FITS Viewer.

7.4 Configure INDI

The INDI page allows you to modify Client side INDI specific options. To access it, select the
INDI tab from Settings → Configure KStars... submenu. The window is divided into several
main categories: General, Device Updates, Display and Server Port:

• General

– INDI Server: Specify the binary of installed INDI server in your system. By default, KStars
uses ‘/usr/bin/indiserver’ binary.

– INDI Drivers Directory: Specify the directory where INDI drivers are located in your sys-
tem. By default, KStars uses ‘/usr/share/indi’ directory.

– Default FITS directory: Specify the directory where all captured FITS images will be
saved to. If no directory is specified, images will be stored in $HOME.

• Device Updates

– Computer: Sync the device to the computer’s time and location settings.
– Device: Sync the computer to the device’s time and location settings.
– Time: Update the telescope’s date and time, if supported, upon connection.
– Geographic location: Update the telescope’s geographical location information (current

longitude and latitude), if supported, upon connection.

• Display

– Telescope crosshair: When checked, KStars displays the telescope’s target crosshair on
the sky map. The crosshair is displayed upon a successful connection to the telescope and
its location is updated periodically. The telescope’s name is displayed next to the crosshair.
KStars displays one crosshair per each connected telescope. To change the color of the tele-
scope’s crosshair, open the Configure KStars window. Select the Colors tab, and then change
the color of the Target Indicator item to the desired color.
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– INDI messages in status bar: When checked, KStars displays INDI status messages in
the KStars status bar.

• Server Port: Specify range of ports that INDI Server will bind to when starting new drivers.

7.5 INDI Concepts

The main key concept in INDI is that devices have the ability to describe themselves. This is
accomplished by using XML to describe a generic hierarchy that can represent both canonical
and non-canonical devices. In INDI, all devices may contain one or more properties. Any property
may contain one or more elements. There are four types of INDI properties:

• Text property.

• Number property.

• Switch property (Represented in GUI by buttons and checkboxes).

• Light property (Represented in GUI by colored LEDs).

For example, all INDI devices share the CONNECTION standard switch property. The CON-
NECTION property has two elements: CONNECT and DISCONNECT switches. KStars parses
the generic XML description of properties and builds a GUI representation suitable for direct
human interaction.
The INDI control panel offers many device properties not accessible from the sky map. The
properties offered differ from one device to another. Nevertheless, all properties share common
features that constrains how they are displayed and used:

• Permission: All properties can either be read-only, write-only, or read and write enabled. An
example of a read-write property is the telescope’s Right Ascension. You can enter a new
Right Ascension and the telescope, based on current settings, will either slew or sync to the
new input. Furthermore, when the telescope slews, its Right Ascension gets updated and sent
back to the client.

• State: Prefixed to each property is a state indicator (round LED). Each property has a state and
an associated color code:

State Color Description

Idle Gray
Device is performing no
action with respect to this
property

Ok Green
Last operation performed
on this property was
successful and active

Busy Yellow The property is performing
an action

Alert Red
The property is in critical
condition and needs
immediate attention

Table 7.1: INDI State color code

The device driver updates the property state in real-time when necessary. For example, if the
telescope is in the process of slewing to a target, then the RA/DEC properties will be signaled
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as Busy. When the slew process is completed successfully, the properties will be signaled as
Ok.

• Context: Numerical properties can accept and process numbers in two formats: decimal and
sexagesimal. The sexagesimal format is convenient when expressing time or equatorial/geo-
graphical coordinates. You can use any format at your convenience. For example, all the
following numbers are equal:

– -156.40
– -156:24:00
– -156:24

• Time: The standard time for all INDI-related communications is Universal Time UTC specified
as YYYY-MM-DDTHH:MM:SS in accord with ISO 8601. KStars communicates the correct UTC
time with device drivers automatically. You can enable/disable automatic time updates from
the INDI page in the settings dialog.

7.6 Remote Device Control

KStars provides a simple yet powerful layer for remote device control. A detailed description of
the layer is described in the INDI white paper.

You need to configure both the server and client machines for remote control:

1. Server: To prepare a device for remote control, follow the same steps in the local/server
setup. When you start a device service in the Device Manager, a port number is displayed
under the Port column. In addition to the port number, you also need the hostname or IP
address of your server.

2. Client: Select the Device Manager from the Tools → Devices submenu and click on the
Client tab. You can add, modify, or delete hosts under the Client tab. Add a host by
clicking on the Add button. Enter the hostname/IP address of the server in the Host field,
and enter the port number obtained from the server machine in step 1.
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After you add a host, right click on the host to Connect or Disconnect. If a connection is es-
tablished, you can control the telescope from the Sky map or INDI Control Panel exactly as
described in the local/server section. It is as easy at that.

7.6.1 Running an INDI server from the command line

While KStars allows you to easily deploy an INDI server; you can launch an INDI server from
the command line.
Since INDI is an independent backend component, you can run an INDI server on a host without
KStars. INDI can be compiled separately to run on remote hosts. Furthermore, device drivers log
messages to stderr and that can be helpful in a debugging situation. The syntax for INDI server
is as following:

$ indiserver [options] [driver ...]

Options:

-l d : log driver messages to d/YYYY-MM-DD.islog

-m m : kill client if gets more than this many MB behind, default 10

-p p : alternate IP port, default 7624

-f path : Path to fifo for dynamic startup and shutdown of drivers.

-v : show key events, no traffic

-vv : -v + key message content

-vvv : -vv + complete xml

driver : executable or device@host[:port]

For example, if you want to start an INDI server running an LX200 GPS driver and listening to
connections on port 8000, you would run the following command:

$ indiserver -p 8000 lx200gps

7.6.2 Secure Remote Operation

Suppose we want to run an indiserver with INDI drivers on a remote host, remote_host, and
connect them to KStars running on the local machine.

From the local machine log onto the remote host, remote_host, by typing:

$ ssh -L local_port:remote_host:remote_port

This binds the local_port on the local machine to the remote_port on the remote_host. After
logging in, run indiserver on the remote host:

$ indiserver -p remote_port [driver...]

Back on the local machine, start KStars then open the Device Manager and add a host under
the Client tab. The host should be the local host (usually 127.0.0.1) and the port number should
be the local_port used in the steps above. Right-click on the host and select Connect from the
popup menu. KStars will connect to the remote INDI server securely. The host information will
be saved for future sessions.
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7.7 INDI Frequently Asked Questions

Q: What is INDI?

A: INDI is the Instrument-Neutral-Distributed-Interface control protocol developed by Elwood
C. Downey of ClearSky Institute. KStars employs device drivers that are compatible with the
INDI protocol. INDI has many advantages including loose coupling between hardware devices
and software drivers. Clients that use the device drivers (like KStars) are completely unaware of
the device capabilities. In run time, KStars communicates with the device drivers and builds
a completely dynamical GUI based on services provided by the device. Therefore, new de-
vice drivers can be written or updated and KStars can take full advantage of them without any
changes on the client side.

Q: Do you plan to support more devices?

A: Yes. We plan to support major CCD cameras and focusers and extend support for more
telescopes. If you would like INDI to support a particular device, please send an email to indi-
devel@lists.sourceforge.net

Q: What operations does KStars provide to control the telescope?

A: It depends on the particular telescope you’re running, but the minimum three operations are
Slew, Track, and Sync, which you can issue directly from the sky map. Your telescope must
be aligned for those operations to perform correctly. Some telescopes offer you more operations
like site management, slew modes, focusing, parking, and more. You can access the telescopes
extended features from the INDI Control Panel in the Tools → Devices submenu.
Q: What’s the difference between Slew, Track, and Sync exactly?

A: The command Slew orders the telescope to move to a particular target, and once the telescope
reaches its target, the telescope keeps tracking that target at a sidereal rate (i.e. the rate at which
stars move across the sky). This works well for stars, Messier objects, and about everything
outside our solar system. But solar system objects travel differently across the sky and so the
telescope must Track the objects as they move.

Therefore, you need to issue a track command if you want to track an object with non-sidereal
motion. On the other hand, Sync is used to synchronize the telescope’s internal coordinates with
that of an object you select.

Q: Can I control my telescope remotely?

A: Yes. You can start an INDI server on the machine connected to your telescope and the server
will listen to requests from KStars clients. Once you’re connected, you can control your telescope
directly from the sky map. This procedure is described in detail in the Remote device control
section.
Q: When I try to Connect, KStars reports that the telescope is not connected to the serial/USB port. What
can I do?
A: This message is triggered when KStars cannot communicate with the telescope. Here are few
things you can do:

1. Check that you have both reading and writing permission for the port you are trying to
connect to.

2. Check the connection cable, make sure it is in good condition and test it with other appli-
cations.

3. Check your telescope power, make sure the power is on and that the telescope is getting
enough power.

4. Set the correct port in the INDI Control Panel under the Devices menu. The default device
is /dev/ttyS0

5. Restart KStars and retry again.
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Q: KStars reports that the telescope is online and ready, but I cannot find the telescope’s crosshair, where
is it?
A: KStars retrieves the telescopes RA and DEC coordinates upon connection. If your alignment
was performed correctly, then you should see the crosshair around your target in the Sky Map.
However, the RA and DEC coordinates provided by the telescope may be incorrect (even below
the horizon) and you need to Sync your telescope to your current target. You can use the right-
click menu to center and track the telescope crosshair in the sky map.

Q: The telescope is moving erratically or not moving at all. What can I do?

A: This behavior is mostly due to incorrect settings, please verify the following check list:

1. Is the telescope aligned?

2. Is the telescope alignment mode correct? Use INDI Control Panel to check and change
these settings (Alt/Az,Polar, Land).

3. Are the telescope’s time and date settings correct?

4. Are the telescope’s longitude and latitude settings correct?

5. Is the telescope’s UTC offset correct?

6. Are the telescope’s RA and DEC axis locked firmly?

7. Is the telescope’s N/S switch (when applicable) setup correctly for your hemisphere?

8. Is the cable between the telescope and computer in good condition?

If you think all settings are correct but the telescope still moves erratically or not at all, then please
send a report to indi-devel@lists.sourceforge.net.
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Chapter 8

Questions and Answers

1. What do the different symbols for deep-sky objects mean?
The symbol indicates the object type:

• dotted circle: Open Cluster
• cross-in-circle: Globular Cluster
• box: Gaseous Nebula
• diamond: Supernova Remnant
• circle with outer lines: Planetary Nebula
• ellipse: Galaxy

2. What do the different colors of Deep-sky objects mean?
Generally, the different colors indicate to which catalog the object belongs (Messier, NGC
or IC). However, some objects have a different color which indicates that there are extra
images available in the popup menu (the default ‘extras’ color is red).

3. Why are there so many more U.S. cities than in other countries?
When we started KStars, we were unable to find a longitude/latitude database that covered
the globe equitably. However, the KStars community is rapidly overcoming this problem!
We have already received city lists from many users around the world. If you can contribute
to this effort, please send us your list of cities and coordinates.

4. How can I add a new custom location to KStars?
If you would like to use a location that is not on the list, enter the relevant information
(longitude, latitude, city name, province name, and country name), then press Add to list
button. All fields must be filled, except the optional province field. You can also modify the
values for an existing city, by simply changing the values in the window, and adding it to
the list.

5. I have added a custom location to KStars that I no longer want. How do I remove it from the
program?
You can easily remove a custom location from KStars by selecting it in the cities list and
pressing the Remove City button. Note that you can not remove a KStars default city.

6. Why do some objects disappear when I am scrolling the display?
When the display is in motion, KStars must recompute the screen coordinates of every
object in its database, which involves some pretty heavy trigonometry. When scrolling
the display (either with the arrow keys or by dragging with the mouse), the display may
become slow and jerky, because the computer is having trouble keeping up. By excluding
many of the objects, the computational load is greatly reduced, which allows for smoother
scrolling. You can turn off this feature in the Configure KStars window, and you can also
configure which objects get hidden.
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7. I do not understand all the terms used in KStars. Where can I learn more about the astronomy
behind the program?
The KStars Handbook includes the AstroInfo Project; a series of short, hyperlinked articles
about astronomical topics that can be explored and illustrated with KStars. AstroInfo is a
community effort, like GNUpedia or Everything2. If you’d like to contribute to AstroInfo,
please join our mailing list: kstars-devel@kde.org.

8. I want KStars to start up with a time and date different from my system CPU clock. Is this possible?
Yes; to start KStars with a different time/date, use the ‘--date’ argument, followed by a date
string like ‘4 July 1976 12:30:00’

9. I want KStars to start up with the simulation clock paused. Is this possible?
Yes; to start KStars with the clock paused, simply add the ‘--paused’ argument to the com-
mand line.

10. How accurate/precise is KStars?
KStars is pretty accurate, but it is not (yet) as precise as it can possibly be. The problem
with high-precision calculations is that you start having to deal with a large number of
complicating factors. If you are not a professional astronomer, you will probably never
have a problem with its accuracy or precision.
Here is a list of some of the complicating factors which limit the program’s precision:

• Planet positions are only accurate for dates within 4000 years or so of the current epoch.
The planet positions are predicted using a Fourier-like analysis of their orbits, as ob-
served over the past few centuries. We learnt in school that planets follow simple ellipti-
cal orbits around the Sun, but this is not strictly true. It would be true only if there was
only one planet in the Solar system, and if the Sun and the planet were both point masses.
As it is, the planets are constantly tugging on each other, perturbing the orbits slightly,
and tidal effects also induce precessional wobbling. In fact, recent analysis suggests that
the planets’ orbits may not even be stable in the long term (i.e., millions or billions of
years). As a rule of thumb, you can expect the position of a planet to be accurate to a few
arcseconds between the dates -2000 and 6000.
Pluto is the exception to this; its position is perhaps ten times less precise than the po-
sitions of the other planets. Still, for dates near the present epoch, its position can be
trusted to about an arcsecond.
The moon’s position is the most difficult to predict to high precision. This is because its
motion is quite perturbed by the Earth. Also, since it is so nearby, even minute effects
that would be undetectable in more distant bodies are easily apparent in the moon.
The objects with the worst long-term precision in the program are the comets and aster-
oids. We use a very simplistic orbital model for the minor planets that does not include
third-body perturbations. Therefore, their positions can only be trusted for dates near
the present epoch. Even for the present epoch, one can expect positional errors among
the minor planets of order 10 arcseconds or more.

11. Why do I have to download an improved NGC/IC catalog and Messier object images? Why not just
include them as part of the KStars distribution?
The author of the downloadable NGC/IC catalog has released it with the restriction that it
may not be used commercially. For most KStars users, this is not a problem. However, it is
technically against the KStars license (the GPL) to restrict usage in this way. We removed the
Messier object images from the standard distribution for two reasons: to simply reduce the
size of KStars, and also because of similar licensing concerns with a couple of the images.
The inline images are significantly compressed to a very low quality from their original
form, so I doubt there is a real copyright concern, but I did obtain explicit permission from
the images’ authors to use the few images for which there was any question about it (see REA
DME.images). Still, just to be absolutely safe, I removed them from the standard distribution,
and marked the download archive as being ´́ free for non-commercial use´́ .
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12. I am really enjoying the beautiful images I have downloaded through KStars! I would like to share
them with the world; can I publish a calendar featuring these images (or are there any usage restric-
tions on the images)?
It depends on the image, but many of the images restrict against commercial usage. The Im-
age Viewer’s statusbar will usually contain information about the image’s copyright holder,
and what usage restrictions apply. As a rule of thumb: anything published by NASA is in
the public domain (including all HST images). For everything else, you can pretty safely
assume that the images may not be used commercially without permission. When in doubt,
contact the image’s copyright holder directly.

13. Can I help contribute to future versions of KStars?
Yes, definitely! Introduce yourself on our mailing list: kstars-devel@kde.org. If you want
to help with the coding, download the latest KStars Git version of the code and dive right
in. There are several README files in the distribution that explain some of the code’s
subsystems. If you need ideas of what to work on, see the TODO file. You can submit
patches to kstars-devel, and feel free to post any questions you have about the code there
as well.
If you are not into coding, we can still use your help with i18n, docs, AstroInfo articles,
URL links, bug reports, and feature requests.
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Chapter 9

The AstroInfo Project

Here you can find a collection of short articles that explain various astronomical concepts used in
KStars. From coordinate systems to celestial mechanics, you can find answers to your questions
here.
The articles sometimes also contain exercises that you can perform with KStars to illustrate the
concept behind the article.

9.1 AstroInfo: Table of Contents

THE SKY AND COORDINATE SYSTEMS

• Celestial Coordinate Systems

• Celestial Equator

• Celestial Poles

• Celestial Sphere

• The Ecliptic

• The Equinoxes

• Geographic Coordinates

• Great Circles

• The Horizon

• Hour Angle

• Local Meridian

• Precession

• The Zenith

TIME

• Epoch

• Julian Day

• Leap Years
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• Sidereal Time

• Time Zones

• Universal Time

INSTRUMENTATION

• Telescopes

PHYSICS

• Blackbody Radiation

• Dark Matter

• Flux

• Luminosity

• Parallax

• Retrograde Motion

ASTROPHYSICS

• Elliptical Galaxies

• Spiral Galaxies

• The Magnitude Scale

• Stars: An Introductory FAQ

• Star Colors and Temperatures

• The Cosmic Distance Ladder

9.2 Celestial Coordinate Systems

A basic requirement for studying the heavens is determining where in the sky things are. To
specify sky positions, astronomers have developed several coordinate systems. Each uses a coordi-
nate grid projected on the Celestial Sphere, in analogy to the Geographic coordinate system used
on the surface of the Earth. The coordinate systems differ only in their choice of the fundamental
plane, which divides the sky into two equal hemispheres along a great circle. (the fundamental
plane of the geographic system is the Earth’s equator). Each coordinate system is named for its
choice of fundamental plane.

9.2.1 The Equatorial Coordinate System

The Equatorial coordinate system is probably the most widely used celestial coordinate system. It
is also the most closely related to the Geographic coordinate system, because they use the same
fundamental plane, and the same poles. The projection of the Earth’s equator onto the celestial
sphere is called the Celestial Equator. Similarly, projecting the geographic Poles onto the celestial
sphere defines the North and South Celestial Poles.

However, there is an important difference between the equatorial and geographic coordinate
systems: the geographic system is fixed to the Earth; it rotates as the Earth does. The Equatorial
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system is fixed to the stars1, so it appears to rotate across the sky with the stars, but of course it is
really the Earth rotating under the fixed sky.

The latitudinal (latitude-like) angle of the Equatorial system is called Declination (Dec for short).
It measures the angle of an object above or below the Celestial Equator. The longitudinal angle
is called the Right Ascension (RA for short). It measures the angle of an object East of the Vernal
Equinox. Unlike longitude, Right Ascension is usually measured in hours instead of degrees,
because the apparent rotation of the Equatorial coordinate system is closely related to Sidereal
Time and Hour Angle. Since a full rotation of the sky takes 24 hours to complete, there are (360
degrees / 24 hours) = 15 degrees in one Hour of Right Ascension.

The equatorial coordinates for deep-sky objects and stars do not vary appreciably over short
durations of time, since they are not affected by the diurnal motion (the daily apparent rotation of
the sky around the earth. However, note that this takes 1 sidereal day, as against 1 solar day).
They are suitable coordinates for making catalogs of stars and deep-sky objects (note that Galactic
Coordinates also work well, but are cumbersome to use from an earth point-of-view). However,
there are effects that cause the RA and Dec of objects to vary over time, namely Precession and
nutation, and proper motion, the latter being even less important. Equatorial coordinates are thus
generally specified with an appropriate epoch, to account for precession. Popular epochs include
J2000.0 (Julian Year 2000) and B1950.0 (Besselian Year 1950).

9.2.2 The Horizontal Coordinate System

The Horizontal coordinate system uses the observer’s local horizon as the Fundamental Plane.
This conveniently divides the sky into the upper hemisphere that you can see, and the lower
hemisphere that you can’t (because the Earth is in the way). The pole of the upper hemisphere
is called the Zenith. The pole of the lower hemisphere is called the nadir. The angle of an object
above or below the horizon is called the Altitude (Alt for short). The angle of an object around the
horizon (measured from the North point, toward the East) is called the Azimuth. The Horizontal
Coordinate System is sometimes also called the Alt/Az Coordinate System.

The Horizontal Coordinate System is fixed to the Earth, not the Stars. Therefore, the Altitude and
Azimuth of an object changes with time, as the object appears to drift across the sky. In addition,
because the Horizontal system is defined by your local horizon, the same object viewed from
different locations on Earth at the same time will have different values of Altitude and Azimuth.
Horizontal coordinates are very useful for determining the Rise and Set times of an object in the
sky. When an object has Altitude=0 degrees, it is either Rising (if its Azimuth is < 180 degrees)
or Setting (if its Azimuth is > 180 degrees).

9.2.3 The Ecliptic Coordinate System

The Ecliptic coordinate system uses the Ecliptic for its Fundamental Plane. The Ecliptic is the path
that the Sun appears to follow across the sky over the course of a year. It is also the projection
of the Earth’s orbital plane onto the Celestial Sphere. The latitudinal angle is called the Ecliptic
Latitude, and the longitudinal angle is called the Ecliptic Longitude. Like Right Ascension in the
Equatorial system, the zeropoint of the Ecliptic Longitude is the Vernal Equinox.

What do you think such a coordinate system would be useful for? If you guessed charting solar
system objects, you are right! Each of the planets (except Pluto) orbits the Sun in roughly the
same plane, so they always appear to be somewhere near the Ecliptic (i.e., they always have
small ecliptic latitudes).

1 actually, the equatorial coordinates are not quite fixed to the stars. See precession. Also, if Hour Angle is used in
place of Right Ascension, then the Equatorial system is fixed to the Earth, not to the stars.
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9.2.4 The Galactic Coordinate System

The Galactic coordinate system uses the Milky Way as its Fundamental Plane. The latitudinal
angle is called the Galactic Latitude, and the longitudinal angle is called the Galactic Longitude.
This coordinate system is useful for studying the Galaxy itself. For example, you might want to
know how the density of stars changes as a function of Galactic Latitude, to how much the disk
of the Milky Way is flattened.

9.3 The Celestial Equator

The Celestial Equator is an imaginary great circle on the celestial sphere. The celestial equator is
the fundamental plane of the Equatorial Coordinate System, so it is defined as the locus of points
with Declination of zero degrees. It is also the projection of the Earth’s equator onto the sky.

The Celestial Equator and the Ecliptic are set at an angle of 23.5 degrees in the sky. The points
where they intersect are the Vernal and Autumnal Equinoxes.

9.4 The Celestial Poles

The sky appears to drift overhead from east to west, completing a full circuit around the sky in 24
(Sidereal) hours. This phenomenon is due to the spinning of the Earth on its axis. The Earth’s spin
axis intersects the Celestial Sphere at two points. These points are the Celestial Poles. As the Earth
spins; they remain fixed in the sky, and all other points seem to rotate around them. The celestial
poles are also the poles of the Equatorial Coordinate System, meaning they have Declinations of
+90 degrees and -90 degrees (for the North and South celestial poles, respectively).

The North Celestial Pole currently has nearly the same coordinates as the bright star Polaris
(which is Latin for ‘Pole Star’). This makes Polaris useful for navigation: not only is it always
above the North point of the horizon, but its Altitude angle is always (nearly) equal to the ob-
server’s Geographic Latitude (however, Polaris can only be seen from locations in the Northern
hemisphere).

The fact that Polaris is near the pole is purely a coincidence. In fact, because of Precession, Polaris
is only near the pole for a small fraction of the time.

TIP
Exercises:
Use the Find Object window (Ctrl+F) to locate Polaris. Notice that its Declination is almost (but
not exactly) +90 degrees. Compare the Altitude reading when focused on Polaris to your location’s
geographic latitude. They are always within one degree of each other. They are not exactly the same
because Polaris isn’t exactly at the Pole. (you can point exactly at the pole by switching to Equatorial
coordinates, and pressing the up-arrow key until the sky stops scrolling).
Use the Time Step spinbox in the toolbar to accelerate time to a step of 100 seconds. You can see
the entire sky appears to rotate around Polaris, while Polaris itself remains nearly stationary.
We said that the celestial pole is the pole of the Equatorial coordinate system. What do you think is
the pole of the horizontal (Altitude/Azimuth) coordinate system? (The Zenith).

9.5 The Celestial Sphere

The celestial sphere is an imaginary sphere of gigantic radius, centered on the Earth. All objects
which can be seen in the sky can be thought of as lying on the surface of this sphere.
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Of course, we know that the objects in the sky are not on the surface of a sphere centered on the
Earth, so why bother with such a construct? Everything we see in the sky is so very far away,
that their distances are impossible to gauge just by looking at them. Since their distances are
indeterminate, you only need to know the direction toward the object to locate it in the sky. In this
sense, the celestial sphere model is a very practical model for mapping the sky.

The directions toward various objects in the sky can be quantified by constructing a Celestial
Coordinate System.

9.6 The Ecliptic

The ecliptic is an imaginary Great Circle on the Celestial Sphere along which the Sun appears to
move over the course of a year. Of course, it is really the Earth’s orbit around the Sun causing
the change in the Sun’s apparent direction. The ecliptic is inclined from the Celestial Equator by
23.5 degrees. The two points where the Ecliptic crosses the Celestial Equator are known as the
Equinoxes.

Since our solar system is relatively flat, the orbits of the planets are also close to the plane of the
ecliptic. In addition, the constellations of the zodiac are located along the ecliptic. This makes the
ecliptic a very useful line of reference to anyone attempting to locate the planets or the constella-
tions of the zodiac, since they all literally ‘follow the Sun’.

Because of the 23.5-degree tilt of the Ecliptic, the Altitude of the Sun at noon changes over the
course of the year, as it follows the path of the Ecliptic across the sky. This causes the seasons.
In the Summer, the Sun is high in the sky at noon, and it remains above the Horizon for more
than twelve hours. Whereas, in the winter, the Sun is low in the sky at noon, and remains above
the Horizon for less than twelve hours. In addition, sunlight is received at the Earth’s surface
at a more direct angle in the Summer, which means that a given area at the surface receives
more energy per second in the Summer than in Winter. The differences in day duration and in
energy received per unit area lead to the differences in temperature we experience in Summer
and Winter.

TIP
Exercises:
Make sure your location is set to somewhere that is not very near the equator for these experiments.
Open the Configure KStars window, and switch to Horizontal coordinates, with the Opaque Ground
shown. Open the Set Time window (Ctrl+S),and change the Date to sometime in the middle of Sum-
mer, and the Time to 12:00 Noon. Back in the Main Window, point toward the Southern Horizon (press
S). Note the height of the Sun above the Horizon at Noon in the Summer. Now, change the Date to
something in the middle of Winter (but keep the Time at 12:00 Noon). The Sun is now much lower in
the Sky. You will also notice that the day durations are different if you open the What’s Up Tonight?
tool for each date.

9.7 The Equinoxes

Most people know the Vernal and Autumnal Equinoxes as calendar dates, signifying the begin-
ning of the Northern hemisphere’s Spring and Autumn, respectively. Did you know that the
equinoxes are also positions in the sky?

The Celestial Equator and the Ecliptic are two Great Circles on the Celestial Sphere, set at an
angle of 23.5 degrees. The two points where they intersect are called the Equinoxes. The Vernal
Equinox has coordinates RA=0.0 hours, Dec=0.0 degrees. The Autumnal Equinox has coordinates
RA=12.0 hours, Dec=0.0 degrees.
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The Equinoxes are important for marking the seasons. Because they are on the Ecliptic, the Sun
passes through each equinox every year. When the Sun passes through the Vernal Equinox (usu-
ally on March 21st), it crosses the Celestial Equator from South to North, signifying the end of
Winter for the Northern hemisphere. Similarly, when the Sun passes through the Autumnal
Equinox (usually on September 21st), it crosses the Celestial Equator from North to South, signi-
fying the end of Winter for the Southern hemisphere.

9.8 Geographic Coordinates

Locations on Earth can be specified using a spherical coordinate system. The geographic (‘earth-
mapping’) coordinate system is aligned with the spin axis of the Earth. It defines two angles
measured from the center of the Earth. One angle, called the Latitude, measures the angle between
any point and the Equator. The other angle, called the Longitude, measures the angle along the
Equator from an arbitrary point on the Earth (Greenwich, England is the accepted zero-longitude
point in most modern societies).

By combining these two angles, any location on Earth can be specified. For example, Baltimore,
Maryland (USA) has a latitude of 39.3 degrees North, and a longitude of 76.6 degrees West. So,
a vector drawn from the center of the Earth to a point 39.3 degrees above the Equator and 76.6
degrees west of Greenwich, England will pass through Baltimore.

The Equator is obviously an important part of this coordinate system; it represents the zeropoint
of the latitude angle, and the halfway point between the poles. The Equator is the Fundamen-
tal Plane of the geographic coordinate system. All Spherical Coordinate Systems define such a
Fundamental Plane.
Lines of constant Latitude are called Parallels. They trace circles on the surface of the Earth, but
the only parallel that is a Great Circle is the Equator (Latitude=0 degrees). Lines of constant
Longitude are called Meridians. The Meridian passing through Greenwich is the Prime Meridian
(longitude=0 degrees). Unlike Parallels, all Meridians are great circles, and Meridians are not
parallel: they intersect at the north and south poles.

TIP
Exercise:
What is the longitude of the North Pole? Its latitude is 90 degrees North.
This is a trick question. The Longitude is meaningless at the north pole (and the south pole too). It has
all longitudes at the same time.

9.9 Great Circles

Consider a sphere, such as the Earth, or the Celestial Sphere. The intersection of any plane with
the sphere will result in a circle on the surface of the sphere. If the plane happens to contain the
center of the sphere, the intersection circle is a Great Circle. Great circles are the largest circles that
can be drawn on a sphere. Also, the shortest path between any two points on a sphere is always
along a great circle.

Some examples of great circles on the celestial sphere include: the Horizon, the Celestial Equator,
and the Ecliptic.

9.10 The Horizon

The Horizon is the line that separates Earth from Sky. More precisely, it is the line that divides all
of the directions you can possibly look into two categories: those which intersect the Earth, and
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those which do not. At many locations, the Horizon is obscured by trees, buildings, mountains,
etc. However, if you are on a ship at sea, the Horizon is strikingly apparent.

The horizon is the Fundamental Plane of the Horizontal Coordinate System. In other words, it is
the locus of points which have an Altitude of zero degrees.

9.11 Hour Angle

As explained in the Sidereal Time article, the Right Ascension of an object indicates the Sidereal
Time at which it will transit across your Local Meridian. An object’s Hour Angle is defined as the
difference between the current Local Sidereal Time and the Right Ascension of the object:

HAobj = LST - RAobj

Thus, the object’s Hour Angle indicates how much Sidereal Time has passed since the object
was on the Local Meridian. It is also the angular distance between the object and the meridian,
measured in hours (1 hour = 15 degrees). For example, if an object has an hour angle of 2.5
hours, it transited across the Local Meridian 2.5 hours ago, and is currently 37.5 degrees West
of the Meridian. Negative Hour Angles indicate the time until the next transit across the Local
Meridian. Of course, an Hour Angle of zero means the object is currently on the Local Meridian.

9.12 The Local Meridian

The Local Meridian is an imaginary Great Circle on the Celestial Sphere that is perpendicular to
the local Horizon. It passes through the North point on the Horizon, through the Celestial Pole,
up to the Zenith, and through the South point on the Horizon.

Because it is fixed to the local Horizon, stars will appear to drift past the Local Meridian as the
Earth spins. You can use an object’s Right Ascension and the Local Sidereal Time to determine
when it will cross your Local Meridian (see Hour Angle).

9.13 Precession

Precession is the gradual change in the direction of the Earth’s spin axis. The spin axis traces
a cone, completing a full circuit in 26,000 years. If you have ever spun a top or a dreidel, the
‘wobbling’ rotation of the top as it spins is precession.

Because the direction of the Earth’s spin axis changes, so does the location of the Celestial Poles.

The reason for the Earth’s precession is complicated. The Earth is not a perfect sphere, it is a bit
flattened, meaning the Great Circle of the equator is longer than a ‘meridonal’ great circle that
passes through the poles. Also, the Moon and Sun lie outside the Earth’s Equatorial plane. As a
result, the gravitational pull of the Moon and Sun on the oblate Earth induces a slight torque in
addition to a linear force. This torque on the spinning body of the Earth leads to the precessional
motion.
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TIP
Exercise:
Precession is easiest to see by observing the Celestial Pole. To find the pole, first switch to Equatorial
Coordinates in the Configure KStars window, and then hold down the Up arrow key until the display
stops scrolling. The declination displayed in the center of the Info Panel should be +90 degrees, and
the bright star Polaris should be nearly at the center of the screen. Try slewing with the left and right
arrow keys. Notice that the sky appears to rotate around the Pole.
We will now demonstrate Precession by changing the Date to a very remote year, and observing that
the location of the Celestial Pole is no longer near Polaris. Open the Set Time window (Ctrl+S), and
set the date to the year 8000 (currently, KStars cannot handle dates much more remote than this, but
this date is sufficient for our purposes). Notice that the sky display is now centered at a point between
the constellations Cygnus and Cepheus. Verify that this is actually the pole by slewing left and right:
the sky rotates about this point; in the year 8000, the North celestial pole will no longer be near Polaris.

9.14 The Zenith

The Zenith is the point in the sky where you are looking when you look ‘straight up’ from the
ground. More precisely, it is the point on the sky with an Altitude of +90 Degrees; it is the Pole
of the Horizontal Coordinate System. Geometrically, it is the point on the Celestial Sphere inter-
sected by a line drawn from the center of the Earth through your location on the Earth’s surface.

The Zenith is, by definition, a point along the Local Meridian.

TIP
Exercise:
You can point to the Zenith by pressing Z or by selecting Zenith from the Location menu.

9.15 Epoch

An epoch is a certain instant of time (usually past) used as a reference for time measurement in
astronomy. In order to make calculations easier, astronomers usually use the number of days
that have passed since a certain moment in time as a way of representing time in astronomical
calculations. This arbitrarily chosen ´́ starting point´́ reference for time is called an epoch.

An epoch is usually cited along with equatorial coordinates in astronomical catalogs, since the
equatorial coordinates of sky objects change (although slowly) with time. Printed star charts /
atlases are usually marked as being valid for a certain epoch.

The most popular epoch used currently is J2000.0, (the Julian year 2000.0), which (almost exactly)
corresponds to 1st January 2000, 12:00 noon UTC. Other epochs include B1900 and B1950.

KStars supports catalogs based on J2000.0 and B1950.0 epochs.

9.16 Julian Day

Julian Days are a way of reckoning the current date by a simple count of the number of days
that have passed since some remote, arbitrary date. This number of days is called the Julian Day,
abbreviated as JD. The starting point, JD=0, is January 1, 4713 BC (or -4712 January 1, since there
was no year ’0’). Julian Days are very useful because they make it easy to determine the number
of days between two events by simply subtracting their Julian Day numbers. Such a calculation
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is difficult for the standard (Gregorian) calendar, because days are grouped into months, which
contain a variable number of days, and there is the added complication of Leap Years.

Converting from the standard (Gregorian) calendar to Julian Days and vice versa is best left to
a special program written to do this, such as the KStars Astrocalculator. However, for those
interested, here is a simple example of a Gregorian to Julian day converter:

JD = D - 32075 + 1461*( Y + 4800 + ( M - 14 ) / 12 ) / 4 + 367*( M - 2 - ( M - 14 ) / 12 * 12 ) / 12 - 3*(
( Y + 4900 + ( M - 14 ) / 12 ) / 100 ) / 4

where D is the day (1-31), M is the Month (1-12), and Y is the year (1801-2099). Note that this
formula only works for dates between 1801 and 2099. More remote dates require a more compli-
cated transformation.
An example Julian Day is: JD 2440588, which corresponds to 1 Jan, 1970.

Julian Days can also be used to tell time; the time of day is expressed as a fraction of a full day,
with 12:00 noon (not midnight) as the zero point. So, 3:00 pm on 1 Jan 1970 is JD 2440588.125
(since 3:00 pm is 3 hours since noon, and 3/24 = 0.125 day). Note that the Julian Day is always
determined from Universal Time, not Local Time.

Astronomers use certain Julian Day values as important reference points, called Epochs. One
widely-used epoch is called J2000; it is the Julian Day for 1 Jan, 2000 at 12:00 noon = JD 2451545.0.

Much more information on Julian Days is available on the internet. A good starting point is the
U.S. Naval Observatory. If that site is not available when you read this, try searching for ‘Julian
Day’ with your favorite search engine.

9.17 Leap Years

The Earth has two major components of motion. First, it spins on its rotational axis; a full spin
rotation takes one Day to complete. Second, it orbits around the Sun; a full orbital rotation takes
one Year to complete.

There are normally 365 days in one calendar year, but it turns out that a true year (i.e., a full orbit
of the Earth around the Sun; also called a tropical year) is a little bit longer than 365 days. In
other words, in the time it takes the Earth to complete one orbital circuit, it completes 365.24219
spin rotations. Do not be too surprised by this; there is no reason to expect the spin and orbital
motions of the Earth to be synchronized in any way. However, it does make marking calendar
time a bit awkward....
What would happen if we simply ignored the extra 0.24219 rotation at the end of the year, and
simply defined a calendar year to always be 365.0 days long? The calendar is basically a charting
of the Earth’s progress around the Sun. If we ignore the extra bit at the end of each year, then
with every passing year, the calendar date lags a little more behind the true position of Earth
around the Sun. In just a few decades, the dates of the solstices and equinoxes will have drifted
noticeably.

In fact, it used to be that all years were defined to have 365.0 days, and the calendar ‘drifted’ away
from the true seasons as a result. In the year 46 BCE, Julius Caeser established the Julian Calendar,
which implemented the world’s first leap years: He decreed that every 4th year would be 366
days long, so that a year was 365.25 days long, on average. This basically solved the calendar
drift problem.

However, the problem wasn’t completely solved by the Julian calendar, because a tropical year
isn’t 365.25 days long; it’s 365.24219 days long. You still have a calendar drift problem, it just
takes many centuries to become noticeable. And so, in 1582, Pope Gregory XIII instituted the
Gregorian calendar, which was largely the same as the Julian Calendar, with one more trick added
for leap years: even Century years (those ending with the digits ‘00’) are only leap years if they
are divisible by 400. So, the years 1700, 1800, and 1900 were not leap years (though they would
have been under the Julian Calendar), whereas the year 2000 was a leap year. This change makes
the average length of a year 365.2425 days. So, there is still a tiny calendar drift, but it amounts to
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an error of only 3 days in 10,000 years. The Gregorian calendar is still used as a standard calendar
throughout most of the world.

NOTE
Fun Trivia: When Pope Gregory instituted the Gregorian Calendar, the Julian Calendar had been
followed for over 1500 years, and so the calendar date had already drifted by over a week. Pope
Gregory re-synchronized the calendar by simply eliminating 10 days: in 1582, the day after October
4th was October 15th!

9.18 Sidereal Time

Sidereal Time literally means ‘star time’. The time we are used to using in our everyday lives is
Solar Time. The fundamental unit of Solar Time is a Day: the time it takes the Sun to travel 360
degrees around the sky, due to the rotation of the Earth. Smaller units of Solar Time are just
divisions of a Day:

• 1/24 Day = 1 Hour

• 1/60 Hour = 1 Minute

• 1/60 Minute = 1 Second

However, there is a problem with Solar Time. The Earth does not actually spin around 360 de-
grees in one Solar Day. The Earth is in orbit around the Sun, and over the course of one day,
it moves about one Degree along its orbit (360 degrees/365.25 Days for a full orbit = about one
Degree per Day). So, in 24 hours, the direction toward the Sun changes by about a Degree.
Therefore, the Earth has to spin 361 degrees to make the Sun look like it has traveled 360 degrees
around the Sky.

In astronomy, we are concerned with how long it takes the Earth to spin with respect to the ‘fixed’
stars, not the Sun. So, we would like a timescale that removes the complication of Earth’s orbit
around the Sun, and just focuses on how long it takes the Earth to spin 360 degrees with respect
to the stars. This rotational period is called a Sidereal Day. On average, it is 4 minutes shorter than
a Solar Day, because of the extra 1 degree the Earth spins in a Solar Day. Rather than defining
a Sidereal Day to be 23 hours, 56 minutes, we define Sidereal Hours, Minutes and Seconds that
are the same fraction of a Day as their Solar counterparts. Therefore, one Solar Second = 1.00278
Sidereal Seconds.
The Sidereal Time is useful for determining where the stars are at any given time. Sidereal Time
divides one full spin of the Earth into 24 Sidereal Hours; similarly, the map of the sky is divided
into 24 Hours of Right Ascension. This is no coincidence; Local Sidereal Time (LST) indicates
the Right Ascension on the sky that is currently crossing the Local Meridian. So, if a star has a
Right Ascension of 05h 32m 24s, it will be on your meridian at LST=05:32:24. More generally,
the difference between an object’s RA and the Local Sidereal Time tells you how far from the
Meridian the object is. For example, the same object at LST=06:32:24 (one Sidereal Hour later),
will be one Hour of Right Ascension west of your meridian, which is 15 degrees. This angular
distance from the meridian is called the object’s Hour Angle.

TIP
The Local Sidereal Time is displayed by KStars in the Time Info Box, with the label ‘ST’ (you have
to ‘unshade’ the box by double-clicking it in order to see the sidereal time). Note that the changing
sidereal seconds are not synchronized with the changing Local Time and Universal Time seconds. In
fact, if you watch the clocks for a while, you will notice that the Sidereal seconds really are slightly
shorter than the LT and UT seconds.
Point to the Zenith (press Z or select Zenith from the Location menu). The Zenith is the point on the
sky where you are looking ‘straight up’ from the ground, and it is a point on your Local Meridian. Note
the Right Ascension of the Zenith: it is exactly the same as your Local Sidereal Time.
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9.19 Time Zones

The Earth is round, and it is always half-illuminated by the Sun. However, because the Earth is
spinning, the half that is illuminated is always changing. We experience this as the passing of
days wherever we are on the Earth’s surface. At any given instant, there are places on the Earth
passing from the dark half into the illuminated half (which is seen as dawn on the surface). At
the same instant, on the opposite side of the Earth, points are passing from the illuminated half
into darkness (which is seen as dusk at those locations). So, at any given time, different places on
Earth are experiencing different parts of the day. Thus, Solar time is defined locally, so that the
clock time at any location describes the part of the day consistently.

This localization of time is accomplished by dividing the globe into 24 vertical slices called Time
Zones. The Local Time is the same within any given zone, but the time in each zone is one Hour
earlier than the time in the neighboring Zone to the East. Actually, this is a idealized simplifica-
tion; real Time Zone boundaries are not straight vertical lines, because they often follow national
boundaries and other political considerations.

Note that because the Local Time always increases by an hour when moving between Zones to
the East, by the time you move through all 24 Time Zones, you are a full day ahead of where
you started. We deal with this paradox by defining the International Date Line, which is a Time
Zone boundary in the Pacific Ocean, between Asia and North America. Points just to the East of
this line are 24 hours behind the points just to the West of the line. This leads to some interesting
phenomena. A direct flight from Australia to California arrives before it departs. Also, the islands
of Fiji straddle the International Date Line, so if you have a bad day on the West side of Fiji, you
can go over to the East side of Fiji and have a chance to live the same day all over again.

9.20 Universal Time

The time on our clocks is essentially a measurement of the current position of the Sun in the sky,
which is different for places at different Longitudes because the Earth is round (see Time Zones).

However, it is sometimes necessary to define a global time, one that is the same for all places on
Earth. One way to do this is to pick a place on the Earth, and adopt the Local Time at that place
as the Universal Time, abbreviated UT. (The name is a bit of a misnomer, since Universal Time has
little to do with the Universe. It would perhaps be better to think of it as global time).

The geographic location chosen to represent Universal Time is Greenwich, England. The choice
is arbitrary and historical. Universal Time became an important concept when European ships
began to sail the wide open seas, far from any known landmarks. A navigator could reckon the
ship’s longitude by comparing the Local Time (as measured from the Sun’s position) to the time
back at the home port (as kept by an accurate clock on board the ship). Greenwich was home
to England’s Royal Observatory, which was charged with keeping time very accurately, so that
ships in port could re-calibrate their clocks before setting sail.

TIP
Exercise:
Set the geographic location to ‘Greenwich, England’ using the Set Location window (Ctrl+G). Note
that the Local Time (LT)and the Universal Time (UT) are now the same.
Further Reading: The history behind the construction of the first clock that was accurate and stable
enough to be used on ships to keep Universal Time is a fascinating tale, and one told expertly in the
book ‘Longitude’, by Dava Sobel.

9.21 Telescopes

Invented in Holland at the beginning of the 17th century, telescopes are the tools used by as-
tronomers and astrophysicists for their observations. With the development of modern science,
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telescopes are nowadays used for observing in all ranges of the electromagnetic spectrum, inside
and outside Earth’s atmosphere. Telescopes work by collecting light with a large surface aerie
called objective that makes the incoming light to converge. The final image will be viewed by
using an eyepiece.

9.21.1 Aperture and Focal Ratio

Telescopes are used in order to collect light from celestial objects and to converge it to a point,
named the focal point. They are described by two parameters, aperture and Focal Ratio. The
diameter of the light collecting surface is called the aperture of the telescope – the bigger the
aperture, the brighter the image. The ratio of the focal length f to the aperture D of a telescope is
defined as the focal ratio. This describes the light gathering power of a telescope. ‘Fast’ telescopes
have smaller focal ratios, as they obtain brighter images in a smaller exposure time. As the focal
ratio gets bigger, the telescope needs more exposure time in order to obtain a bright image, which
is why it is ‘slower’. The focal ratio is usually denoted as ‘f/n’, where n is the ratio of the focal
length to the aperture.

9.21.2 Aberrations

In order to obtain an image, telescopes use lenses or mirrors. Unfortunately, if we use both of
them we obtain image distortions known as aberrations. Some aberrations are common for both
lenses and mirrors, like astigmatism and curvature of field.

Astigmatism appears when different parts of the lens or mirror make the rays of the incoming light
to converge in slightly different locations on the focal plane. When corrected for astigmatism,
curvature of field may appear on the surface of the lens/ mirror, which makes the light to converge
on a curve rather than on a plane.

Still, there are also lens specific aberrations and mirror specific aberrations.

Chromatic aberration is a feature of telescopes that use lenses to converge the light. Mainly, the
focal length of a lens is wavelength dependent, which means that the focal point of blue light
differs from that of the red light. This results in a blurred image. The effect of chromatic aber-
ration can be diminished by adding correcting lenses into the system. Spherical aberration may
also be a problem for lenses, resulting from their shape. Spheroid surfaces will not make the
incoming light to converge to a single point, which is why other optical surfaces like paraboloids
are preferred. Even by using them we aren’t still out of trouble, as coma aberration appears in
this case. It results from the dependence of the focal length on the angle between the direction of
the incoming ray and the optical axis of the system. Thus, images of points that lie off the optical
axis are elongated, rather than being simple points, as it would be normal.

9.21.3 Magnification

Magnification, the increase in angular size of an object as viewed in a telescope, is described as the
ratio of the focal length of the objective to the focal length of the eyepiece. So the greater the focal
length of the objective, the greater the magnification. If you want to have a large image then you
need a long focal length objective and a short focal length eyepiece.

As an example, if you have a 500 mm objective and a 25 mm eyepiece the resulting magnification
will be 500 / 25, which is 20, or 20X.

9.21.4 Field of View

The field of view is the angle covered on the sky by the telescope.The apparent field of view of a
telescope is determined only by the eyepiece. It is a specific characteristic of it, usually around 52
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degrees. In order to find the true field of view of a telescope, you need to divide the apparent field
of view by the magnification. The true field of view is the actual angle covered on the sky by the
telescope.

TIP
KStars has a tool to find and display (on the virtual sky) a true field of view called the FOV Indicator.
Launch it by heading under the Settings → FOV Symbols → Edit FOV Symbols. Clicking New
will open a dialog with four different tabs: Eyepiece, Camera, Binocular and Radiotelescope. To
compute the field of view, select the tab that applies and enter the specifications of the equipment.
Finally, clicking Compute FOV will calculate and display the field of view immediately below. KStars
can now also display this as a shape of that size on the virtual sky. To do so, enter a name for
this particular field of view (such as 20mm eyepiece or DSLR with refractor) and select a
shape and color to be displayed. For Eyepiece, use Circle or Semitransparent circle as the shape
since an eyepiece’s field is round. For Camera, use Square (which is actually a rectangle) assuming
the sensor or film is rectangular or square. When using multiple eyepieces and/or telescopes, it is
good to distinguish them with different colors. Click OK to close the dialog. To show the shape on the
screen, go back under the Settings → FOV Symbols menus then select the new menu item with the
name of whatever it was given. To disable it again, click the menu item again.

9.21.5 Types of Telescopes

As telescopes are used in observations over the entire electromagnetic spectrum, they are classi-
fied in Optical Telescopes, Ultraviolet, Gamma Ray, X-Ray, Infrared and Radio Telescopes. Each
one of them has its own, well defined role in obtaining a detailed analysis of a celestial object.

9.21.6 Optical Telescopes

Used for observations in the visible field of view, Optical Telescopes are mainly Refractors and
Reflectors, the difference between the two of them being the way of collecting light from a star.

Refracting Telescopes use two lenses in order to create an image, a primary or objective lens, which
collects the incoming light, forming an image in the focal plane and the eyepiece, which is acting
as a magnifying glass used for observing the final image. The two lenses are situated at opposite
ends of a moving tube and the distance between the two of them can be adjusted in order to
obtain the final image.

The largest refracting telescope in the world is at the Yerkes Observatory in Williams Bay, Wiscon-
sin. Built in 1897, it has a 1.02-m (40-in) objective and a focal length of 19.36 m.

Reflecting Telescopes, on the other side, use mirrors instead of lenses in order to obtain the final
image. By replacing the objective lens with a mirror, we obtain a focal point that lies on the path
of the incoming light. An observer situated at this point could see an image, but he would block
part of the incoming light. The focal point of the principal mirror is called prime focus, and this
is also the name of the first category of reflecting telescopes. Thus, prime focus telescopes use
a mirror in order to collect light from a celestial object and by reflection the image of the object
may be observed from the prime focus of the telescope. Other types of reflecting telescopes are
Newtonian, Cassegrain and Coude.

The Newtonian one uses an additional flat mirror placed in the vicinity of the prime focus, in the
path of the reflected light. This results in moving the focal point to a different location, on one of
the sides of the telescope, more accessible for observing. Of course, a mirror placed in the path of
the reflected light will also block part of the incoming one, but if the ratio of the surface aeries of
the primary mirror to the second one is big enough, the amount of the blocked incoming light is
negligible.
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The Cassegrain telescope is similar to the Newtonian one but this time the secondary mirror re-
flects light to the bottom of the telescope. There is a hole at the center of the primary mirror
that lets the reflected light to go on its way until it converges to the focal point. The secondary
mirror needs to be convex, as it is increasing the focal length of the optical system. The primary
mirror of a Cassegrain Telescope is a paraboloid. By replacing it with a hyperboloid we obtain a
Ritchey-Chretien telescope. The advantage of using a Ritchey-Chretien telescope is that it removes
the coma of the classical reflectors.
The Coude type consists of more than one mirror that reflects the light to a special room, the Coude
room, which is located below the telescope. The advantages of using a Coude telescope are
varied, from obtaining a long focal length useful in different fields of astronomy and astrophysics,
like spectroscopy to avoiding the usage of a massive instrument. But there are also disadvantages
in using a Coude telescope, because the more mirrors are placed in the system, the less amount
of light arrives at the detector. This happens because by using Aluminum mirrors, only 80 % of
the incident light gets reflected.
Catadioptrics are types of telescopes that use systems of both lenses and mirrors for making the
light to converge. The most popular catadioptric is the Schmidt-Cassegrain telescope. It has the
advantage of providing a large angle field of view. In order to minimize coma, it uses a primary
spheroidal mirror with a thin correcting lens that removes spherical aberrations. The secondary
mirror is placed in the center of the correcting lens, reflecting light through a hole made in the
primary mirror. Not as famous as the Schmidt-Cassegrain telescope but common though is the
Maksutov telescope that also uses a correcting lens with the primary mirror, this time their sur-
faces being concentric.

9.21.7 Observations in Other Wavelengths

For a detailed analysis of the sky, observations are also carried in other regions of the electro-
magnetic spectrum. Very popular and efficient are radio telescopes, developed mostly in the last
century. A common problem for both radio and optical telescopes is the need for better reso-
lution. We can derive the resolution of a telescope by using Rayleigh criterion, that states the
resolving power is equal to the ratio of the incoming wavelength to the diameter of the aperture
(times 1.22 for circular apertures). So for a good resolution we need a diameter as big as pos-
sible. The biggest radio telescope in the world is the Arecibo telescope from Puerto Rico that
uses a huge dish of 305 m diameter. In order to solve the problem for resolutions, astronomers
have developed a new technique called interferometry. The basic principal of interferometry is
that by observing the same object with two distinct telescopes we can obtain a final image by
´́ connecting´́ the two initial ones. Nowadays, the most efficient observatory that uses interfer-
ometry is the Very Large Array located near Socorro, New Mexico. It uses 27 telescopes placed
in a ´́ Y´́ shape, with 25 m aperture each. There also exists a technique called Very Long Base-
line Interferometry (VLBI) that allows astronomers to resolve images over the size of continents.
The biggest project of the century in this domain is the building of the Atacama Large Millimeter
Array (ALMA), which will be using 66 telescopes placed in the Atacama desert of northern Chile.

9.21.8 Space-Based Observations

Because Earth-based observations are affected by extinction due Earth’s atmosphere, observa-
tions carried out in space are more successful. We mention the Hubble Space Telescope (HST) that
has a 2.4, f/24 primary mirror, the smoothest mirror ever constructed. The Hubble Space Tele-
scope is placed on a low-orbit around Earth and because of the lack of atmosphere it can observe
very faint objects. Another Space Telescope is the James Webb Space Telescope (JWST) which is
planned to be launched in 2018. It will have a 6.5m primary mirror and it will orbit around a
gravitation stable point on the Sun-Earth line known as the Second Lagrange Point (L2). Here
the gravitational attractions due to both Sun and Earth balances the centrifugal force of an object
set in motion around the Sun. This point has the special property that if an object is placed here,
it is in equilibrium with respect to the Sun-Earth system. The second Lagrange Point lies on the
line connecting Sun and Earth, on the other side of the Earth. So a telescope placed here will
receive less thermal radiation, which will improve Infrared Observations.

166



The KStars Handbook

9.22 Blackbody Radiation

A blackbody refers to an opaque object that emits thermal radiation. A perfect blackbody is one that
absorbs all incoming light and does not reflect any. At room temperature, such an object would
appear to be perfectly black (hence the term blackbody). However, if heated to a high temperature,
a blackbody will begin to glow with thermal radiation.

In fact, all objects emit thermal radiation (as long as their temperature is above Absolute Zero, or
-273.15 degrees Celsius), but no object emits thermal radiation perfectly; rather, they are better
at emitting/absorbing some wavelengths of light than others. These uneven efficiencies make it
difficult to study the interaction of light, heat and matter using normal objects.

Fortunately, it is possible to construct a nearly-perfect blackbody. Construct a box made of a
thermally conductive material, such as metal. The box should be completely closed on all sides,
so that the inside forms a cavity that does not receive light from the surroundings. Then, make a
small hole somewhere on the box. The light coming out of this hole will almost perfectly resemble
the light from an ideal blackbody, for the temperature of the air inside the box.

At the beginning of the 20th century, scientists Lord Rayleigh, and Max Planck (among others)
studied the blackbody radiation using such a device. After much work, Planck was able to em-
pirically describe the intensity of light emitted by a blackbody as a function of wavelength. Fur-
thermore, he was able to describe how this spectrum would change as the temperature changed.
Planck’s work on blackbody radiation is one of the areas of physics that led to the foundation of
the wonderful science of Quantum Mechanics, but that is unfortunately beyond the scope of this
article.
What Planck and the others found was that as the temperature of a blackbody increases, the total
amount of light emitted per second increases, and the wavelength of the spectrum’s peak shifts
to bluer colors (see Figure 1).

Figure 1

For example, an iron bar becomes orange-red when heated to high temperatures and its color
progressively shifts toward blue and white as it is heated further.

In 1893, German physicist Wilhelm Wien quantified the relationship between blackbody temper-
ature and the wavelength of the spectral peak with the following equation:
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where T is the temperature in Kelvin. Wien’s law (also known as Wien’s displacement law)
states that the wavelength of maximum emission from a blackbody is inversely proportional to
its temperature. This makes sense; shorter-wavelength (higher-frequency) light corresponds to
higher-energy photons, which you would expect from a higher-temperature object.

For example, the sun has an average temperature of 5800 K, so its wavelength of maximum
emission is given by:

This wavelengths falls in the green region of the visible light spectrum, but the sun’s continuum
radiates photons both longer and shorter than lambda(max) and the human eyes perceives the
sun’s color as yellow/white.

In 1879, Austrian physicist Stephan Josef Stefan showed that the luminosity, L, of a black body is
proportional to the 4th power of its temperature T.

where A is the surface area, alpha is a constant of proportionality, and T is the temperature in
Kelvin. That is, if we double the temperature (e.g. 1000 K to 2000 K) then the total energy
radiated from a blackbody increase by a factor of 24 or 16.

Five years later, Austrian physicist Ludwig Boltzman derived the same equation and is now
known as the Stefan-Boltzman law. If we assume a spherical star with radius R, then the lumi-
nosity of such a star is

where R is the star radius in cm, and the alpha is the Stefan-Boltzman constant, which has the
value:

9.23 Dark Matter

Scientists are now quite comfortable with the idea that 90% of the mass in the universe is in a
form of matter that cannot be seen.
Despite comprehensive maps of the nearby universe that cover the spectrum from radio to
gamma rays, we are only able to account of 10% of the mass that must be out there. As Bruce H.
Margon, an astronomer at the University of Washington, told the New York Times in 2001: ‘It’s a
fairly embarrassing situation to admit that we can’t find 90 percent of the universe.’

The term given this ‘missing mass’ is Dark Matter, and those two words pretty well sum up
everything we know about it at this point. We know there is ‘Matter’, because we can see the
effects of its gravitational influence. However, the matter emits no detectable electromagnetic
radiation at all, hence it is ‘Dark’. There exist several theories to account for the missing mass
ranging from exotic subatomic particles, to a population of isolated black holes, to less exotic
brown and white dwarfs. The term ‘missing mass’ might be misleading, since the mass itself is
not missing, just its light. But what is exactly dark matter and how do we really know it exists, if
we cannot see it?
The story began in 1933 when Astronomer Fritz Zwicky was studying the motions of distant
and massive clusters of galaxies, specifically the Coma cluster and the Virgo cluster. Zwicky
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estimated the mass of each galaxy in the cluster based on their luminosity, and added up all of
the galaxy masses to get a total cluster mass. He then made a second, independent estimate of
the cluster mass, based on measuring the spread in velocities of the individual galaxies in the
cluster. To his suprise, this second dynamical mass estimate was 400 times larger than the estimate
based on the galaxy light.

Although the evidence was strong at Zwicky’s time, it was not until the 1970s that scientists
began to explore this discrepancy comprehensively. It was at this time that the existence of Dark
Matter began to be taken seriously. The existence of such matter would not only resolve the mass
deficit in galaxy clusters; it would also have far more reaching consequences for the evolution
and fate of the universe itself.
Another phenomenon that suggested the need for dark matter is the rotational curves of Spiral
Galaxies. Spiral Galaxies contain a large population of stars that orbit the Galactic center on nearly
circular orbits, much like planets orbit a star. Like planetary orbits, stars with larger galactic orbits
are expected to have slower orbital speeds (this is just a statement of Kepler’s 3rd Law). Actually,
Kepler’s 3rd Law only applies to stars near the perimeter of a Spiral Galaxy, because it assumes
the mass enclosed by the orbit to be constant.

However, astronomers have made observations of the orbital speeds of stars in the outer parts of
a large number of spiral galaxies, and none of them follow Kepler’s 3rd Law as expected. Instead
of falling off at larger radii, the orbital speeds remain remarkably constant. The implication is
that the mass enclosed by larger-radius orbits increases, even for stars that are apparently near
the edge of the galaxy. While they are near the edge of the luminous part of the galaxy, the galaxy
has a mass profile that apparently continues well beyond the regions occupied by stars.

Here is another way to think about it: Consider the stars near the perimeter of a spiral galaxy,
with typical observed orbital velocities of 200 kilometers per second. If the galaxy consisted of
only the matter that we can see, these stars would very quickly fly off from the galaxy, because
their orbital speeds are four times larger than the galaxy’s escape velocity. Since galaxies are not
seen to be spinning apart, there must be mass in the galaxy that we are not accounting for when
we add up all the parts we can see.

Several theories have surfaced in literature to account for the missing mass such as WIMPs
(Weakly Interacting Massive Particles), MACHOs (MAssive Compact Halo Objects), primordial
black holes, massive neutrinos, and others; each with their pros and cons. No single theory has
yet been accepted by the astronomical community, because we so far lack the means to conclu-
sively test one theory against the other.

TIP
You can see the galaxy clusters that Professor Zwicky studied to discover Dark Matter. Use the KStars
Find Object Window (Ctrl+F) to center on ‘M 87’ to find the Virgo Cluster, and on ‘NGC 4884’ to find
the Coma Cluster. You may have to zoom in to see the galaxies. Note that the Virgo Cluster appears
to be much larger on the sky. In reality, Coma is the larger cluster; it only appears smaller because it
is further away.

9.24 Flux

The flux is the amount of energy that passes through a unit area each second.

Astronomers use flux to denote the apparent brightness of a celestial body. The apparent bright-
ness is defined as the amount of light received from a star above the earth atmosphere passing
through a unit area each second. Therefore, the apparent brightness is simply the flux we receive
from a star.

The flux measures the rate of flow of energy that passes through each cm2 (or any unit area) of
an object’s surface each second. The detected flux depends on the distance from the source that
radiates the energy. This is because the energy has to spread over a volume of space before it
reaches us. Let us assume that we have an imaginary balloon that encloses a star. Each dot on
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the balloon represents a unit of energy emitted from the star. Initially, the dots in an area of one
cm2 are in close proximity to each other and the flux (energy emitted per square centimeter per
second) is high. After a distance d, the volume and surface area of the balloon increased causing
the dots to spread away from each. Consequently, the number of dots (or energy) enclosed in one
cm2 has decreased as illustrated in Figure 1.

Figure 1

The flux is inversely proportional to distance by a simple r2 relation. Therefore, if the distance is
doubled, we receive 1/22 or 1/4th of the original flux. From a fundamental standpoint, the flux
is the luminosity per unit area:

where (4 * p * R2) is the surface area of a sphere (or a balloon!) with a radius R. Flux is measured
in Watts/m2/s or as commonly used by astronomers: Ergs/cm2/s. For example, the luminosity
of the sun is L = 3.90 * 1026 W. That is, in one second the sun radiates 3.90 * 1026 joules of energy
into space. Thus, the flux we receive passing through one square centimeter from the sun at a
distance of one AU (1.496 * 1013 cm) is:

9.25 Luminosity

Luminosity is the amount of energy emitted by a star each second.

All stars radiate light over a broad range of frequencies in the electromagnetic spectrum from the
low energy radio waves up to the highly energetic gamma rays. A star that emits predominately
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in the ultra-violet region of the spectrum produces a total amount of energy magnitudes larger
than that produced in a star that emits principally in the infrared. Therefore, luminosity is a
measure of energy emitted by a star over all wavelengths. The relationship between wavelength
and energy was quantified by Einstein as E = h * v where v is the frequency, h is the Planck
constant, and E is the photon energy in joules. That is, shorter wavelengths (and thus higher
frequencies) correspond to higher energies.

For example, a wavelength of lambda = 10 meter lies in the radio region of the electromagnetic
spectrum and has a frequency of f = c / lambda = 3 * 108 m/s / 10 = 30 MHz where c is the speed
of light. The energy of this photon is E = h * v = 6.625 * 10-34 J s * 30 Mhz = 1.988 * 10-26 joules.
On the other hand, visible light has much shorter wavelengths and higher frequencies. A photon
that has a wavelength of lambda = 5 * 10-9 meters (A greenish photon) has an energy E = 3.975
* 10-17 joules which is over a billion times higher than the energy of a radio photon. Similarly, a
photon of red light (wavelength lambda = 700 nm) has less energy than a photon of violet light
(wavelength lambda = 400 nm).

Luminosity depends both on temperature and surface area. This makes sense because a burning
log radiates more energy than a match, even though both have the same temperature. Similarly,
an iron rod heated to 2000 degrees emits more energy than when it is heated to only 200 degrees.

Luminosity is a very fundamental quantity in Astronomy and Astrophysics. Much of what is
learnt about celestial objects comes from analyzing their light. This is because the physical pro-
cesses that occur inside stars gets recorded and transmitted by light. Luminosity is measured in
units of energy per second. Astronomers prefer to use Ergs, rather than Watts, when quantifying
luminosity.

9.26 Parallax

Parallax is the apparent change of an observed object’s position caused by a shift in the observer’s
position. As an example, hold your hand in front of you at arm’s length, and observe an object
on the other side of the room behind your hand. Now tilt your head to your right shoulder, and
your hand will appear on the left side of the distant object. Tilt your head to your left shoulder,
and your hand will appear to shift to the right side of the distant object.

Because the Earth is in orbit around the Sun, we observe the sky from a constantly moving posi-
tion in space. Therefore, we should expect to see an annual parallax effect, in which the positions
of nearby objects appear to ‘wobble’ back and forth in response to our motion around the Sun.
This does in fact happen, but the distances to even the nearest stars are so great that you need to
make careful observations with a telescope to detect it2.

Modern telescopes allow astronomers to use the annual parallax to measure the distance to
nearby stars, using triangulation. The astronomer carefully measures the position of the star
on two dates, spaced six months apart. The nearer the star is to the Sun, the larger the apparent
shift in its position will be between the two dates.

Over the six-month period, the Earth has moved through half its orbit around the Sun; in this
time its position has changed by 2 Astronomical Units (abbreviated AU; 1 AU is the distance from
the Earth to the Sun, or about 150 million kilometers). This sounds like a really long distance, but
even the nearest star to the Sun (alpha Centauri) is about 40 trillion kilometers away. Therefore,
the annual parallax is very small, typically smaller than one arcsecond, which is only 1/3600 of
one degree. A convenient distance unit for nearby stars is the parsec, which is short for ´́ parallax
arcsecond´́ . One parsec is the distance a star would have if its observed parallax angle was one
arcsecond. It is equal to 3.26 light-years, or 31 trillion kilometers3.

2 The ancient Greek astronomers knew about parallax; because they could not observe an annual parallax in the
positions of stars, they concluded that the Earth could not be in motion around the Sun. What they did not realize was
that the stars are millions of times further away than the Sun, so the parallax effect is impossible to see with the unaided
eye.

3 Astronomers like this unit so much that they now use ‘kiloparsecs’ to measure galaxy-scale distances, and ‘Mega-
parsecs’ to measure intergalactic distances, even though these distances are much too large to have an actual, observable
parallax. Other methods are required to determine these distances
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9.27 Retrograde Motion

Retrograde Motion is the orbital motion of a body in a direction opposite that which is normal to
spatial bodies within a given system.

When we observe the sky, we expect most objects to appear to move in a particular direction with
the passing of time. The apparent motion of most bodies in the sky is from east to west. However
it is possible to observe a body moving west to east, such as an artificial satellite or space shuttle
that is orbiting eastward. This orbit is considered Retrograde Motion.

Retrograde Motion is most often used in reference to the motion of the outer planets (Mars,
Jupiter, Saturn, and so forth). Though these planets appear to move from east to west on a
nightly basis in response to the spin of the Earth, they are actually drifting slowly eastward with
respect to the stationary stars, which can be observed by noting the position of these planets for
several nights in a row. This motion is normal for these planets, however, and not considered
Retrograde Motion. However, since the Earth completes its orbit in a shorter period of time than
these outer planets, we occasionally overtake an outer planet, like a faster car on a multiple-lane
highway. When this occurs, the planet we are passing will first appear to stop its eastward drift,
and it will then appear to drift back toward the west. This is Retrograde Motion, since it is in a
direction opposite that which is typical for planets. Finally, as the Earth swings past the planet in
its orbit, they appear to resume their normal west-to-east drift on successive nights.

This Retrograde Motion of the planets puzzled ancient Greek astronomers, and was one reason
why they named these bodies ‘planets’ which in Greek means ‘wanderers’.

9.28 Elliptical Galaxies

Elliptical galaxies are spheroidal concentrations of billions of stars that resemble Globular Clus-
ters on a grand scale. They have very little internal structure; the density of stars declines
smoothly from the concentrated center to the diffuse edge, and they can have a broad range of
ellipticities (or aspect ratios). They typically contain very little interstellar gas and dust, and no
young stellar populations (although there are exceptions to these rules). Edwin Hubble referred
to Elliptical galaxies as ‘early-type’ galaxies, because he thought that they evolved to become
Spiral Galaxies (which he called ‘late-type’ galaxies). Astronomers actually now believe the op-
posite is the case (i.e., that Spiral galaxies can turn into Elliptical galaxies), but Hubble’s early-
and late-type labels are still used.

Once thought to be a simple galaxy type, ellipticals are now known to be quite complex objects.
Part of this complexity is due to their amazing history: ellipticals are thought to be the end
product of the merger of two Spiral galaxies. You can view a computer simulation MPEG movie
of such a merger at this NASA HST webpage (warning: the file is 3.4 MB).

Elliptical galaxies span a very wide range of sizes and luminosities, from giant Ellipticals hun-
dreds of thousands of light years across and nearly a trillion times brighter than the sun, to dwarf
Ellipticals just a bit brighter than the average globular cluster. They are divided to several mor-
phological classes:

cD galaxies:

Immense and bright objects that can measure nearly 1 Megaparsec (3 million light years)
across. These titans are only found near the centers of large, dense clusters of galaxies, and
are likely the result of many galaxy mergers.

Normal Elliptical galaxies

Condensed Object with relatively high central surface brightness. They include the giant
ellipticals (gE’e), intermediate-luminosity ellipticals (E’s), and compact ellipticals.
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Dwarf elliptical galaxies (dE’s)

This class of galaxies is fundamentally different from normal ellipticals. Their diameters on
the order of 1 to 10 kiloparsec with surface brightness that is much lower than normal ellip-
ticals, giving them a much more diffuse appearance. They display the same characteristic
gradual decline of star density from a relatively dense core out to a diffuse periphery.

Dwarf spheroidal galaxies (dSph’s)

Extreme low-luminosity, low surface-brightness and have only been observed in the vicin-
ity of the Milky Way, and possibly other very nearby galaxy groups, such as the Leo group.
Their absolute magnitudes are only -8 to -15 mag. The Draco dwarf spheroidal galaxy has
an absolute magnitude of -8.6, making it fainter than the average globular cluster in the
Milky Way!

Blue compact dwarf galaxies (BCD’s)

Small galaxies that are unusually blue. Thehave photometric colors of B-V = 0.0 to 0.30
mag, which is typical for relatively young stars of spectral type A. This suggests that BCDs
are currently actively forming stars. These systems also have abundant interstellar gas
(unlike other Elliptical galaxies).

TIP
You can see examples of Elliptical galaxies in KStars, using the Find Object window (Ctrl+F). Search
for NGC 4881, which is the Giant cD galaxy in the Coma cluster of galaxies. M 86 is a normal Elliptical
galaxy in the Virgo cluster of galaxies. M 32 is a dwarf Elliptical that is a satellite of our neighbor, the
Andromeda galaxy (M 31). M 110 is another satellite of M 31 that is a borderline dwarf spheroidal
galaxy (‘borderline’ because it is somewhat brighter than most other dwarf spheroidals).

9.29 Spiral Galaxies

Spiral galaxies are huge collections of billions of stars, most of which are flattened into a disk
shape, with a bright, spherical bulge of stars at its center. Within the disk, there are typically
bright arms where the youngest, brightest stars are found. These arms wind out from the center
in a spiral pattern, giving the galaxies their name. Spiral galaxies look a bit like hurricanes, or
like water flowing down a drain. They are some of the most beautiful objects in the sky.

Galaxies are classified using a ‘tuning fork diagram’. The end of the fork classifies elliptical
galaxies on a scale from the roundest, which is an E0, to those that appear most flattened, which is
rated as E7. The ‘tines’ of the tuning fork are where the two types of spiral galaxies are classified:
normal spirals, and ‘barred’ spirals. A barred spiral is one whose nuclear bulge is stretched out
into a line, so it literally looks like it has a ‘bar’ of stars in its center.

Both types of spiral galaxies are sub-classified according to the prominence of their central ‘bulge’
of stars, their overall surface brightness, and how tightly their spiral arms are wound. These
characteristics are related, so that an Sa galaxy has a large central bulge, a high surface brightness,
and tightly-wound spiral arms. An Sb galaxy has a smaller bulge, a dimmer disk, and looser arms
than an Sa, and so on through Sc and Sd. Barred galaxies use the same classification scheme,
indicated by types SBa, SBb, SBc, and SBd.

There is another class of galaxy called S0, which is morphologically a transitional type between
true spirals and ellipticals. Its spiral arms are so tightly wound as to be indistinguishable; S0
galaxies have disks with a uniform brightness. They also have an extremely dominant bulge.

The Milky Way galaxy, which is home to earth and all of the stars in our sky, is a Spiral Galaxy,
and is believed to be a barred spiral. The name ‘Milky Way’ refers to a band of very faint stars in
the sky. This band is the result of looking in the plane of our galaxy’s disk from our perspective
inside it.
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Spiral galaxies are very dynamic entities. They are hotbeds of star formation, and contain many
young stars in their disks. Their central bulges tend to be made of older stars, and their diffuse
halos are made of the very oldest stars in the Universe. Star formation is active in the disks
because that is where the gas and dust are most concentrated; gas and dust are the building
blocks of star formation.
Modern telescopes have revealed that many Spiral galaxies harbor supermassive black holes at
their centers, with masses that can exceed that of a billion Suns. Both elliptical and spiral galaxies
are known to contain these exotic objects; in fact many astronomers now believe that all large
galaxies contain a supermassive black hole in their nucleus. Our own Milky Way is known to
harbor a black hole in its core with a mass millions of times bigger than a star’s mass.

TIP
There are many fine examples of spiral galaxies to be found in KStars, and many have beautiful images
available in their popup menu. You can find them by using the Find Object window. Here is a list of
some spiral galaxies with nice images available:

• M 64, the Black-Eye Galaxy (type Sa)

• M 31, the Andromeda Galaxy (type Sb)

• M 81, Bode’s Galaxy (type Sb)

• M 51, the Whirlpool Galaxy (type Sc)

• NGC 300 (type Sd) [use DSS image link]

• M 83 (type SBa)

• NGC 1530 (type SBb)

• NGC 1073 (type SBc)

9.30 Magnitude Scale

2500 years ago, the ancient Greek astronomer Hipparchus classified the brightnesses of visible
stars in the sky on a scale from 1 to 6. He called the very brightest stars in the sky ‘first mag-
nitude’, and the very faintest stars he could see ‘sixth magnitude’. Amazingly, two and a half
millenia later, Hipparchus’s classification scheme is still widely used by astronomers, although it
has since been modernized and quantified.

NOTE
The magnitude scale runs backwards to what you might expect: brighter stars have smaller magni-
tudes than fainter stars).

The modern magnitude scale is a quantitative measurement of the flux of light coming from a
star, with a logarithmic scaling:

m = m0 - 2.5 log (F / F0)

If you do not understand the math, this just says that the magnitude of a given star (m) is dif-
ferent from that of some standard star (m0) by 2.5 times the logarithm of their flux ratio. The 2.5
*log factor means that if the flux ratio is 100, the difference in magnitudes is 5 mag. So, a 6th
magnitude star is 100 times fainter than a 1st magnitude star. The reason Hipparchus’s simple
classification translates to a relatively complex function is that the human eye responds logarith-
mically to light.
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There are several different magnitude scales in use, each of which serves a different purpose.
The most common is the apparent magnitude scale; this is just the measure of how bright stars
(and other objects) look to the human eye. The apparent magnitude scale defines the star Vega to
have magnitude 0.0, and assigns magnitudes to all other objects using the above equation, and a
measure of the flux ratio of each object to Vega.

It is difficult to understand stars using just the apparent magnitudes. Imagine two stars in the sky
with the same apparent magnitude, so they appear to be equally bright. You cannot know just
by looking if the two have the same intrinsic brightness; it is possible that one star is intrinsically
brighter, but further away. If we knew the distances to the stars (see the parallax article), we could
account for their distances and assign Absolute magnitudes which would reflect their true, intrinsic
brightness. The absolute magnitude is defined as the apparent magnitude the star would have if
observed from a distance of 10 parsecs (1 parsec is 3.26 light-years, or 3.1 x 1018 cm). The absolute
magnitude (M) can be determined from the apparent magnitude (m) and the distance in parsecs
(d) using the formula:

M = m + 5 - 5 * log(d) (note that M=m when d=10).

The modern magnitude scale is no longer based on the human eye; it is based on photographic
plates and photoelectric photometers. With telescopes, we can see objects much fainter than Hip-
parchus could see with his unaided eyes, so the magnitude scale has been extended beyond 6th
magnitude. In fact, the Hubble Space Telescope can image stars nearly as faint as 30th magnitude,
which is one trillion times fainter than Vega.

A final note: the magnitude is usually measured through a color filter of some kind, and these
magnitudes are denoted by a subscript describing the filter (i.e., mV is the magnitude through
a ‘visual’ filter, which is greenish; mB is the magnitude through a blue filter; mpg is the photo-
graphic plate magnitude, etc.).

9.31 Stars: An Introductory FAQ

1. What are the stars?
Stars are gigantic, self-gravitating spheres of (mostly) Hydrogen gas. Stars are also ther-
monuclear engines; nuclear fusion takes place deep in the cores of stars, where the density
is extreme and the temperature reaches tens of millions of degrees Celsius.

2. Is the Sun a star?
Yes, the Sun is a star. It is the dominant centerpiece of our solar system. Compared to other
stars, our Sun is rather ordinary; it appears to be so much bigger and brighter to us because
it is millions of times closer than any other star.

3. Why do stars shine?
The short answer is: star shine because they are very hot. It is really no more complicated
than that. Any object heated to thousands of degrees will radiate light, just like stars do.

4. The obvious next question is: why are stars so hot?
This is a tougher question. The usual answer is that stars get their heat from the thermonu-
clear fusion reactions in their cores. However, this cannot be the ultimate cause for the stars’
heat, because a star must be hot in the first place for nuclear fusion to be triggered. Fusion
can only sustain the hot temperature; it cannot make a star hot. A more correct answer is
that stars are hot because they have collapsed. Stars form from diffuse gaseous nebulae; as
the nebulous gas condenses to form a star, the gravitational potential energy of the material
is released, first as kinetic energy, and ultimately as heat as the density increases.

5. Are stars all the same?
Stars have many things in common: they are all collapsed spheres of hot, dense gas (mostly
Hydrogen), and nuclear fusion reactions are occurring at or near the centers of every star
in the sky.

175



The KStars Handbook

However, stars also show a great diversity in some properties. The brightest stars shine
almost 100 million times as brightly as the faintest stars. Stars range in surface temperature
from only a few thousand degrees to almost 50,000 degrees Celsius. These differences are
largely due to differences in mass: massive stars are both hotter and brighter than lower-
mass stars. The temperature and Luminosity also depend on the evolutionary state of the
star.

6. What is the Main Sequence?
The main sequence is the evolutionary state of a star when it is fusing Hydrogen in its core.
This is the first (and longest) stage of a star’s life (not including protostar phases). What
happens to a star after it runs out of core Hydrogen is addressed in the stellar evolution
article (coming soon).

7. How long do stars last?
The lifetime of a star depends very much on its mass. More massive stars are hotter and
shine much more brightly, causing them to consume their nuclear fuel much more rapidly.
The largest stars (roughly 100 times as massive as the Sun), will run out of fuel in only a
few million years; while the smallest stars (roughly ten percent the mass of the Sun), with
their much more frugal consumption rate, will shine on (albeit dimly) for trillions of years.
Note that this is much longer than the Universe has yet been in existence.

9.32 Star Colors and Temperatures

Stars appear to be exclusively white at first glance. But if we look carefully, we can notice a
range of colors: blue, white, red, and even gold. In the winter constellation of Orion, a beautiful
contrast is seen between the red Betelgeuse at Orion’s ´́ armpit´́ and the blue Bellatrix at the
shoulder. What causes stars to exhibit different colors remained a mystery until two centuries
ago, when Physicists gained enough understanding of the nature of light and the properties of
matter at immensely high temperatures.

Specifically, it was the physics of blackbody radiation that enabled us to understand the varia-
tion of stellar colors. Shortly after blackbody radiation was understood, it was noticed that the
spectra of stars look extremely similar to blackbody radiation curves of various temperatures,
ranging from a few thousand Kelvin to ~50,000 Kelvin. The obvious conclusion is that stars are
similar to blackbodies, and that the color variation of stars is a direct consequence of their surface
temperatures.

Cool stars (i.e., Spectral Type K and M) radiate most of their energy in the red and infrared region
of the electromagnetic spectrum and thus appear red, while hot stars (i.e., Spectral Type O and
B) emit mostly at blue and ultra-violet wavelengths, making them appear blue or white.

To estimate the surface temperature of a star, we can use the known relationship between the
temperature of a blackbody, and the wavelength of light where its spectrum peaks. That is, as
you increase the temperature of a blackbody, the peak of its spectrum moves to shorter (bluer)
wavelengths of light. This is illustrated in Figure 1 where the intensity of three hypothetical stars
is plotted against wavelength. The ´́ rainbow´́ indicates the range of wavelengths that are visible
to the human eye.
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Figure 1

This simple method is conceptually correct, but it cannot be used to obtain stellar temperatures
accurately, because stars are not perfect blackbodies. The presence of various elements in the
star’s atmosphere will cause certain wavelengths of light to be absorbed. Because these absorp-
tion lines are not uniformly distributed over the spectrum, they can skew the position of the
spectral peak. Moreover, obtaining a usable spectrum of a star is a time-intensive process and is
prohibitively inefficient for large samples of stars.

An alternative method utilizes photometry to measure the intensity of light passing through
different filters. Each filter allows only a specific part of the spectrum of light to pass through
while rejecting all others. A widely used photometric system is called the Johnson UBV system. It
employs three bandpass filters: U (´́ Ultra-violet´́ ), B (´́ Blue´́ ), and V (´́ Visible´́ ); each occupying
different regions of the electromagnetic spectrum.

The process of UBV photometry involves using light sensitive devices (such as film or CCD cam-
eras) and aiming a telescope at a star to measure the intensity of light that passes through each
of the filters individually. This procedure gives three apparent brightnesses or fluxes (amount of
energy per cm2 per second) designated by Fu, Fb, and Fv. The ratio of fluxes Fu/Fb and Fb/Fv is
a quantitative measure of the star’s ´́ color´́ , and these ratios can be used to establish a tempera-
ture scale for stars. Generally speaking, the larger the Fu/Fb and Fb/Fv ratios of a star, the hotter
its surface temperature.

For example, the star Bellatrix in Orion has Fb/Fv = 1.22, indicating that it is brighter through
the B filter than through the V filter. furthermore, its Fu/Fb ratio is 2.22, so it is brightest through
the U filter. This indicates that the star must be very hot indeed, since the position of its spectral
peak must be somewhere in the range of the U filter, or at an even shorter wavelength. The
surface temperature of Bellatrix (as determined from comparing its spectrum to detailed models
that account for its absorption lines) is about 25,000 Kelvin.

We can repeat this analysis for the star Betelgeuse. Its Fb/Fv and Fu/Fb ratios are 0.15 and 0.18,
respectively, so it is brightest in V and dimmest in U. So, the spectral peak of Betelgeuse must be
somewhere in the range of the V filter, or at an even longer wavelength. The surface temperature
of Betelgeuse is only 2,400 Kelvin.

Astronomers prefer to express star colors in terms of a difference in magnitudes, rather than a
ratio of fluxes. Therefore, going back to blue Bellatrix we have a color index equal to

B - V = -2.5 log (Fb/Fv) = -2.5 log (1.22) = -0.22,

Similarly, the color index for red Betelgeuse is
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B - V = -2.5 log (Fb/Fv) = -2.5 log (0.18) = 1.85

The color indices, like the magnitude scale, run backward. Hot and blue stars have smaller and
negative values of B-V than the cooler and redder stars.

An Astronomer can then use the color indices for a star, after correcting for reddening and inter-
stellar extinction, to obtain an accurate temperature of that star. The relationship between B-V
and temperature is illustrated in Figure 2.

Figure 2

The Sun with surface temperature of 5,800 K has a B-V index of 0.62.

9.33 Cosmic Distance Ladder

The cosmic distance ladder refers to the succession of different methods that astronomers use to
measure distances to objects in the sky. Some methods, like parallax, work well for only nearby
objects. Other methods, like using the cosmological redshift, work only for very distance galaxies.
Thus, there are several methods, each with its own limited validity, and hence the name.

9.33.1 Direct measurements

The bottom of the ladder consists of objects whose distances can be directly measured, like the
moon (see Lunar Laser Ranging). The same technique, using radio waves, is applied to find
distances to planets as well.

For nearby stars, measuring the parallax is possible and yields the distance to the star.

9.33.2 Standard candles

´́ Standard candles´́ are objects whose intrinsic brightnesses we can know for sure. The apparent
magnitude, which is easy to measure, tells us how bright an object appears, not how bright it
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actually is. Distant objects appear less brighter, because their light gets spread out over a larger
area.
In accordance with the inverse square law for light intensities, the amount of light we receive from
an object drops with the distance squared. Thus, we may compute the distance to an object if we
know both how bright it actually is (absolute magnitude; ’M’) and how bright it appears to us on
earth (apparent magnitude; ’m’). We may define the distance modulus as follows:

Distance Modulus = M - m = 5 log10 d - 5

Here ’d’ is the distance measured in parsecs.

For these special standard candle objects, we have some other way of knowing their intrinsic
brightness, and thereby can calculate their distance.

Common ´́ standard candles´́ used in astronomy are:

• Cepheid Variables: A kind of periodic variable star, whose variation period is related to the
luminosity

• RR Lyrae Variables: Another such periodic variable star with a well-known period-luminosity
relationship

• Type-Ia supernovae: These supernovae have a very well-defined luminosity as a result of the
physics that governs them and hence serve as standard-candles

9.33.3 Other methods

There are many other methods. Some of them rely on the physics of stars, such as the relation-
ship between luminosity and color for various types of stars (this is usually represented on a
Hertzsprung-Russel Diagram). Some of them work for star clusters, such as the Moving cluster
method and the main-sequence fitting method. The Tully-Fisher relation that relates the brightness of
a spiral galaxy to its rotation can be used to find the distance modulus, since the rotation of a
galaxy is easy to measure using Doppler shift. Distances to distant galaxies may be found by mea-
suring the Cosmological redshift, which is the redshift of light from distance galaxies that results
from the expansion of the universe.

For further information, consult Wikipedia on Cosmic Distance Ladder
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Chapter 10

Credits and License

KStars
Program copyright 2001-2015 The KStars Team mutlaqja@ikarustech.com

The KStars Team:

• Jason Harris kstars@30doradus.org

• Jasem Mutlaqmutlaqja@ikarustech.com

• Pablo de Vicentepvicentea@wanadoo.es

• Heiko Evermannheiko@evermann.de

• Thomas Kabelmanntk78@gmx.de

• Mark Hollomonmhh@mindspring.com

• Carsten Niehauscniehaus@gmx.de

• James Bowlinbowlin@mindspring.com

• Alexey Khudyakovalexey.skladnoy@gmail.com

• Mederic Boquienmboquien@free.fr
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Data Sources:

• Object catalogs and planet position tables: NASA Astronomical Data Center

• Detailed credit information for all of the images used in the program is presented in the file
README.images
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Chapter 11

Index

A
Altitude, see Horizontal Coordinates
Animated Slewing, 39
Astronomical Unit, see Parallax
Atmospheric Refraction, 39
Azimuth, see Horizontal Coordinates

B
Blackbody Radiation, see Star Colors and

Temperatures

C
Catalogs

Deep-Sky Catalogs, 24
Star Catalogs, 24

Catalogs page
Short overview, 23

CCD Video Control
Setup, 144

Celestial Coordinate Systems
Ecliptic Coordinates, see Ecliptic
Equatorial Coordinates, see Celestial

Equator
Galactic Coordinates, 156
Horizontal Coordinates, see Horizon
Overview, 154

Celestial Equator, see Equatorial Coordinates
Celestial Poles, see Equatorial Coordinates
Celestial Sphere, see Celestial Coordinate

Systems
Color Schemes

Customizing, 22, 36
Selecting, 40

Commands
Keyboard, 52
Menu, 43

Keyboard Shortcuts, 53
Mouse, 55

Configure
INDI, 144

Configure KStars window, 21
Advanced page, 22, 39
Catalogs page, 22
Colors page, 22, 36
FITS page, 36
Guides page, 22, 35
Satellites page, 22, 33

Solar System page, 22, 32
Supernovae page, 22, 34
Xplanet page, 22

Cosmic Distance Ladder, 178

D
Dark Matter, 168
Date and Time

Extended range of dates, 21
Setting, 21
The simulation clock, 21

Declination, see Equatorial Coordinates

E
Ecliptic, see Ecliptic Coordinates
Elliptical Galaxies, 172
Epoch, 160
Equinoxes, see Celestial Equator

F
Field-of-View Symbols

Customizing, 40
Defining New, 41
Description, 40

Find Object Tool, 16
FITS Viewer, 122
Flux, see Luminosity

G
Geographic Coordinate System, 158
Geographic Location Tool

Custom locations, 21
Filtering, 20

Great Circles, see Celestial Sphere

H
Horizon, see Horizontal Coordinates
Hour Angle, see Local Meridian

I
Image-dump Mode, 139
INDI

Setup, 140, 141
INDI Control

Overview, 140
Info Boxes

Customizing, 40
Shading, 40
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J
Julian Day, 160

L
Latitude, see Geographic Coordinate System
Leap Years, 161
Local Meridian, see Hour Angle
Longitude, see Geographic Coordinate Sys-

tem
Luminosity, see Flux

M
Magnitude Scale, see Flux
Main sequence, 176
Milky Way, 156

N
Navigation Controls

Basics, 14
Keyboard, 52
Mouse, 55

O
Objects in the Sky

Centering, 55
Details, 58
Finding by Name, 16
Hiding, 39
Identifying, 55
Internet Links, see Popup Menu

Customizing, 58
Invoking Popup Menu for, 55
Keyboard Actions, 18, 54
Labeling

Automatic, 39
Overview, 15
Tracking, 18

Orbit Trails
Attached to centered object, 18

P
Parallax, 171
Parsec, see Parallax
Planner, 129
Popup Menu

Description, 50
Example, 15

Precession, 159

R
Retrograde Motion, 172
Right Ascension, see Equatorial Coordinates

S
Setup Wizard, 13
Sidereal Time, see Hour Angle
Spiral Galaxies, 173
Star Colors and Temperatures, see Blackbody

Radiation
Stars, 175

T
Telescope Control

Concepts, 145

FAQ, 148
Remote Devices, 146

Telescopes, 163–166
Time Zones, 163
Toolbars

Customizing, 40
Tools, 57

Altitude vs. Time Tool, 69
Astrocalculator, 59

Angular Distance module, 60
Apparent Coordinates module, 61
Day Duration module, 66
Ecliptic Coordinates module, 62
Equatorial/Galactic Coordinates

module, 62
Equinoxes and Solstices module, 66
Geodetic Coordinates module, 64
Horizontal Coordinates module, 63
Julian Day module, 67
Planet Coordinates module, 65
Sidereal Time module, 68

Ekos, 76
Align, 105
Capture, 84
Focus, 92
Guide, 98
Logs, 84
Profile Editor, 83
Profile Wizard, 80
Scheduler, 117
Setup, 78
Tutorials, 128
User Interface, 79

FITS Viewer, 137
Jupiter Moons Tool, 129
Object Details Window, 58
Script Builder, 73
Simulate Eyepiece View, 71
Solar System Viewer, 76
What’s Up Tonight? Tool, 72

U
Universal Time, see Time Zones

V
Views

HiPS Progressive Overlay, 41

Z
Zenith, see Horizontal Coordinates
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